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Model Coverage
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Model coverage helps you validate your model tests by measuring how thoroughly the
model objects are tested. Model coverage calculates how much a model test case
exercises simulation pathways through a model. It is a measure of how thoroughly a test
case tests a model and the percentage of pathways that a test case exercises.

Model coverage analyzes the execution of the following types of model objects that
directly or indirectly determine simulation pathways through your model:

* Simulink® blocks
e Models referenced in Model blocks
* The states and transitions of Stateflow® charts

During a simulation run, the tool records the behavior of the covered objects, states, and
transitions. At the end of the simulation, the tool reports the extent to which the run
exercised potential simulation pathways through each covered object in the model.

The Simulink Coverage™ software can only collect model coverage for a model if its
simulation mode is set to Normal, SIL, or PIL. If the simulation mode is set to any other
mode, model coverage is not measured during simulation.

For the types of coverage that model coverage performs, see “Types of Model Coverage”
on page 1-3. For an example of a model coverage report, see “Top-Level Model
Coverage Report” on page 6-12.

If you have an Embedded Coder® license, you can also measure code coverage for code
generated from models in software-in-the-loop (SIL) mode or processor-in-the-loop (PIL)
mode. For the types of coverage that code coverage performs, see “Types of Code
Coverage” on page 4-2. For an example of how to enable code coverage, see “Code
Coverage for Models in Software-in-the-Loop (SIL) Mode and Processor-in-the-Loop (PIL)
Mode” on page 4-7
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Types of Model Coverage

Simulink Coverage can perform several types of coverage analysis.

In this section...

“Execution Coverage (EC)” on page 1-3

“Decision Coverage (DC)” on page 1-3

“Condition Coverage (CC)” on page 1-3

“Modified Condition/Decision Coverage (MCDC)” on page 1-4
“Cyclomatic Complexity” on page 1-5

“Lookup Table Coverage” on page 1-5

“Signal Range Coverage” on page 1-6

“Signal Size Coverage” on page 1-7

“Objectives and Constraints Coverage” on page 1-7
“Saturate on Integer Overflow Coverage” on page 1-8
“Relational Boundary Coverage” on page 1-9

Execution Coverage (EC)

Execution coverage is the most basic form of coverage. For each item, execution coverage
determines whether the item is executed during simulation.

Decision Coverage (DC)

Decision coverage analyzes elements that represent decision points in a model, such as a
Switch block or Stateflow states. For each item, decision coverage determines the
percentage of the total number of simulation paths through the item that the simulation

traversed.

For an example of decision coverage data in a model coverage report, see “Decisions
Analyzed” on page 6-25.

Condition Coverage (CC)

Condition coverage analyzes blocks that output the logical combination of their inputs
(for example, the Logical Operator block) and Stateflow transitions. A test case achieves
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full coverage when it causes each input to each instance of a logic block in the model and
each condition on a transition to be true at least once during the simulation, and false at
least once during the simulation. Condition coverage analysis reports whether the test
case fully covered the block for each block in the model.

When you collect coverage for a model, you may not be able to achieve 100% condition
coverage. For example, if you specify to short-circuit logic blocks, by selecting Treat
Simulink Logic blocks as short-circuited in the Coverage pane in the Configuration
Parameters, you might not be able to achieve 100% condition coverage for that block. See
“MCDC Analysis” on page 6-27 for more information.

For an example of condition coverage data in a model coverage report, see “Conditions
Analyzed” on page 6-27.

Modified Condition/Decision Coverage (MCDC)

Modified condition/decision coverage analysis by the Simulink Coverage software extends
the decision and condition coverage capabilities. It analyzes blocks that output the logical
combination of their inputs and Stateflow transitions to determine the extent to which the
test case tests the independence of logical block inputs and transition conditions.

* A test case achieves full coverage for a block when a change in one input, independent
of any other inputs, causes a change in the block output.

* A test case achieves full coverage for a Stateflow transition when there is at least one
time when a change in the condition triggers the transition for each condition.

If your model contains blocks that define expressions that have different types of logical
operators and more than 12 conditions, the software cannot record MCDC coverage.

Because the Simulink Coverage MCDC coverage may not achieve full decision or
condition coverage, you can achieve 100% MCDC coverage without achieving 100%
decision coverage.

Some Simulink objects support MCDC coverage, some objects support only condition
coverage, and some objects support only decision coverage. The table in “Model Objects
That Receive Coverage” on page 2-2 lists which objects receive which types of model
coverage. For example, the Combinatorial Logic block can receive decision coverage and
condition coverage, but not MCDC coverage.
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To achieve 100% MCDC coverage for your model, as defined by the DO-178C/D0O-331
standard, in the Coverage pane of the Configuration Parameters, select “Modified
Condition/Decision Coverage (MCDC)” on page 1-4 as the Structural coverage level.

When you collect coverage for a model, you may not be able to achieve 100% MCDC
coverage. For example, if you specify to short-circuit logic blocks, you may not be able to
achieve 100% MCDC coverage for that block.

If you run the test cases independently and accumulate all the coverage results, you can
determine if your model adheres to the modified condition and decision coverage
standard. For more information about the DO-178C/D0-331 standard, see “DO-178C/
DO-331 Checks” (Simulink Check).

For an example of MCDC coverage data in a model coverage report, see “MCDC Analysis”
on page 6-27. For an example of accumulated coverage results, see “Cumulative
Coverage” on page 6-29.

Cyclomatic Complexity

Cyclomatic complexity is a measure of the structural complexity of a model. It
approximates the McCabe complexity measure for code generated from the model. The
McCabe complexity measure is slightly higher on the generated code due to error checks
that the model coverage analysis does not consider.

To compute the cyclomatic complexity of an object (such as a block, chart, or state),
model coverage uses the following formula:

N
c= Z(On—l)

N is the number of decision points that the object represents and o, is the number of
outcomes for the nth decision point. The tool adds 1 to the complexity number for atomic
subsystems and Stateflow charts.

For an example of cyclomatic complexity data in a model coverage report, see
“Cyclomatic Complexity” on page 6-23.

Lookup Table Coverage

Lookup table coverage (LUT) examines blocks, such as the 1-D Lookup Table block, that
output information from inputs in a table of inputs and outputs, interpolating between or
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extrapolating from table entries. Lookup table coverage records the frequency that table
lookups use each interpolation interval. A test case achieves full coverage when it
executes each interpolation and extrapolation interval at least once. For each lookup table
block in the model, the coverage report displays a colored map of the lookup table,
indicating each interpolation. If the total number of breakpoints of an n-D Lookup Table
block exceeds 1,500,000, the software cannot record coverage for that block.

For an example of lookup table coverage data in a model coverage report, see “N-
Dimensional Lookup Table” on page 6-31.

Note Configure lookup table coverage only at the start of a simulation. If you tune a
parameter that affects lookup table coverage at run time, the coverage settings for the
affected block are not updated.

Signal Range Coverage

Signal range coverage records the minimum and maximum signal values at each block in
the model, as measured during simulation. Only blocks with output signals receive signal
range coverage.

The software does not record signal range coverage for control signals, signals used by
one block to initiate execution of another block. See “Control Signals” (Simulink).

If the total number of signals in your model exceeds 65535, or your model contains a
signal whose width exceeds 65535, the software cannot record signal range coverage.

For an example of signal range coverage data in a model coverage report, see “Signal
Range Analysis” on page 6-43.

Note When you create cumulative coverage for reusable subsystems or Stateflow
constructs with single range coverage, the cumulative coverage has the largest possible
range of signal values. For more information, see “Obtain Cumulative Coverage for
Reusable Subsystems and Stateflow Constructs” on page 8-7.
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Signal Size Coverage

Signal size coverage records the minimum, maximum, and allocated size for all variable-
size signals in a model. Only blocks with variable-size output signals are included in the
report.

If the total number of signals in your model exceeds 65535, or your model contains a
signal whose width exceeds 65535, the software cannot record signal size coverage.

For an example of signal size coverage data in a model coverage report, see “Signal Size
Coverage for Variable-Dimension Signals” on page 6-45.

For more information about variable-size signals, see “Variable-Size Signal Basics”
(Simulink).

Objectives and Constraints Coverage

The Simulink Coverage software collects model coverage data for the following Simulink
Design Verifier™ blocks and MATLAB® for code generation functions:

Simulink Design Verifier blocks MATLAB for code generation functions
Test Condition sldv.condition

Test Objective sldv.test

Proof Assumption sldv.assume

Proof Objective sldv.prove

If you do not have a Simulink Design Verifier license, you can collect model coverage for a
model that contains these blocks or functions, but you cannot analyze the model using the
Simulink Design Verifier software.

By adding one or more Simulink Design Verifier blocks or functions into your model, you
can:

* Check the results of a Simulink Design Verifier analysis, run generated test cases, and
use the blocks to observe the results.

* Define model requirements using the Test Objective block and verify the results with
model coverage data that the software collected during simulation.

* Analyze the model, create a test harness, and simulate the harness with the Test
Objective block to collect model coverage data.

1-7
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* Analyze the model and use the Proof Assumption block to verify any counterexamples
that the Simulink Design Verifier identifies.

If you specify to collect Simulink Design Verifier coverage:

* The software collects coverage for the Simulink Design Verifier blocks and functions.

* The software checks the data type of the signal that links to each Simulink Design
Verifier block. If the signal data type is fixed point, the block parameter must also be
fixed point. If the signal data type is not fixed point, the software tries to convert the
block parameter data type. If the software cannot convert the block parameter data
type, the software reports an error and you must explicitly assign the block parameter
data type to match the signal.

* If your model contains a Verification Subsystem block, the software only records
coverage for Simulink Design Verifier blocks in the Verification Subsystem block; it
does not record coverage for any other blocks in the Verification Subsystem.

If you do not specify to collect Simulink Design Verifier coverage, the software does not
check the data types for any Simulink Design Verifier blocks and functions in your model
and does not collect coverage.

For an example of coverage data for Simulink Design Verifier blocks or functions in a
model coverage report, see “Simulink Design Verifier Coverage” on page 6-46.

Saturate on Integer Overflow Coverage

Saturate on integer overflow coverage examines blocks, such as the Abs block, with the
Saturate on integer overflow parameter selected. Only blocks with this parameter
selected receive saturate on integer overflow coverage.

Saturate on integer overflow coverage records the number of times the block saturates on
integer overflow.

A test case achieves full coverage when the blocks saturate on integer overflow at least
once and does not saturate at least once.

For an example of saturate on integer overflow coverage data in a model coverage report,
see “Saturate on Integer Overflow Analysis” on page 6-42.

1-8
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Relational Boundary Coverage

Relational boundary coverage examines blocks, Stateflow charts, and MATLAB function
blocks that have an explicit or implicit relational operation.

» Blocks such as Relational Operator and If have an explicit relational operation.

* Blocks such as Abs and Saturation have an implicit relational operation.

For these model objects, the metric records whether a simulation tests the relational
operation with:

* Equal operand values.

This part of relational boundary coverage applies only if both operands are integers or
fixed-point numbers.

* Operand values that differ by a certain tolerance.
This part of relational boundary coverage applies to all operands. For integer and

fixed-point operands, the tolerance is fixed. For floating-point operands, you can either
use a predefined tolerance or you can specify your own tolerance.

The tolerance value depends on the data type of both the operands. If both operands have
the same type, the tolerance follows the following rules:

Data Type of Operand Tolerance

Floating point, such as single or double |[max(absTol, relTol* max(|lhs]|, |
rhs|))

¢ absTol is an absolute tolerance value
you specify. Default is 1e-05.

* relTol is a relative tolerance value you
specify. Default is 0.01.

* 1lhs is the left operand and rhs the
right operand.

* max(x,y) returns x or y, whichever is
greater.

1-9
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Data Type of Operand Tolerance

Fixed point Value corresponding to least significant bit.
For more information, see “Precision”
(Fixed-Point Designer). To find the precision
value, use the 1sb function.

Integer 1
Boolean N/A
Enum N/A

If the two operands have different types, the tolerance follows the rules for the stricter
type. If one of the operands is boolean, the tolerance follows the rules for the other
operand. The strictness decreases in this order:

1 Floating point
2 Fixed point
3 Integer

If both operands are fixed point but have different precision, the smaller value of
precision is used as tolerance.

You specify the value of absolute and relative tolerances for relational boundary coverage
of floating point inputs when you select this metric in the Coverage metrics section in
the“Coverage Pane” on page 3-2 of the Configuration Parameters dialog box.

For more information on:

* How this coverage metric appears in reports, see “Relational Boundary” on page 6-
38.

*  Which model objects receive this coverage, see the table in “Model Objects That
Receive Coverage” on page 2-2.

* How to obtain coverage results from the MATLAB command-line, see “Collect
Relational Boundary Coverage for Supported Block in Model”.
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Simulink Optimizations and Model Coverage

In the Configuration Parameters dialog box, there are three Simulink optimization
parameters that can affect your model coverage data:

In this section...

“Inlined parameters” on page 1-11
“Block reduction” on page 1-11
“Conditional input branch execution” on page 1-12

Inlined parameters

To transform tunable model parameters into constant values for code generation, in the
Configuration Parameters dialog box, on the Math and Data Types pane, set Default
parameter behavior to Inlined.

When the parameters are transformed into constants, Simulink may eliminate certain
decisions in your model. You cannot achieve coverage for eliminated decision, so the
coverage report displays 0/0 for those decisions.

Block reduction

To achieve faster execution during model simulation and in generated code, in the
Configuration Parameters dialog box, select the Block reduction parameter. The
Simulink software collapses certain groups of blocks into a single, more efficient block, or
removes them entirely.

One of the model coverage options, Force block reduction off, allows you to ignore the
Block reduction parameter when collecting model coverage.

If you do not select the Block reduction parameter, or if you select Force block
reduction off, the Simulink Coverage software provides coverage data for every block in
the model that collects coverage.

If you select the Block reduction parameter and do not set Force block reduction off,
the coverage report lists the reduced blocks that would have collected coverage.
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Conditional input branch execution

To improve model execution when the model contains Switch and Multiport Switch
blocks, in the Configuration Parameters dialog box, select Conditional input branch
execution. If you select this parameter, the simulation executes only blocks that are
required to compute the control input and the data input selected by the control input.

When Conditional input branch execution is enabled, instead of executing all blocks
driving the Switch block input ports at each time step, only the blocks required to
compute the control input and the data input selected by the control input execute.

Several considerations affect or limit Switch block optimization:

*  Only blocks with -1 (inherited) or inf (Constant) sample time can be optimized.
* Blocks with outputs flagged as test points cannot be optimized.

* Multirate blocks cannot be optimized.

* Blocks with states cannot be optimized.

* Only S-functions with the SS OPTION CAN BE CALLED CONDITIONALLY option
enabled can be optimized.

For example, if your model has a Switch block and an input is flagged as a test point, such
as when a Scope block is attached, the blocks feeding that input will always be executed
for model coverage regardless of the switch position. If you have a model with Switch
blocks and you want to ensure that the model coverage data is processing each input at
every step, clear Conditional input branch execution.

Conditional input branch execution does not apply to Stateflow charts.
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Model Objects That Receive Coverage

Certain Simulink objects can receive any type of model coverage. Other Simulink objects
can receive only certain types of coverage, as the following table shows. Click a link in the
first column to get more detailed information about coverage for specific model objects.

All Simulink objects can receive Execution coverage, except blocks that are not
instrumented in model coverage:

Merge Blocks
Scope Blocks
Outport Blocks
Inport Blocks
Width Blocks
Display Blocks

For Stateflow states, events, and state temporal logic decisions, model coverage provides
decision coverage. For Stateflow transitions, model coverage provides decision, condition,
and MCDC coverage. Model coverage provides condition and MCDC coverage for logical
expressions in assignment statements in states and transitions. For more information, see
“Model Coverage for Stateflow Charts” on page 5-55.

Model Object Decision |Condition |MCDC Lookup Simulink [Saturate |Relational
Table Design on Integer |Boundary
Verifier Overflow
“Abs” on page 2- . . .
8
“Bias” on page 2-
L]
9
“Combinatorial
Logic” on page 2- » »
9
“Compare to
Constant” on ] .
page 2-9

2-2
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Model Object

Decision

Condition

MCDC

Lookup
Table

Simulink
Design
Verifier

Saturate
on Integer
Overflow

Relational
Boundary

“Compare to
Zero” on page 2-
10

“Data Type
Conversion” on
page 2-10

“Dead Zone” on
page 2-10

“Direct Lookup
Table (n-D)” on
page 2-11

“Discrete Filter”
on page 2-12

“Discrete FIR
Filter” on page 2-
12

“Discrete-Time
Integrator” on
page 2-12 (when
saturation limits
are enabled or
reset)

“Discrete
Transfer Fcn” on
page 2-13

“Dot Product” on
page 2-13

“Enabled
Subsystem” on
page 2-13
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Model Object

Decision

Condition

MCDC

Lookup
Table

Simulink
Design
Verifier

Saturate
on Integer
Overflow

Relational
Boundary

“Enabled and
Triggered
Subsystem” on
page 2-14

“Fcn” on page 2-
15

“For Iterator, For
Iterator
Subsystem” on
page 2-16

“Gain” on page 2-

16

“If, If Action
Subsystem” on
page 2-16

“Interpolation
Using Prelookup”
on page 2-17

“Library-Linked
Objects” on page
2-18

“Logical
Operator” on
page 2-18

“1-D Lookup
Table” on page 2-
18

“2-D Lookup
Table” on page 2-
19
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Model Object

Decision

Condition

MCDC

Saturate |Relational
on Integer |Boundary
Overflow

Simulink
Design
Verifier

Lookup
Table

“n-D Lookup
Table” on page 2-
20

“Math Function”
on page 2-20

“MATLAB
Function” on
page 2-20

“MATLAB
System” on page
2-21

“MinMax” on
page 2-21

“Model” on page
2-21

See also
“Triggered
Models” on page
2-30.

“Multiport
Switch” on page
2-22

“PID Controller,
PID Controller (2
DOF)” on page 2-
22

“Product” on
page 2-23

“Proof
Assumption” on
page 2-23
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Model Object

Decision

Condition

MCDC

Lookup
Table

Simulink
Design
Verifier

Saturate
on Integer
Overflow

Relational
Boundary

“Proof Objective”
on page 2-23

“Rate Limiter” on
page 2-23

(Relative
to slew
rates)

“Relational
Operator” on
page 2-24

“Relay” on page
2-25

“C/C++ S-
Function” on
page 2-25

“Saturation” on
page 2-26

“Saturation
Dynamic” on
page 2-27

“Simulink Design
Verifier Functions
in MATLAB
Function Blocks”
on page 2-27

Stateflow charts
on page 5-55

Stateflow state
transition tables
on page 5-72
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Model Object

Decision

Condition

MCDC

Lookup
Table

Simulink
Design
Verifier

Saturate
on Integer
Overflow

Relational
Boundary

“Sqrt, Signed
Sqrt, Reciprocal
Sqrt” on page 2-
28

“Sum, Add,
Subtract, Sum of
Elements” on
page 2-28

“Switch” on page
2-28

“SwitchCase,
SwitchCase
Action
Subsystem” on
page 2-29

“Test Condition”
on page 2-29

“Test Objective”
on page 2-29

“Triggered
Models” on page
2-30

“Triggered
Subsystem” on
page 2-31

“Truth Table” on
page 2-31

“Unary Minus” on
page 2-32
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Model Object

Decision

Condition

MCDC

Lookup
Table

Simulink
Design
Verifier

Saturate
on Integer
Overflow

Relational
Boundary

“Weighted
Sample Time

Math” on page 2-

32

“While Iterator,
While Iterator
Subsystem” on
page 2-32

2-8

Abs

The Abs block receives decision coverage. Decision coverage is based on:

» Input to the block being less than zero.
» Data type of the input signal.

For input to the block being less than zero, the decision coverage measures:

* The number of time steps that the block input is less than zero, indicating a true
decision.

* The number of time steps the block input is not less than zero, indicating a false
decision.

If you select the Saturate on integer overflow coverage metric, the Abs block receives
saturate on integer overflow coverage. For more information, see “Saturate on Integer
Overflow Coverage” on page 1-8.

If the input data type to the Abs block is uint8, uint16, or uint32, the Simulink
Coverage software reports no coverage for the block. The software sets the block output
equal to the block input without making a decision. If the input data type to the Abs block
is Boolean, an error occurs.

The Abs block contains an implicit comparison of the input with zero. Therefore, if you
select the Relational Boundary coverage metric, the Abs block receives relational
boundary coverage. For more information, see “Relational Boundary Coverage” on page
1-9.
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Bias

If you select the Saturate on integer overflow coverage metric, the Bias block receives
saturate on integer overflow coverage. For more information, see “Saturate on Integer
Overflow Coverage” on page 1-8.

Combinatorial Logic

The Combinatorial Logic block receives decision and condition coverage. Decision
coverage is based on achieving each output row of the truth table. The decision coverage
measures the number of time steps that each output row of the truth table is set to the
block output.

The condition coverage measures the number of time steps that each input is false (equal
to zero) and the number of times each input is true (not equal to zero). If the
Combinatorial Logic block has a single input element, the Simulink Coverage software
reports only decision coverage, because decision and condition coverage are equivalent.

If all truth table values are set to the block output for at least one time step, decision
coverage is 100%. Otherwise, the software reports the coverage as the number of truth
table values output during at least one time step, divided by the total number of truth
table values. Because this block always has at least one value in the truth table as output,
the minimum coverage reported is one divided by the total number of truth table values.

If all block inputs are false for at least one time step and true for at least one time step,
condition coverage is 100%. Otherwise, the software reports the coverage as achieving a
false value at each input for at least one time step, plus achieving a true value for at least
one time step, divided by two raised to the power of the total number of inputs (i.e.,
2~number of inputs). The minimum coverage reported is the total number of inputs
divided by two raised to the power of the total number of inputs.

Compare to Constant
The Compare to Constant block receives condition coverage.

Condition coverage measures:

* the number of times that the comparison between the input and the specified constant
was true.
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* the number of times that the comparison between the input and the specified constant
was false.

The Compare to Constant block contains a comparison of the input with a constant.
Therefore, if you select the Relational Boundary coverage metric, the Compare to
Constant block receives relational boundary coverage. For more information, see
“Relational Boundary Coverage” on page 1-9.

Compare to Zero
The Compare to Zero block receives condition coverage.

Condition coverage measures:

* the number of times that the comparison between the input and zero was true.

* the number of times that the comparison between the input and zero was false.

The Compare to Zero block contains a comparison of the input with zero. Therefore, if you
select the Relational Boundary coverage metric, the Compare to Zero block receives

relational boundary coverage. For more information, see “Relational Boundary Coverage”
on page 1-9.

Data Type Conversion

If you select the Saturate on integer overflow coverage metric, the Data Type
Conversion block receives saturate on integer overflow coverage. For more information,
see “Saturate on Integer Overflow Coverage” on page 1-8.

Dead Zone

The Dead Zone block receives decision coverage. The Simulink Coverage software reports
decision coverage for these parameters:

« Start of dead zone
* End of dead zone

The Start of dead zone parameter specifies the lower limit of the dead zone. For the
Start of dead zone parameter, decision coverage measures:
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* The number of time steps that the block input is greater than or equal to the lower
limit, indicating a true decision.

* The number of time steps that the block input is less than the lower limit, indicating a
false decision.

The End of dead zone parameter specifies the upper limit of the dead zone. For the End
of dead zone, decision coverage measures:

* The number of time steps that the block input is greater than the upper limit,
indicating a true decision.

* The number of time steps that the block input is less than or equal to the upper limit,
indicating a false decision.

When the upper limit is true, the software does not measure Start of dead zone
coverage for that time step. Therefore, the total number of Start of dead zone decisions
equals the number of time steps that the End of dead zone is false.

If you select the Saturate on integer overflow coverage metric, the Dead Zone block
receives saturate on integer overflow coverage. For more information, see “Saturate on
Integer Overflow Coverage” on page 1-8.

The Dead Zone block contains an implicit comparison of the input with an upper and
lower limit value. Therefore, if you select the Relational Boundary coverage metric, the
Dead Zone block receives relational boundary coverage. For more information, see
“Relational Boundary Coverage” on page 1-9.

Direct Lookup Table (n-D)

The Direct Lookup Table (n-D) block receives lookup table coverage. For an n-dimensional
lookup table, the number of output break points is the product of all the number of break
points for each table dimension.

Lookup table coverage measures:
* The number of times during simulation that each combination of dimension input
values is between each of the break points.

* The number of times during simulation that each combination of dimension input
values is below the lowest break point and above the highest break point for each
table dimension.
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The total number of coverage points for an n-dimensional lookup table is the product of
the number of break points in each table dimension plus one. In the coverage report, an
increasing white-to-green color scale, with six evenly spaced data ranges starting with
zero, indicates the number of time steps that the software measures each interpolation or
extrapolation point.

The software determines a percentage of total coverage by measuring the total
interpolation and extrapolation points that achieve a measurement of at least one time
step during simulation between a break point or beyond the end points.

Discrete Filter

If you select the Saturate on integer overflow coverage metric, the Discrete Filter
block receives saturate on integer overflow coverage. For more information, see
“Saturate on Integer Overflow Coverage” on page 1-8.

Discrete FIR Filter

If you select the Saturate on integer overflow coverage metric, the Discrete FIR Filter
block receives saturate on integer overflow coverage. For more information, see
“Saturate on Integer Overflow Coverage” on page 1-8.

Discrete-Time Integrator

The Discrete-Time Integrator block receives decision coverage. The Simulink Coverage
software reports decision coverage for these parameters:

* External reset

* Limit output

If you set External reset to none, the Simulink Coverage software does not report
decision coverage for the reset decision. Otherwise, the decision coverage measures:

* The number of time steps that the block output is reset, indicating a true decision.

* The number of time steps that the block output is not reset, indicating a false decision.
If you do not select Limit output, the software does not report decision coverage for that

decision. Otherwise, the software reports decision coverage for the Lower saturation
limit and the Upper saturation limit.
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For the Upper saturation limit, decision coverage measures:

* The number of time steps that the integration result is greater than or equal to the
upper limit, indicating a true decision.

* The number of time steps that the integration result is less than the upper limit,
indicating a false decision.

For the Lower saturation limit, decision coverage measures

* The number of time steps that the integration result is less than or equal to the lower
limit, indicating a true decision.

* The number of time steps that the integration result is greater than the lower limit,
indicating a false decision.

For a time step when the upper limit is true, the software does not measure Lower
saturation limit coverage. Therefore, the total number of lower limit decisions equals
the number of time steps that the upper limit is false.

If you select the Saturate on integer overflow coverage metric, the Discrete-Time

Integrator block receives saturate on integer overflow coverage. For more information,
see “Saturate on Integer Overflow Coverage” on page 1-8.

Discrete Transfer Fcn
If you select the Saturate on integer overflow coverage metric, the Discrete Transfer

Fcn block receives saturate on integer overflow coverage. For more information, see
“Saturate on Integer Overflow Coverage” on page 1-8.

Dot Product
If you select the Saturate on integer overflow coverage metric, the Dot Product block

receives saturate on integer overflow coverage. For more information, see “Saturate on
Integer Overflow Coverage” on page 1-8.

Enabled Subsystem
The Enabled Subsystem block receives decision, condition, and MCDC coverage.

Decision coverage measures:
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* The number of time steps that the block is enabled, indicating a true decision.
* The number of time steps that the block is disabled, indicating a false decision.

If at least one time step is true and at least one time step is false, decision coverage is
100%. If no time steps are true, or if no time steps are false, decision coverage is 50%.

The Simulink Coverage software measures condition coverage for the enable input only if
the enable input is a vector. For the enable input, condition coverage measures the
number of time steps each element of the enable input is true and the number of time
steps each element of the enable input is false. The software reports condition coverage
based on the total number of possible conditions and how many are true for at least one
time step and how many are false for at least one time step.

The software measures MCDC coverage for the enable input only if the enable input is a
vector. Because the enable of the subsystem is an OR of the vector inputs, MCDC
coverage is 100% if, during at least one time step, each vector enable input is exclusively
true and if, during at least one time step, all vector enable inputs are false. For MCDC
coverage measurement, the software treats each element of the vector as a separate
condition.

Enabled and Triggered Subsystem

The Enabled and Triggered Subsystem block receives decision, condition, and MCDC
coverage. Decision coverage measures:

* The number of time steps that a trigger edge occurs while the block is enabled,
indicating a true decision.

* The number of time steps that a trigger edge does not occur while the block is
enabled, or the block is disabled, indicating a false decision.

If at least one time step is true and at least one time step is false, decision coverage is
100%. If no time steps are true, or if no time steps are false, decision coverage is 50%.

The software measures condition coverage for the enable input and for the trigger input
separately:

* For the enable input, condition coverage measures the number of time steps the
enable input is true and the number of time steps the enable input is false.

» For the trigger input, condition coverage measures the number of time steps the
trigger edge occurs, indicating true, and the number of time steps the trigger edge
does not occur, indicating false.
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The software reports condition coverage based on the total number of possible conditions
and how many conditions are true for at least one time step and how many are false for at
least one time step. The software treats each element of a vector as a separate condition
coverage measurement.

The software measures MCDC coverage for the enable input and for the trigger input in
combination. Because the enable input of the subsystem is an AND of these two inputs,
MCDC coverage is 100% if all of the following occur:

* During at least one time step, both inputs are true.
* During at least one time step, the enable input is true and the trigger edge is false.
* During one time step, the enable input is false and the trigger edge is true.

The software treats each vector element as a separate MCDC coverage measurement. It
measures each trigger edge element against each enable input element. However, if the
number of elements in both the trigger and enable inputs exceeds 12, the software does
not report MCDC coverage.

Fcn

The Fcn block receives condition and MCDC coverage. The Simulink Coverage software
reports condition or MCDC coverage for Fcn blocks only if the top-level operator is
Boolean (&&, | |, or !).

Condition coverage is based on input values or arithmetic expressions that are inputs to
Boolean operators in the block. The condition coverage measures:

* The number of time steps that each input to a Boolean operator is true (not equal to
Zero).

* The number of time steps that each input to a Boolean operator is false (equal to zero).

If all Boolean operator inputs are false for at least one time step and true for at least one
time step, condition coverage is 100%. Otherwise, the software reports condition
coverage based on the total number of possible conditions and how many are true for at
least one time step and how many are false for at least one time step.

The software measures MCDC coverage for Boolean expressions within the Fcn block. If,
during at least one time step, each condition independently sets the output of the
expression to true and if, during at least one time step, each condition independently sets
the output of the expression to false, MCDC coverage is 100%. Otherwise, the software
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reports MCDC coverage based on the total number of possible conditions and how many
times each condition independently sets the output to true during at least one time step
and how many conditions independently set the output to false during at least one time
step.

If the Fcn block contains a relational operation and you select the Relational Boundary
coverage metric, the Fcn block receives relational boundary coverage. For more
information, see “Relational Boundary Coverage” on page 1-9.

For Iterator, For Iterator Subsystem

The For Iterator block and For Iterator Subsystem receive decision coverage. The
Simulink Coverage software measures decision coverage for the loop condition value,
which is determined by one of the following:

* The iteration value being at or below the iteration limit, indicated as true.
* The iteration value being above the iteration limit, indicated as false.

The software reports the total number of times that each loop condition evaluates to true
and to false. If the loop condition evaluates to true at least once and false at least once,
decision coverage is 100%. If no loop conditions are true, or if no loop conditions are
false, decision coverage is 50%.

Gain

If you select the Saturate on integer overflow coverage metric, the Gain block receives
saturate on integer overflow coverage. For more information, see “Saturate on Integer
Overflow Coverage” on page 1-8.

If, If Action Subsystem

The If block that causes an If Action Subsystem to execute receives condition, decision,
and MCDC coverage:

* The software measures decision coverage for the if condition and all elseif
conditions defined in the If block.

» Ifthe if condition or any of the elseif conditions contains a logical expression with
multiple conditions, such as ul & u2 & u3, the software also measures condition and
MCDC coverage for each condition in the expression, ul, u2, and u3 in the preceding
example.
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The software does not directly measure the else condition. When there are no elseif
conditions, the else condition is the direct complement of the if condition, or the else
condition is the direct complement of the last elseif condition.

The software reports the total number of time steps that each if and elseif condition
evaluates to true and to false. If the if or elseif condition evaluates to true at least
once, and evaluates to false at least once, decision coverage is 100%. If no if or elseif
conditions are true, or if no if or elseif conditions are false, decision coverage is 50%.
If the previous if or elseif condition never evaluates as false, an elseif condition can
have 0% decision coverage.

The If block contains a comparison between its inputs. Therefore, if you select the
Relational Boundary coverage metric, the If block receives relational boundary
coverage. For more information, see “Relational Boundary Coverage” on page 1-9.

Interpolation Using Prelookup

The Interpolation Using Prelookup block receives lookup table coverage. For an n-D
lookup table, the number of output break points equals the product of all the number of
break points for each table dimension. The lookup table coverage measures:

* The number of times during simulation that each combination of dimension input
values is between each of the break points.

* The number of times during simulation that each combination of dimension input
values is below the lowest break point and above the highest break point for each
table dimension.

The total number of coverage points for an n-dimensional lookup table is the product of
the number of break points in each table dimension plus one. In the coverage report, an
increasing white-to-green color scale, with six evenly spaced data ranges starting with
zero, indicates the number of time steps that the software measures each interpolation or
extrapolation point.

The software determines a percentage of total coverage by measuring the total
interpolation and extrapolation points that achieve a measurement of at least one time
step during simulation between a break point or beyond the end points.

If you select the Saturate on integer overflow, the Interpolation Using Prelookup block
receives saturate on integer overflow coverage. For more information, see “Saturate on
Integer Overflow Coverage” on page 1-8. The software treats each element of a vector or
matrix as a separate coverage measurement.
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Library-Linked Objects

Simulink blocks and Stateflow charts that are linked to library objects receive the same
coverage that they would receive if they were not linked to library objects. The Simulink
Coverage software records coverage individually for each library object in the model. If
your model contains multiple instances of the same library object, each instance receives
its own coverage data.

Logical Operator

The Logical Operator block receives condition and MCDC coverage. The Simulink
Coverage software measures condition coverage for each input to the block. The
condition coverage measures:

* The number of time steps that each input is true (not equal to zero).
* The number of time steps that each input is false (equal to zero).

If all block inputs are false for at least one time step and true for at least one time step,
the software condition coverage is 100%. Otherwise, the software reports the condition
coverage based on the total number of possible conditions and how many are true at least
one time step and how many are false at least one time step.

The software measures MCDC coverage for all inputs to the block. If, during at least one
time step, each condition independently sets the output of the block to true and if, during
at least one time step, each condition independently sets the output of the block to false,
MCDC coverage is 100%. Otherwise, the software reports the MCDC coverage based on
the total number of possible conditions and how many times each one of them
independently set the output to true for at least one time step and how many
independently set the output to false for at least one time step.

1-D Lookup Table

The 1-D Lookup Table block receives lookup table coverage; for a one-dimensional lookup
table, the number of input and output break points is equal. Lookup table coverage
measures:

* The number of times during simulation that the input and output values are between
each of the break points.

* The number of times during simulation that the input and output values are below the
lowest break point and above the highest break point.
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The total number of coverage points for a one-dimensional lookup table is the number of
break points in the table plus one. In the coverage report, an increasing white-to-green
color scale, with six evenly spaced data ranges starting with zero, indicates the number of
time steps that the software measures each interpolation or extrapolation point.

The software determines a percentage of total coverage by measuring the total
interpolation and extrapolation points that achieve a measurement of at least one time
step during simulation between a break point or beyond the end points.

If you select the Saturate on integer overflow coverage metric, the 1-D Lookup Table
block receives saturate on integer overflow coverage. For more information, see
“Saturate on Integer Overflow Coverage” on page 1-8. The software treats each element
of a vector or matrix as a separate coverage measurement.

2-D Lookup Table

The 2-D Lookup Table block receives lookup table coverage. For a two-dimensional lookup
table, the number of output break points equals the number of row break points
multiplied by the number of column inputs. Lookup table coverage measures:

* The number of times during simulation that each combination of row input and column
input values is between each of the break points.

* The number of times during simulation that each combination of row input and column
input values is below the lowest break point and above the highest break point for
each row and column,

The total number of coverage points for a two-dimensional lookup table is the number of
row break points in the table plus one, multiplied by the number of column break points
in the table plus one. In the coverage report, an increasing white-to-green color scale,
with six evenly spaced data ranges starting with zero, indicates the number of time steps
that the software measures each interpolation or extrapolation point.

If you select the Saturate on integer overflow coverage metric, the 2-D Lookup Table
block receives saturate on integer overflow coverage. For more information, see
“Saturate on Integer Overflow Coverage” on page 1-8. The software treats each element
of a vector or matrix as a separate coverage measurement.
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n-D Lookup Table

The n-D Lookup Table block receives lookup table coverage. For an n-dimensional lookup
table, the number of output break points equals the product of all the number of break
points for each table dimension. Lookup table coverage measures:

* The number of times during simulation that each combination of dimension input
values is between each of the break points.

* The number of times during simulation that each combination of dimension output
values is below the lowest break point and above the highest break point for each
table dimension.

The total number of coverage points for an n-dimensional lookup table is the product of
the number of break points in each table dimension plus one. In the coverage report, an
increasing white-to-green color scale, with six evenly spaced data ranges starting with
zero, indicates the number of time steps that the software measures each interpolation or
extrapolation point.

The software determines a percentage of total coverage by measuring the total
interpolation and extrapolation points that achieve a measurement of at least one time
step during simulation between a break point or beyond the end points.

If you select the Saturate on integer overflow coverage metric, the n-D Lookup Table
block receives saturate on integer overflow coverage. For more information, see
“Saturate on Integer Overflow Coverage” on page 1-8. The software treats each element
of a vector or matrix as a separate coverage measurement.

Math Function

If you select the Saturate on integer overflow coverage metric, the Math Function
block receives saturate on integer overflow coverage. For more information, see
“Saturate on Integer Overflow Coverage” on page 1-8. The software treats each element
of a vector or matrix as a separate coverage measurement.

MATLAB Function

For information about the type of coverage that the Simulink Coverage software reports
for the MATLAB Function block, see “Model Coverage for MATLAB Functions” on page 5-
30.
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MATLAB System

Simulink Coverage records only Decision, Condition, and MCDC coverage for MATLAB
System blocks.

MinMax

The MinMax block receives decision coverage based on passing each input to the output
of the block.

For decision coverage based on passing each input to the output of the block, the
coverage measures the number of time steps that the simulation passes each input to the
block output. The number of decision points is based on the number of inputs to the block
and whether they are scalar, vector, or matrix.

If all inputs are passed to the block output for at least one time step, the Simulink
Coverage software reports the decision coverage as 100%. Otherwise, the software
reports the coverage as the number of inputs passed to the output during at least one
time step, divided by the total number of inputs.

If you select the Saturate on integer overflow coverage metric, the MinMax block
receives saturate on integer overflow coverage. For more information, see “Saturate on
Integer Overflow Coverage” on page 1-8. The software treats each element of a vector or
matrix as a separate coverage measurement.

Model

The Model block does not receive coverage directly; the model that the block references
receives coverage. If the simulation mode for the referenced model is set to Normal, the
Simulink Coverage software reports coverage for all objects within the referenced model
that receive coverage. . If the simulation mode for the referenced model is set to SIL or
PIL and you have Embedded Coder installed, the Simulink Coverage software reports
coverage for the code generated from your model .If the simulation mode is set to a value
other than Normal, SIL, or PIL, the software cannot measure coverage for the
referenced model.

In the Coverage pane of the Configuration Parameters dialog box, select the referenced

models for which you want to report coverage. The software generates a coverage report
for each referenced model you select.
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If your model contains multiple instances of the same referenced model, the software
records coverage for all instances of that model where the simulation mode of the Model
block is set to Normal. The coverage report for that referenced model combines the
coverage data for all Normal mode instances of that model.

The coverage reports for referenced models are linked from a summary report for the
parent model.

Note For details on how to select referenced models to report coverage, see “Referenced
Models” on page 3-4.

Multiport Switch

The Multiport Switch block receives decision coverage based on passing each input,
excluding the first control input, to the output of the block.

For decision coverage based on passing each input, excluding the first control input, to
the output of the block, the coverage measures the number of time steps that each input
is passed to the block output. The number of decision points is based on the number of
inputs to the block and whether the control input is scalar or vector.

If all inputs, excluding the first control input, are passed to the block output for at least
one time step, decision coverage is 100%. Otherwise, the Simulink Coverage software
reports coverage as the number of inputs passed to the output during at least one time
step, divided by the total number of inputs minus one.

If you select the Saturate on integer overflow coverage metric, the Multiport Switch
block receives saturate on integer overflow coverage. For more information, see
“Saturate on Integer Overflow Coverage” on page 1-8. The software treats each element
of a vector or matrix as a separate coverage measurement.

PID Controller, PID Controller (2 DOF)

If you select the Saturate on integer overflow coverage metric, the PID Controller and
PID Controller (2 DOF) blocks receive saturate on integer overflow coverage. For more
information, see “Saturate on Integer Overflow Coverage” on page 1-8. The software
treats each element of a vector or matrix as a separate coverage measurement.
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Product

If you select the Saturate on integer overflow coverage metric, the Product block
receives saturate on integer overflow coverage. For more information, see “Saturate on
Integer Overflow Coverage” on page 1-8. The software treats each element of a vector or
matrix as a separate coverage measurement.

Proof Assumption

The Proof Assumption block receives Simulink Design Verifier coverage. Simulink Design
Verifier coverage is based on the points and intervals defined in the block dialog box.
Simulink Design Verifier coverage measures the number of time steps that each point or
interval defined in the block is satisfied. The total number of objective outcomes is based
on the number of points or intervals defined in the Proof Assumption block.

If all points and intervals defined in the block are satisfied for at least one time step,
Simulink Design Verifier coverage is 100%. Otherwise, the Simulink Coverage software
reports coverage as the number of points and intervals satisfied during at least one time
step, divided by the total number of points and intervals defined for the block.

Proof Objective

The Proof Objective block receives Simulink Design Verifier coverage. Simulink Design
Verifier coverage is based on the points and intervals defined in the block dialog box.
Simulink Design Verifier coverage measures the number of time steps that each point or
interval defined in the block is satisfied. The total number of objective outcomes is based
on the number of points or intervals defined in the Proof Objective block.

If all points and intervals defined in the block are satisfied for at least one time step,
Simulink Design Verifier coverage is 100%. Otherwise, the Simulink Coverage software
reports coverage as the number of points and intervals satisfied during at least one time
step, divided by the total number of points and intervals defined for the block.

Rate Limiter

The Rate Limiter block receives decision coverage. The Simulink Coverage software
reports decision coverage for the Rising slew rate and Falling slew rate parameters.

For the Rising slew rate, decision coverage measures:
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* The number of time steps that the block input changes more than or equal to the
rising rate, indicating a true decision.

* The number of time steps that the block input changes less than the rising rate,
indicating a false decision.

For the Falling slew rate, decision coverage measures:

* The number of time steps that the block input changes less than or equal to the falling
rate, indicating a true decision.

* The number of time steps that the block input changes more than the falling rate,
indicating a false decision.

The software does not measure Falling slew rate coverage for a time step when the
Rising slew rate is true. Therefore, the total number of Falling slew rate decisions
equals the number of time steps that the Rising slew rate is false.

If at least one time step is true and at least one time step is false, decision coverage for
each of the two individual decisions for the block is 100%. If no time steps are true, or if
no time steps are false, decision coverage is 50%. The software treats each element of a
vector or matrix as a separate coverage measurement.

The Rate Limiter block implicitly compares the derivative of the input signal with an
upper and lower limit value. Therefore, if you select the Relational Boundary coverage
metric, the Rate Limiter block receives relational boundary coverage. For more
information, see “Relational Boundary Coverage” on page 1-9.

Relational Operator
The Relational Operator block receives condition coverage.

Condition coverage measures:

* the number of times that the specified relational operation was true.
* the number of times that the specified relational operation was false.

The Relational Operator block contains a comparison between its inputs. Therefore, if you
select the Relational Boundary coverage metric, the Relational Operator block receives
relational boundary coverage. For more information, see “Relational Boundary Coverage”
on page 1-9.
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Relay

The Relay block receives decision coverage. The Simulink Coverage software reports
decision coverage for the Switch on point and the Switch off point parameters.

For the Switch on point, decision coverage measures:

* The number of consecutive time steps that the block input is greater than or equal to
the Switch on point, indicating a true decision.

* The number of consecutive time steps that the block input is less than the Switch on
point, indicating a false decision.

For the Switch off point, decision coverage measures:

* The number of consecutive time steps that the block input is less than or equal to the
Switch off point, indicating a true decision.

* The number of consecutive time steps that the block input is greater than the Switch
off point, indicating a false decision.

The software does not measure Switch off point coverage for a time step when the
switch on threshold is true. Therefore, the total number of Switch off point decisions
equals the number of time steps that the Switch on point is false.

If at least one time step is true and at least one time step is false, decision coverage for
each of the two individual decisions for the block is 100%. If no time steps are true, or if
no time steps are false, decision coverage is 50%. The software treats each element of a
vector or matrix as a separate coverage measurement.

The Relay block contains an implicit comparison of its second input with a threshold
value. Therefore, if you select the Relational Boundary coverage metric, the Relay block
receives relational boundary coverage. For more information, see “Relational Boundary
Coverage” on page 1-9.

C/C++ S-Function

Model coverage is supported for C/C++ S-Functions. The coverage report for the model
contains results for each instance of an S-Function block in the model. The results for an
S-Function block link to a separate coverage report for the C/C++ code in the block.

To generate coverage report for S-Functions:
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When creating the S-Functions, enable support for coverage. For more information,
see “Make S-Function Compatible with Model Coverage” on page 5-47.

When generating the coverage report, enable support for S-Functions. For more
information, see “Generate Coverage Report for S-Function” on page 5-48.

The following coverage types are reported for S-Functions:

“Cyclomatic Complexity for Code Coverage” on page 4-5

“Condition Coverage for Code Coverage” on page 4-3

“Decision Coverage for Code Coverage” on page 4-3

“Modified Condition/Decision Coverage (MCDC) for Code Coverage” on page 4-4
“Relational Boundary for Code Coverage” on page 4-5

Percentage of statements covered

The coverage data for S-Function blocks is obtained in the following way:

The coverage result for a block is a weighted average of the result over all files in the
block.

For instance, an S-Function block has two files, filel.c and file2. c. The decision
coverage for filel. c is 75% (3/4 outcomes covered) and that for file2.c is 50%
(10/20 outcomes covered). The decision coverage for the block is 13/24 = 54 %.

For each file, the coverage result is a weighted average of the result over all functions
in the file.

For each function, the coverage result is a weighted average of the result over all
statements in the function that receive that coverage.

Note Model coverage for S-Functions have the following restrictions:

Only Level-2 C/C++ S-Functions are supported for coverage. For an example of a
level-2 C S-Function, see “Create a Basic C MEX S-Function” (Simulink).

C++ class templates are not instrumented for coverage.

Saturation

The Saturation block receives decision coverage. The Simulink Coverage software reports
decision coverage for the Lower limit and Upper limit parameters.
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For the Upper limit, decision coverage measures:

* The number of time steps that the block input is greater than or equal to the upper
limit, indicating a true decision.

» The number of time steps that the block input is less than the upper limit, indicating a
false decision.

For the Lower limit, decision coverage measures:

» The number of time steps that the block input is greater than the lower limit,
indicating a true decision.

* The number of time steps that the block input is less than or equal to the lower limit,
indicating a false decision.

The software does not measure Lower limit coverage for a time step when the upper
limit is true. Therefore, the total number of Lower limit decisions equals the number of
time steps that the Upper limit is false.

If at least one time step is true and at least one time step is false, decision coverage for
each of the two individual decisions for the Saturation block is 100%. If no time steps are
true, or if no time steps are false, decision coverage is 50%. The software treats each
element of a vector or matrix as a separate coverage measurement.

The Saturation block contains an implicit comparison of the input with an upper and
lower limit value. Therefore, if you select the Relational Boundary coverage metric, the
Saturation block receives relational boundary coverage. For more information, see
“Relational Boundary Coverage” on page 1-9.

Saturation Dynamic
If you select the Saturate on integer overflow coverage metric, the Saturation Dynamic
block receives saturate on integer overflow coverage. For more information, see

“Saturate on Integer Overflow Coverage” on page 1-8. The software treats each element
of a vector or matrix as a separate coverage measurement.

Simulink Design Verifier Functions in MATLAB Function Blocks

The following functions in MATLAB Function blocks receive Simulink Design Verifier
coverage:
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* sldv.condition

* sldv.test

* sldv.assume

* sldv.prove

Each of these functions evaluates an expression expr, for example, sldv.test(expr),

where expr is any valid Boolean MATLAB expression. Simulink Design Verifier coverage
measures the number of time steps that the expression expr evaluates to true.

If expr is true for at least one time step, Simulink Design Verifier coverage for that
function is 100%. Otherwise, the Simulink Coverage software reports coverage for that
function as 0%.

Sqrt, Signed Sqrt, Reciprocal Sqrt

If you select the Saturate on integer overflow coverage metric, the Sqrt, Signed Sqrt,
and Reciprocal Sqrt blocks receive saturate on integer overflow coverage. For more
information, see “Saturate on Integer Overflow Coverage” on page 1-8. The software
treats each element of a vector or matrix as a separate coverage measurement.

Sum, Add, Subtract, Sum of Elements

If you select the Saturate on integer overflow coverage metric, the Sum, Add, Subtract,
and Sum of Elements blocks receive saturate on integer overflow coverage. For more
information, see “Saturate on Integer Overflow Coverage” on page 1-8. The software
treats each element of a vector or matrix as a separate coverage measurement.

Switch

The Switch block receives decision coverage based on the control input to the block.
Decision coverage measures:

* The number of time steps that the control input evaluates to true.
* The number of time steps the control input evaluates to false.

The number of decision points is based on whether the control input is scalar or vector.

If you select the Saturate on integer overflow coverage metric, the Switch block
receives saturate on integer overflow coverage. For more information, see “Saturate on
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Integer Overflow Coverage” on page 1-8. The software treats each element of a vector or
matrix as a separate coverage measurement.

The Switch block contains an implicit comparison of its second input with a threshold
value. Therefore, if you select the Relational Boundary coverage metric, the Switch
block receives relational boundary coverage. For more information, see “Relational
Boundary Coverage” on page 1-9.

SwitchCase, SwitchCase Action Subsystem

The SwitchCase block and SwitchCase Action Subsystem receive decision coverage. The
Simulink Coverage software measures decision coverage individually for each switch case
defined in the block and also for the default case. The number of decision outcomes is
equal to the number of case conditions plus one for the default case, if one is defined.

The software reports the total number of time steps that each case evaluates to true. If
each case, including the default case, evaluates to true at least once, decision coverage is
100%. The software determines the decision coverage by the number of cases that
evaluate true for at least one time step divided by the total number of cases.

If the SwitchCase block does not contain a default case, the software measures decision
coverage for the number of time steps in which none of the cases evaluated to true. In the
coverage report, this coverage is reported as implicit-default.

Test Condition

The Test Condition block receives Simulink Design Verifier coverage. Simulink Design
Verifier coverage is based on the points and intervals defined in the block dialog box.
Simulink Design Verifier coverage measures the number of time steps that each point or
interval defined in the block is satisfied. The total number of ohjective outcomes is based
on the number of points or intervals defined in the Test Condition block.

If all points and intervals defined in the block are satisfied for at least one time step,
Simulink Design Verifier coverage is 100%. Otherwise, the Simulink Coverage software
reports coverage as the number of points and intervals satisfied during at least one time
step, divided by the total number of points and intervals defined for the block.

Test Objective

The Test Objective block receives Simulink Design Verifier coverage. Simulink Design
Verifier coverage is based on the points and intervals defined in the block dialog box.
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Simulink Design Verifier coverage measures the number of time steps that each point or
interval defined in the block is satisfied. The total number of objective outcomes is based
on the number of points or intervals defined in the Test Objective block.

If all points and intervals defined in the block are satisfied for at least one time step,
Simulink Design Verifier coverage is 100%. Otherwise, the Simulink Coverage software
reports coverage as the number of points and intervals satisfied during at least one time
step, divided by the total number of points and intervals defined for the block.

Triggered Models

A Model block can reference a model that contains edge-based trigger ports at the root
level of the model. Triggered models receive decision, condition, and MCDC coverage.

Decision coverage measures:

* The number of time steps that the referenced model is triggered, indicating a true
decision.

* The number of time steps that the referenced model is not triggered, indicating a false
decision.

If at least one time step is true and at least one time step is false, decision coverage for
the Model block that references the triggered model is 100%. If no time steps are true, or
if no time steps are false, decision coverage is 50%.

Only if the trigger input is a vector, the Simulink Coverage software measures condition
coverage for the trigger port in the referenced model. For the trigger port, condition
coverage measures:

* The number of time steps that each element of the trigger port is true.
* The number of time steps that each element of the trigger port is false.

The software reports condition coverage based on the total number of possible conditions
and how many are true for at least one time step and how many are false for at least one
time step.

If the trigger port is a vector, the software measures MCDC coverage for the trigger port
only. Because the trigger port of the referenced model is an OR of the vector inputs, if,

during at least one time step, each vector trigger port is exclusively true and if, during at
least one time step, all vector trigger port inputs are false, MCDC coverage is 100%. The
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software treats each element of the vector as a separate condition for MCDC coverage
measurement.

Triggered Subsystem
The Triggered Subsystem block receives decision, condition, and MCDC coverage.

Decision coverage measures:

* The number of time steps that the block is triggered, indicating a true decision.
* The number of time steps that the block is not triggered, indicating a false decision.

If at least one time step is true and at least one time step is false, decision coverage is
100%. If no time steps are true, or if no time steps are false, decision coverage is 50%.

The Simulink Coverage software measures condition coverage for the trigger input only if
the trigger input is a vector. For the trigger input, condition coverage measures:

* The number of time steps that each element of the trigger edge is true.

* The number of time steps that each element of the trigger edge is false.

The software reports condition coverage based on the total number of possible conditions
and how many are true for at least one time step and how many are false for at least one
time step.

If the trigger input is a vector, the software measures MCDC coverage for the trigger
input only. Because the trigger edge of the subsystem is an OR of the vector inputs, if,
during at least one time step, each vector trigger edge input is exclusively true and if,
during at least one time step, all vector trigger edge inputs are false, MCDC coverage is
100%. The software treats each element of the vector as a separate condition for MCDC
coverage measurement.

Truth Table

The Truth Table block is a Stateflow block that enables you to use truth table logic
directly in a Simulink model. The Truth Table block receives condition, decision, and
MCDC coverage. For more information on model coverage with Stateflow truth tables, see
“Model Coverage for Stateflow Truth Tables” on page 5-76.
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Unary Minus

If you select the Saturate on integer overflow coverage metric, the Unary Minus block
receives saturate on integer overflow coverage. For more information, see “Saturate on
Integer Overflow Coverage” on page 1-8. The software treats each element of a vector or
matrix as a separate coverage measurement.

Weighted Sample Time Math

If you select the Saturate on integer overflow coverage metric, the Weighted Sample
Time Math block receives saturate on integer overflow coverage. For more information,
see “Saturate on Integer Overflow Coverage” on page 1-8. The software treats each
element of a vector or matrix as a separate coverage measurement.

While Iterator, While Iterator Subsystem

The While Iterator block and While Iterator Subsystem receive decision coverage.
Decision coverage is measured for the while condition value, which is determined by the
while condition being satisfied (true), or the while condition not being satisfied (false).
Simulink Coverage software reports the total number of times that each while condition
evaluates to true and to false. If the while condition evaluates to true at least once, and
false at least once, decision coverage for the while condition is 100%. If no while
conditions are true, or if no while conditions are false, decision coverage is 50%.

If the iteration limit is exceeded (true) or is not exceeded (false), the software measures
decision coverage independently. If the iteration limit evaluates to true at least once, and
false at least once, decision coverage for the iteration limit is 100%. If no iteration limits
are true, or if no iteration limits are false, decision coverage is 50%. If you set Maximum
number of iterations to -1 (no limit), the decision coverage for the iteration limit is true
for all iterations and false for zero iterations, and decision coverage is 50%.
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Model Objects That Do Not Receive Coverage

The Simulink Coverage software does not record Decision, Condition, or MCDC coverage
for blocks that are not listed in “Model Objects That Receive Coverage” on page 2-2.

Note The software only records model coverage when the Simulation mode parameter
is set to Normal. If you have Embedded Coder installed, the software can measure the
coverage of code generated from models in SIL or PIL mode. For more information,
see“Code Coverage for Models in Software-in-the-Loop (SIL) Mode and Processor-in-the-
Loop (PIL) Mode” on page 4-7.

The following table identifies specific model objects that do not receive coverage in
certain conditions.

Model object Does not receive coverage...

Logical Operator block When the Operator parameter specifies
XOR or NXOR and there are more than
twelve scalar inputs or more than twelve
elements in a vector input.

Model block When the Simulation mode parameter
specifies Accelerator.

Coverage for Model blocks is the sum of the
coverage data for the contents of the
referenced model.

Subsystem block When the Read/Write Permissions
parameter is set to NoReadOrWrite.

Stateflow chart When debugging/animation is not enabled
for the model or object.

MATLAB Function block

Virtual Blocks doc Virtual blocks do not receive model

coverage. For more information, see
“Nonvirtual and Virtual Blocks” (Simulink).
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* “Specify Coverage Options” on page 3-2
* “Access, Manage, and Accumulate Coverage Results” on page 3-10
* “Cumulative Coverage Data” on page 3-21
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Specify Coverage Options

Before starting a coverage analysis, you specify several coverage recording options. In
the Simulink Editor, select Analysis > Coverage > Settings.

In this section...

“Coverage Pane” on page 3-2

“Results Pane” on page 3-7

Coverage Pane

On the Coverage pane in the Configuration Parameters dialog box, set the options for the
coverage calculated during simulation.
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& Configuration Parameters: sivnvdemo_counter/Configuration (Active) - O x
Solver Enable coverage analysis
Data Import/Export
» Optimization (®) Entire System

> Diagnostics (_)Referenced Models Select Models...
Hardware Implementation (_)Subsystem Select Subsystemn
Model Referencing ect Subsystem...
Simulation Target

» Code Generation

¥ Coverage MATLAE files

Results C/C++ S-functions
* Design Verifier

Include in analysis

Coverage metrics

Structural coverage level: |Modified Condition Decision Coverage (MCDC) | -

» Other metrics

OK Cancel Help Apply

Enable coverage analysis

Gather specified coverage results during simulation and report the coverage. When you
select Enable coverage analysis, these sections become available:

* “Scope of analysis” on page 3-4
* “Include in analysis” on page 3-6
* “Coverage metrics” on page 3-7
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Scope of analysis

Specifies the systems for which the software gathers and reports coverage data. The
options are:

* “Entire System” on page 3-4

* “Referenced Models” on page 3-4

* “Subsystem” on page 3-5

You must select Enable coverage analysis to specify the scope of analysis.
Entire System

By default, generates coverage data for the entire system. The coverage results include
the top-level and all supported subsystems and model references.

Referenced Models

Coverage analysis records the coverages for the referenced models that you select. By
default, generates coverage data for all referenced models where the simulation mode of
the Model block is set to Normal, Software-in-the-loop (SIL), or Processor-in-
the-loop (PIL).

To specify the referenced models for which the Simulink Coverage software records
coverage data:

1 In the Configuration Parameters dialog box, on the Coverage pane, select Enable
coverage analysis.

2 Click Select Models.
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J'.'ﬁ Select Models for Coverage Analysis

4 [0 sidemo_mdiref_basic
@ sidemo_mdiref_counter
sldemo_mdiref_counter {SIL)
sldemo_mdiref_counter

Ready

oo ]

Instructions

To enable or disable model coverage for a referenced model, select or clear the check box next to
the model's name.

To enable or disable model coverage for all referenced models in a hierarchy, right-click the
topmost model in the hierarchy and then select Select All or Deselect All. Right-click a
referenced model and select Open to open that model.

MNote that you can record model coverage for model references that operate in Normal mode or
code coverage for model references that operate in Software-in-the-Loop (SIL) or Processor-in-the-
Loop (PIL) modes. You cannot enable coverage for model references whose Simulation mode
parameter specifies "Accelerator'.

For more information, click Help.
Legend

@ MNormal Mode
Accelerated, Software-in-the-Loop (SIL), or Processor-in-the-Loop (PIL) Mode

ok || cance |[ hep Apply

3 In the Select Models for Coverage Analysis dialog box, select the referenced models
for which you want to record coverage. You can also select the top-level model.

The icon next to the model name indicates the simulation mode for that referenced
model. You can select only referenced models whose simulation mode is set to

Normal, SIL, or PIL.

If you have multiple Model blocks that reference the same model and whose
simulation modes are the same, selecting the check box for that model selects the
check boxes for all instances of that model with the same simulation mode.

4 To close the Select Models for Coverage Analysis dialog box and return to the
Configuration Parameters dialog box, click OK.

Subsystem

Coverage analysis records coverage during simulation for the subsystem that you select.
By default, generates coverage data for the entire model. To restrict coverage reporting

to a particular subsystem:
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3

In the Configuration Parameters dialog box, on the Coverage pane, select Enable
coverage analysis.

Click Select Subsystem.

b

Subsystern Selection @

4 :5f car
Engine
User Inputs
Vehicle
4 shift_logic
4 selection_state.calc_th
Look-Up
4 fransmission
Torque
Converter il

m

oK ] l Cancel

In the Subsystem Selection dialog box, select the subsystem for which you want to
enable coverage reporting and click OK.

Include in analysis

The Include in analysis section contains two options:

MATLAB files enables coverage for any external functions called by MATLAB
functions in your model. You can define MATLAB functions in MATLAB Function blocks
or in Stateflow charts.

To select the Coverage for MATLAB files option, you must select Enable coverage
analysis.

C/C++ S-functions enables coverage for C/C++ S-Function blocks in your model.
Coverage metrics are reported for the S-Function blocks and the C/C++ code in those
blocks. For more information, see “Generate Coverage Report for S-Function” on page
5-48.

You must select Enable coverage analysis to select the Coverage for S-Functions
option.
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Coverage metrics

Select the structural coverage level and other types of test case coverage analysis that
you want the tool to perform (see “Types of Model Coverage” on page 1-3). The Simulink
Coverage software gathers and reports those types of coverage for the subsystems,
models, and referenced models that you specify.

The structural coverage levels are listed in order of strictness of test case coverage
analysis:
* Block Execution — Enables “Execution Coverage (EC)” on page 1-3

* Decision — Enables “Execution Coverage (EC)” on page 1-3 and “Decision Coverage
(DC)” on page 1-3

* Condition Decision — Enables “Execution Coverage (EC)” on page 1-3, “Decision
Coverage (DC)” on page 1-3, and “Condition Coverage (CC)” on page 1-3

* Modified Condition Decision Coverage (MCDC) — enables “Execution
Coverage (EC)” on page 1-3, “Decision Coverage (DC)” on page 1-3, “Condition
Coverage (CC)” on page 1-3, and “Modified Condition/Decision Coverage (MCDC)” on
page 1-4

Coverage metrics also includes Other metrics:

* “Lookup Table Coverage” on page 1-5

+ “Signal Range Coverage” on page 1-6

* “Signal Size Coverage” on page 1-7

* “Objectives and Constraints Coverage” on page 1-7

» “Saturate on Integer Overflow Coverage” on page 1-8

» “Relational Boundary Coverage” on page 1-9

You must select Enable coverage analysis to select the coverage metrics.

Results Pane

On the Coverage > Results pane in the Configuration Parameters dialog box, select the
destination for coverage results. You must select Enable coverage analysis on the
Coverage pane to set the Coverage > Results pane options.
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2% Configuration Parameters: shvnvdemo_counter/Configuration (Active) — O >
Solver Show Results Explorer

Data Import/Export
o p. P [ | Display coverage results using model coloring
* Optimization

» Diagnostics || Generate report automatically after analysis

Hardware Implementation [ ] save last run in workspace variable

Model Referencing
) . Autosave data file name: |$ModelNamed cvdata
Simulation Target =
¢ Code Generation Output directory: slcov_output’SModelNamed
¥ Coverage

Results

* Design Verifier

OK Cancel Help Apply

Show Results Explorer
After simulation, shows the results explorer.
Display coverage results using model coloring

After simulation, colors model objects according to their level of coverage. Objects
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highlighted in light green receive full coverage during testing. Objects highlighted in light
red receive incomplete coverage. See “View Coverage Results in a Model” on page 5-12.

Note If you use the toolbar buttons to simulate a model with coverage enabled, this
setting is not honored and the model coloring for coverage results always appears after
each simulation. You can click Highlight model with coverage results in the Results
Explorer to enable or disable model coverage highlighting. You access the Results
Explorer by selecting Analysis > Coverage > Open Results Explorer. For more
information, see “Accessing Coverage Data from the Results Explorer” on page 3-10.




See Also

Generate report automatically after analysis

Specifies whether to open a generated HTML coverage report in a MATLAB browser
window at the end of model simulation.

Save last run in workspace variable

Saves the results of the last simulation run in a cvdata object in the workspace. Specify
the workspace variable name in cvdata object name.

cvdata object name

Name of the workspace variable where the results of the last simulation run are saved.
You must select Save last run in workspace variable to specify the cvdata object
name.

Increment variable name with each simulation (varl, var2, ...)

Appends numerals to the workspace variable names for each new result so that earlier
results are not overwritten. You must select Save last run in workspace variable to
enable this option.

Autosave data file name

Name of file to which coverage data results are saved. The default name is $ModelName
$ cvdata. $ModelName$ is the name of the model.

Output directory

The folder where the coverage data is saved. The default location is slcov_output/
$ModelName$ in the current folder. $ModelName$ is the name of the model.

See Also

Related Examples

. “Access, Manage, and Accumulate Coverage Results” on page 3-10
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Access, Manage, and Accumulate Coverage Results

After you “Specify Coverage Options” on page 3-2 and record coverage results, you can
use the Results Explorer to access, manage, and accumulate the coverage data that you
record. After you accumulate the coverage results you need, you can then create a “Top-
Level Model Coverage Report” on page 6-12 or “Export Model Coverage Web View” on
page 6-48 using your accumulated coverage data.

In this section...

“Accessing Coverage Data from the Results Explorer” on page 3-10
“Managing Coverage Data from the Results Explorer” on page 3-18
“Accumulating Coverage Data from the Results Explorer” on page 3-18

Accessing Coverage Data from the Results Explorer

In the Configuration Parameters dialog box, on the Coverage > “Results Pane” on page
3-7, you can specify whether to show the Results Explorer after each simulation. You can
also specify whether to generate an HTML report after each simulation. If you do not
specify to show the Results Explorer or generate an HTML report, you can access the
Results Explorer by selecting Analysis > Coverage > Open Results Explorer after you
record coverage. The Coverage Results Explorer opens to show the most recent coverage
run:

3-10




Access, Manage, and Accumulate Coverage Results

Coverage Results: sf_car

r] E sf_car
& Settings
4 |24 Current Cumulative Data
|5 Run 1
» |3 Data Repository

Coverage Data

Mode| version 1.120
Author The MathWaorks, Inc.
Started execution 28-Jun-2016 14:03:56
File name: sf_car_cwdata
Description

Tag: Run 1
Summary

Model Hierarchy/Complexity

Decision Condition MCDC

L. sf_car 32 7% TS0 50%
2....Engine MA A NA

3....Vehicle NA NA NA

4. . .. shift_logic 26 7BV 7550 50%0
L A SF: shift_logic 25 7BV 7550 50%0
Beasssanaas SF: o &9, MA MNA

gear_state

Townnanns SF: 16 BEYD 7500 50%

Generate report
Highlight model with coverage results

TBL
2T7%
11%0

MA

17%0

17%0

17%

= e >

Execution
100%
100%
100%
100%
100%

MA

100%

:.r:p-r?rt

m

You can view the current data results summary from within the Results Explorer or click
Generate Report to create a full coverage report. If you do not make any changes to
your model after you record coverage, you do not need to resimulate the model to
generate a new coverage report. For more information on coverage reports, see “Top-
Level Model Coverage Report” on page 6-12.
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Click Highlight model with coverage results to provide highlighted results in your
model that allow you to quickly see coverage results for model objects. For more
information, see “Overview of Model Coverage Highlighting” on page 5-12.

Settings

In the coverage Results Explorer, you can access the data and reporting settings for your
coverage data. To access these settings, click Settings.
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i

Coverage Results: sf_car

F] E sf_car
& Settings
F Ii;,. Current Cumulative Data
() Run1
i+ |5 Data Repository

Settings

Cumulative Mode

Enable collecting cumulative data

|:| Show cumulative progress report

Html Options
Show report
|:| Generate Web View Report

Include each test in the model summary

Produce bar graphs in the model summary

Use two color bar graphs (red,blue)

|:| Display hit/count ratio in the model summary

|:| Exclude fully covered model objects from report

Exclude fully covered model object details from report

Include cyclomatic complexity numbers in summary

Include cyclomatic complexity numbers in block details

|:| Filter Stateflow events from report

|:| Filter Execution metric from report

Revert

&p: ¥
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Option

Description

Enable collecting cumulative data

Accumulates coverage results from
successive simulations, by default. You
specify the name and output folder of

the . cvt file in the Configuration
Parameters dialog box, on the “Results
Pane” on page 3-7. For more information,
see .“Cumulative Coverage Data” on page
3-21

Show cumulative progress report

Shows the Current Run coverage results,
the Delta of coverage compared to the
previous cumulative data, and the total
Cumulative data from all current
cumulative data separately in the coverage
reports. If you do not select this option,
only the total Cumulative data from all
current cumulative data are shown.

Show report

Opens a generated HTML coverage report
in a MATLAB browser window at the end of
model simulation. For more information,
see “Top-Level Model Coverage Report” on
page 6-12.

Note If you enable the Simulink Toolstrip
tech preview and you use the toolbar
buttons to simulate a model with coverage
enabled, the HTML report does not appear
after a simulation. You access the HTML
report from theSimulink Coverage
contextual tabs, which appear when you
open the Coverage Analyzer app, under
Verification, Validation, and Test.

Generate Web View Report

Opens a generated Model Coverage Web
View in a MATLAB browser window at the
end of model simulation. For more
information, see “Export Model Coverage
Web View” on page 6-48.




Access, Manage, and Accumulate Coverage Results

Option

Description

Include each test in the model
summary

At the top of the HTML report, the model
hierarchy table includes columns listing the
coverage metrics for each test. If you do
not select this option, the model summary
reports only the total coverage.

Produce bar graphs in the model
summary

Causes the model summary to include a bar
graph for each coverage result for a visual
representation of the coverage.

Use two color bar graphs (red, blue)

Red and blue bar graphs are displayed in
the report instead of black and white bar
graphs.

Display hit/count ratio in the model
summary

Reports coverage numbers as both a
percentage and a ratio, for example, 67%
(8/12).

Exclude fully covered model objects
from report

The coverage report includes only model
objects that the simulation does not cover
fully, useful when developing tests, because
it reduces the size of the generated reports.

Exclude fully covered model object
details from report

If you choose to include fully covered model
objects in the report, the report does not
include the details of the fully covered
model objects

Include cyclomatic complexity numbers
in summary

Includes the cyclomatic complexity (see
“Types of Model Coverage” on page 1-3) of
the model and its top-level subsystems and
charts in the report summary. A cyclomatic
complexity number shown in boldface
indicates that the analysis considered the
subsystem itself to be an object when
computing its complexity. Boldface text can
occur for atomic and conditionally executed
subsystems and Stateflow Chart blocks.

Include cyclomatic complexity numbers
in block details

Includes the cyclomatic complexity metric
in the block details section of the report.
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Option Description

Filter Stateflow events from report Excludes coverage data on Stateflow
events.

Filter Execution metric from report Excludes coverage data on Execution
metrics

Creating and Managing Filters

You can create, load, or edit filters for the current coverage data from within the Results
Explorer.

1 Open the Results Explorer.
2 Click the Current Cumulative Data.
3  Click the Filter tab.
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I B

Coverage Results: sf_car EI@

Coverage Data
4 E sf_car

& Settings Report | Filter -
4 [& Current Cumulative Data* m
|54 Run 2, Delta*
I:l Run 3, Cumulative*
4 [ Data Repository
|:| Run 1

L_d Run 2, Delta*
L_d Run 3, Cumulative®

Name I Type I Mode i Rationale

m

Filename: slcov_output\sf_caractive_filt
Load filker

Generate report
Highlight model with coverage results L.

4

Rewvert | [ Help ] | Apply |

For more information on filtering model objects, see “Creating and Using Coverage
Filters”.
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Managing Coverage Data from the Results Explorer

After you record coverage, you can manage the coverage data from the Results Explorer.
To view coverage data details, under Current Cumulative Data, click the coverage data
of interest. You can edit the description and tags for each run. Before you leave the
coverage data details view, click Apply to apply your changes. Otherwise, the changes are
reverted.

When you apply changes to coverage data, such as adding descriptions and tags, the data
shows an asterisk next to its icon. To save these changes, right-click the data and click
Save modified coverage data.

Accumulating Coverage Data from the Results Explorer

If you record multiple coverage runs, each run is listed separately in the Data Repository.
You can drag and drop runs from the Data Repository to the Current Cumulative Data to
manage which runs to include in the cumulative coverage data. Alternatively, right-click
runs in the Data Repository or the Current Cumulative Data to include or exclude them in
the cumulative coverage data.
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Coverage Results: sf_car EI
Coverage Data
4 E sf car
@& Settings Report Filter =

4 ([ Current Cumulative Data* Model version 1.120
[} Run 2, Delta* Author The MathWorks, Inc.
%] Run 3, Cumulative* Started . IBTun-2016 16:32:34

4 £ Data Repository tarted execution un- 12
@ Run 1* File name: active
|sg Run 2, Delta* Description

|sg Run 3, Cumulative®
Serond coverage run, Third coverage run

Tag: Run 2, Delta,Run 3, Cumulative

Summary

Model Hierarchy f Complexity

m

Decision Condition MCDC 1gp Execution

m

L sf car 32 To% F5% 50% 27% 1009
Z....Engine NA NA NA  11% 1009
3....vehicle MNA NA& NA MA 100%
4, . .. shift_logic 26 FEYe 75% 50% 17% 1009

Generate report
Highlight model with coverage results

Save cumulative coverage data —

1

Rewvert Help Apply

To save the current cumulative data set to a . cvt file, click Save cumulative coverage

data. Alternatively, you can right-click the Current Cumulative Data and select Save
cumulative coverage data.
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Load Existing Coverage Data

The Data Repository contains the coverage data, which is saved to the Input folder. You
specify the Input folder on the Configuration Parameters dialog box > Coverage >
“Results Pane” on page 3-7, in the Output directory field.

. .l
=] Coverage Results: sf_car ol = =]
Current coverage data folder
4 E sf_car
. Simulink model: sf_car
@ Settings B
4 |2h Current Cumulative Data Input folder: sloov_outpui\sf car
|5 Run1

Checksu
» [ Data Repository ek

ul: 619757950 uZ: 3804025024 u3: 3095521650 w4: 767468304

Revert App ¥

To synchronize the data in the input folder and the data in the Data Repository, click
e

Synchronize with the current coverage data folder = |,

To load existing coverage data to the Data Repository:

1 Right-click the Data Repository.
2 Select Load coverage data.
3 Select existing coverage data for the current model and click Open.
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Cumulative Coverage Data

On the Coverage > Results pane in the Configuration Parameters dialog box, if you
select Enable cumulative data collection and Save cumulative results in workspace
variable, a coverage running total is updated with new results at the end of each
simulation. However, if you change model or block settings between simulations that are
incompatible with settings from previous simulations and affect the type or number of
coverage points, the cumulative coverage data resets.

When you restore a running total from saved data, the saved results are reflected in the
next cumulative report. If a running total exists when you restore a saved value, the
existing value is overwritten.

Whenever you report on more than one single simulation, the coverage displayed for truth
tables and lookup-table maps is based on the total coverage of all the reported runs. For
cumulative reports, this information includes all the simulations where cumulative results
are stored. For more information about managing cumulative results, see “Access,
Manage, and Accumulate Coverage Results” on page 3-10.

You can make cumulative coverage results persist between MATLAB sessions. The
cvload parameter RESTORETOTAL must be 1 to restore cumulative results. At the end of
the sessions, use cvsave to save results to a file. At the beginning of the next session, use
cvload to load the results.

When you save the coverage results to a file using cvsave and a model name argument,
the file also contains the cumulative running total. When you load that file into the
coverage tool using cvload, you can select whether you want to restore the running total
from the file.

You can also calculate cumulative coverage results at the command line, through the +
operator:

covdatal = cvsim(testl);

covdata2 = cvsim(test2);
cvhtml('cumulative report', covdatal + covdata2);
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Types of Code Coverage

4-2

If you have Embedded Coder, Simulink Coverage can perform several types of code
coverage analysis for models in software-in-the-loop (SIL) mode, processor-in-the-loop
(PIL) mode, and for the code within supported S-Function blocks.

In this section...

“Statement Coverage for Code Coverage” on page 4-2

“Condition Coverage for Code Coverage” on page 4-3

“Decision Coverage for Code Coverage” on page 4-3

“Modified Condition/Decision Coverage (MCDC) for Code Coverage” on page 4-4
“Cyclomatic Complexity for Code Coverage” on page 4-5

“Relational Boundary for Code Coverage” on page 4-5

“Function Coverage” on page 4-5

“Function Call Coverage” on page 4-6

Statement Coverage for Code Coverage

Statement coverage determines the number of source code statements that execute when
the code runs. Use this type of coverage to determine whether every statement in the
program has been invoked at least once.

Statement coverage = (Number of executed statements / Total number of statements)
*100

Statement Coverage Example

This code snippet contains five statements. To achieve 100% statement coverage, you
need at least three test cases. Specifically, tests with positive x values, negative x values,
and x values of zero.

if (x > 0)

printf( "x is positive" );
else if (x < 0)

printf( "x is negative" );
else

printf( "x is 0" );
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Condition Coverage for Code Coverage

Condition coverage analyzes statements that include conditions in source code.
Conditions are C/C++ Boolean expressions that contain relation operators (<, >, <=, or
>=), equation operators (!= or ==), or logical negation operators (!), but that do not
contain logical operators (&& or | |). This type of coverage determines whether every
condition has been evaluated to all possible outcomes at least once.

Condition coverage = (Number of executed condition outcomes / Total number of
condition outcomes) *100

Condition Coverage Example
In this expression:
y = x<=5 && x!=7;

there are these conditions:

Decision Coverage for Code Coverage

Decision coverage analyzes statements that represent decisions in source code. Decisions
are Boolean expressions composed of conditions and one or more of the logical C/C++
operators && or | |. Conditions within branching constructs (if/else, while, do-while) are
decisions. Decision coverage determines the percentage of the total number of decision
outcomes the code exercises during execution. Use this type of coverage to determine
whether all decisions, including branches, in your code are tested.

Note The decision coverage definition for DO-178C compliance differs from the Simulink
Coverage definition. For decision coverage compliance with DO-178C, select the
Condition Decision structural coverage level for Boolean expressions not containing
&& or || operators.

Decision coverage = (Number of executed decision outcomes / Total number of decision
outcomes) *100
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Decision Coverage Example

This code snippet contains three decisions:

y = x<=5 && x!=7; // decision #1

if(x>0) // decision #2
printf( "decision #2 is true" );

else if( x < 0 & vy ) // decision #3
printf( "decision #3 is true" );

else

printf( "decisions #2 and #3 are false" );

Modified Condition/Decision Coverage (MCDC) for Code
Coverage

Modified condition/decision coverage (MCDC) is the extent to which the conditions within
decisions are independently exercised during code execution.

» All conditions within decisions have been evaluated to all possible outcomes at least
once.

+ Every condition within a decision independently affects the outcome of the decision.

MCDC coverage = (Number of conditions evaluated to all possible outcomes affecting the
outcome of the decision / Total number of conditions within the decisions) *100

Modified Condition/Decision Coverage Example

For this decision:
X 1] (Y& Z)

the following set of test cases delivers 100% MCDC coverage.

X Y y4
Test case #1 0 0 1
Test case #2 0 1 0
Test case #3 0 1 1
Test case #4 1 0 1
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Cyclomatic Complexity for Code Coverage

Cyclomatic complexity is a measure of the structural complexity of code that uses the
McCabe complexity measure. To compute the cyclomatic complexity of code, code
coverage uses this formula:

N
c=>(n—-1)
T

N is the number of decisions in the code. o, is the number of outcomes for the n* decision
point. Code coverage adds 1 to the complexity number for each C/C++ function.

Coverage Example

For this code snippet:

void evalNum( int x ){

if (x > 0)

printf( "x is positive" );
else if (x < 0)

printf( "x is negative" );
else

printf( "x is 0" );
}

the cyclomatic complexity is 3.

Relational Boundary for Code Coverage

Relational boundary code coverage examines code that has relational operations.
Relational boundary code coverage metrics align with those for model coverage, as
described in “Relational Boundary Coverage” on page 1-9. Fixed-point values in your
model are integers during code coverage.

Function Coverage
Function coverage determines whether all the functions of your code have been called

during simulation. For instance, if there are ten unique functions in your code, function
coverage checks if all ten functions have been executed at least once during simulation.
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Function Call Coverage

Function call coverage determines whether all function call-sites in your code have been
executed during simulation. For instance, if functions are called twenty times in your
code, function call coverage checks if all twenty function calls have been executed during

simulation.
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Code Coverage for Models in Software-in-the-Loop (SIL)
Mode and Processor-in-the-Loop (PIL) Mode

If you have Embedded Coder and Simulink Coverage, you can analyze coverage for
generated code during a software-in-the-loop (SIL) or processor-in-the-loop (PIL)
simulation.

In this section...

“Enable SIL or PIL Code Coverage for a Model” on page 4-7

“Simulink Coverage Code Coverage Measurement Workflows” on page 4-8
“Review the Coverage Results for Models in SIL or PIL. Mode” on page 4-9
“Limitations” on page 4-10

Enable SIL or PIL Code Coverage for a Model

To record SIL or PIL code coverage for a model:

1 In the Configuration Parameters dialog box, on the left pane, click Code Generation.
From the list, select Verification.

Under Code profiling, clear Measure function execution times.

Under Code coverage for SIL or PIL, for the Third-party tool select None (use
Simulink Coverage).
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) Configuration Pararmeters: slvnvdemo_counter_harness/ModelReferencing (Active) — O >
Solver Code profiling

Data Import/Export

» Optimization [ ] Measure task execution time

» Diagnostics [ ] Measure function execution times

Hardware Implementation
Maodel Referencing
Simulation Target

Workspace variable: executionProfile Save options: | Summary data only | «

Code coverage for SIL or PIL
¥ Code Generation

Report Third-party tool: |None (use Simulink Coverage) - M
Comments
Symbols
Custom Code [ | Enable source-level debugging for SIL
Interface

Code Style
Verification
Templates

Code Placement

Enable portable word sizes

Data Type Replacement
Memary Sections

» Coverage

» Design Verifier

OK Cancel Help Apply

Simulink Coverage Code Coverage Measurement Workflows

To measure code coverage, use either of these workflows:

* The top model is in SIL mode or PIL mode. Simulink Coverage measures code
coverage for the top model, depending RecordCoverage. Simulink Coverage also
measures code coverage for referenced models, depending on CovModelRefEnable.

* The top model is in Normal mode and contains at least one reference model in SIL or
PIL mode. Simulink Coverage measures code coverage for the referenced model if
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CovModelRefEnableis 'on', 'all', or 'filtered' and RecordCoverage is
'off'.

Review the Coverage Results for Models in SIL or PIL Mode

In the code coverage report, each hyperlink opens a report with more details on the
coverage analysis for the model. The code coverage results in these reports are similar to
the coverage results for C/C++ code in S-function blocks, as described in “View Coverage
Results for Custom C/C++ Code in S-Function Blocks” on page 5-50. You can navigate
from code coverage results to the associated model blocks by using the links within the
detailed code coverage reports.

Link to model element

/

Logic block " And"
Metric Coverage
Condition (C1) 100% (4/4) condition outcomes COde cove Fage summa ry
MCDC (C1) 100% (2/2) conditions reversed the outcome

Link to code

Covered expressions: (*rtu upper >= rtb input) & rtb inputGElower (line 39)

Each detailed code coverage report also contains syntax highlighted code with coverage
information.
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Link to model element

/"% Switch: '<Root>/Switch' incorporates:
Logic: 'sRoot>/And’
RelationalOperator: 'sRoot>/upper GE input'
Switch: '<Root>/s limit’

(74

|_|nk tO COde Coverage —] Q if ((*rtu_upper >= rtb_input) && rtb_inputGElower) {

*rty_output = rtb_input;

result details 41} else if (rtb_inputGElower) {
x|imit*® *
2 s per;
Decisions analyzed: i i
rtb_inputGElower 50% wer ; TOOltlp with code
false 55| T coverage results
true 05 t>/Switch' */
: '<Root>/Previous Output' */
Iocalow->Previousoutput_DSTATE = *rty_output;
_'.. }

Limitations

Coverage for models in SIL and PIL mode has these limitations:

* The model must meet the requirements listed in “Enable SIL or PIL Code Coverage for
a Model” on page 4-7.

* Code coverage results must not include external C/C++ files in read-only folders.

See Also

Related Examples

. “Software-in-the-Loop Code Coverage”
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Verify Generated Code for a Component

This example shows how to verify generated code for a model component. You use
component verification functions to create test cases and measure coverage for a

referenced model. In addition, you execute the referenced model in both simulation mode

and software-in-the-loop (SIL) or processor-in-the-loop (PIL) mode using the Code

Generation Verification (CGV) API and then compare the results.

The component you verify is a Model block named control, which is part of the

power window_control system subsystem in the slvnvdemo powerwindow model.

The Model block references the slvnvdemo powerwindow controller model.

Simulink Verification and Validation
Power Window Controller

~
1 } | endstop —_
endstop movelp .—I'-
27 .‘rubstacI&D movelp maov ellp
obstacle
.3} P driver t@ _
driv er owvelown .TIP
4} | passenger movelown maovelDown
passenger I\'

control

The referenced model implements controller logic with a Stateflow® chart.
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safe N
- LI O =L L= RN emergency Down
(driverNeutral passengerneutral ! - emr}-;g CF
b P8 ﬁ:g?;up_ . : moveUp = 0;
moveDown = [passenger] . moveDown = 1;
1 [endstop]
passengerDown \ m //
) _ 1 passengerlp =
it moveDowZ0; [passenger 1IN entry: movep = 1; ["IF 255engerue e
) ! exit: movelp = (; —after(5 tick)
[passenger{1] [passenger(1]]
')
autoPassengerDown
\_ A
[driver(3]] 2 T T 1 [drver[2]]
| [endstop] | [ (rendstop: [
(driverDown __y / ' driverUp ] )
exit: moveDown = 0, exit movelp = 0; ' e )
after(s fick) fiver[1] [driv er{ 1] ' ' £ T
[driver[1]] < 2 — i
i ({2—-,? [driver[2]] A [T
|D"" erDoun l“ [arvera] 1L l L
i s—— —/
\_ v,
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Prepare the Component for Verification

Begin by creating a harness model containing input signals that simulate the controller in
the plant model:

1. Open the slvnvdemo powerwindow example model, and load the referenced model.
addpath(fullfile(matlabroot, 'toolbox', 'slcoverage', 'slcovdemos'));
open_system(fullfile(matlabroot, 'toolbox"', 'slcoverage', 'slcovdemos’, ...

'slvnvdemo_powerwindow.slx'))
load system('slvnvdemo powerwindow controller');

2. Simulate the Model block and log the input signals to the Model block:

modelController = 'slvnvdemo powerwindow/power window control system/control';
evalc('loggedSignalsPlant = slvnvlogsignals(modelController)');

slvnvlogsignals stores the logged signals in the loggedSignalsPlant variable.

3. Generate a harness model for adding test cases.



Verify Generated Code for a Component

harnessModelFilePath = slvnvmakeharness('slvnvdemo powerwindow controller');

slvnvmakeharness creates a harness model named
slvnvdemo_powerwindow_controller_harness. The harness model includes:

» Test Unit - A Model block that references the
slvnvdemo powerwindow controller model.

* Inputs - A Signal Builder block that contains one test case. That test case specifies the
values of the input signals logged when the model slvnvdemo powerwindow was
simulated.

* Test Case Explanation - A DocBlock block that describes the test case.

» Size-Type - A Subsystem block that transmits signals from the Inputs block to the Test
Unit block. The output signals from this block match the input signals for the Model
block you are verifying.

* moveUp and moveDown - Two output ports that match the output ports from the
Model block.

4. Get the name of the harness model:
[~,harnessModel] = fileparts(harnessModelFilePath);
5. Leave all models open for the next steps.
Next, create a test case that tests values for input signals to the component.
Create and Log Test Cases
Add a test case for your component to help you get closer to 100% coverage.

Add a test case to the Signal Builder block in the harness model using the
signalbuilder function. The test case specifies input signals to the component.

1. Load the file containing the test case data into the MATLAB workspace:
load('slvnvdemo powerwindow controller newtestcase.mat');

The workspace variables newTestData and newTestTime contain the test case data.

2. Add the test case to the Signal Builder block in the harness model.

signalBuilderBlock = slvnvdemo signalbuilder block(harnessModel);
signalbuilder(signalBuilderBlock, 'Append’, ...
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newTestTime, newTestData,...
{'endstop', 'obstacle', 'driver(1l)"', 'driver(2)"', 'driver(3)"',...
'passenger(l) ', 'passenger(2)', 'passenger(3)'}, 'New Test Case');

3. Simulate the harness model with both test cases, then log the signals to the referenced
model and save the results:

loggedSignalsHarness = slvnvlogsignals(harnessModel);
Next, record coverage for the slvnv_powerwindow controller model.
Merge Test Case Data
You have two sets of test case data:

* loggedSignalsPlant - Logged signals to the Model block control

* loggedSignalsHarness - Logged signals to the test cases you added to the empty
harness

To simulate all the test data simultaneously, merge the two data files into a single file:
1. Combine the test case data:

mergedTestCases = slvnvmergedata(loggedSignalsPlant, loggedSignalsHarness);
2. View the merged data:

disp(mergedTestCases);

Next, simulate the referenced model with the merged data and get coverage for the
referenced model, slvnv_powerwindow controller.

Record Coverage for Component
Record coverage for the slvnv_powerwindow controller model.

1. Create a default options object, required by the slvnvruntest function:
runopts = slvnvruntestopts;

2. Specify to simulate the model and record coverage:
runopts.coverageEnabled = true;

3. Simulate the model using the logged input signals:
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[~, covdata] = slvnvruntest('slvnvdemo powerwindow controller',...
mergedTestCases, runopts);

4. Display the HTML coverage report:
cvhtml('Coverage with Test Cases from Harness', covdata);
The slvnv_powerwindow controller model achieved:

* Decision coverage: 44%
* Condition coverage: 45%
* MCDC coverage: 10%

For more information about decision coverage, condition coverage, and MCDC coverage,
see Types of Model Coverage.

Execute Component in Simulation Mode

To verify that the generated code produces the same results as simulating the model, use
the Code Generation Verification (CGV) API methods. When you perform this procedure,
the simulation compiles and executes the model code using the merged test cases:

1. Create a default options object for slvnvruncgvtest:
runcgvopts = slvnvruntestopts('cgv');

2. Specify to execute the model in simulation mode:
runcgvopts.cgvConn = 'sim';

3. Execute the slvnv_powerwindow controller model using the two test cases and
the runopts object:

slmodel = 'slvnvdemo powerwindow controller';
evalc('cgvSim=slvnvruncgvtest(slmodel, mergedTestCases, runcgvopts)');

These steps save the results in the workspace variable cgvSim.

Next, execute the same model with the same test cases in software-in-the-loop (SIL) mode
and compare the results from both simulations.

For more information about Normal simulation mode, see Execute the Model.
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Execute Component in SIL Mode

When you execute a model in software-in-the-loop (SIL) mode, the simulation compiles
and executes the generated code on your host computer.

To execute a model in SIL mode, you must have an Embedded Coder™ license.

In this section, you execute the slvnvdemo powerwindow controller model in SIL
mode and compare the results to the previous section, where you executed the model in
simulation mode:

1. Specify to execute the model in SIL mode:
runcgvopts.cgvConn = 'sil';

2. Execute the slvnv_powerwindow controller model using the merged test cases
and the runopts object:

evalc('cgvSil = slvnvruncgvtest(slmodel, mergedTestCases, runcgvopts)');
The workspace variable cgvSil contains the results of the SIL. mode execution.

3. Display a comparison of the results in cgvSil to the results in cgvSim (the results
from the simulation mode execution). Use the cgv.CGV. compare method to compare the
results from the two simulations:

for i=1:1length(loggedSignalsHarness.TestCases)
simout = cgvSim.getOutputData(i);
silout = cgvSil.getOutputData(i);
[matchNames, ~, mismatchNames, ~ ] = ...
cgv.CGV.compare(simout, silout);
fprintf('\nTest Case(%d): %d Signals match, %d Signals mismatch',
i, length(matchNames), length(mismatchNames));
end

For more information about software-in-the-loop (SIL) simulations, see What Are SIL and
PIL Simulations?


http://www.mathworks.com/help/ecoder/ref/cgv.cgv.compare.html
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http://www.mathworks.com/help/ecoder/ug/about-sil-and-pil-simulations.html#brr9tb5-2
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Specify Code Coverage Options

Simulink Coverage provides three modes of code coverage analysis. For general coverage
options, see “Specify Coverage Options” on page 3-2.

In this section...

“Models with S-Function Blocks” on page 4-17

“Models with Software-in-the-Loop and Processor-in-the-Loop Mode Blocks” on page 4-
17

“Models with MATLAB Function Blocks” on page 4-18

Models with S-Function Blocks

Configure an S-Function block for coverage based on how you created it. For more
information, see “Coverage for Custom C/C++ Code in Simulink Models” on page 5-47.

Note If you have software-in-the-loop or processor-in-the-loop blocks in your model, set
the options described in “Models with Software-in-the-Loop and Processor-in-the-Loop
Mode Blocks” on page 4-17.

Models with Software-in-the-Loop and Processor-in-the-Loop
Mode Blocks

1 In the Simulink Editor, select Simulation > Model Configuration Parameters.

2 Before setting code coverage options, on the Code Generation pane in the
Configuration Parameters dialog box, set the System target file in the Target
selection menu to ert.tlc.

3 Inthe Configuration Parameters dialog box, on the left pane, click Code Generation.
From the list, select Verification.

4 Select the code coverage tool from the Code coverage for SIL or PIL tab.

You can measure code coverage using these tools:

« Simulink Coverage code coverage tool
* BullseyeCoverage
* LDRA TestBed
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BullseyeCoverage and LDRA TestBed are third-party tools supported by Embedded Coder.
For more information on third-party code coverage tool support, see “Code Coverage Tool
Support” (Embedded Coder). To set code coverage options, click Configure. If you select
None (use Simulink Coverage) as the code coverage tool, the software opens the
Coverage pane when you click Configure.

Using Simulink Coverage for code coverage means that you can analyze coverage results,
justify missing coverage, and generate more test cases from within the Simulink
environment.

Models with MATLAB Function Blocks

When you record coverage for models containing MATLAB Function blocks, code
coverage is recorded for the code within the MATLAB Function blocks. To include
MATLAB Function blocks in your analysis:

1 In the Simulink Editor, select Analysis > Coverage > Settings.
2 In the Configuration Parameters dialog box, on the Coverage pane, under Include in
analysis, select MATLAB files.

See Also

More About

. “Create and Run Test Cases” on page 5-3

. “Types of Coverage Reports” on page 6-2

. “View Coverage Results for Custom C/C++ Code in S-Function Blocks” on page 5-
50

. “Coverage Filtering” on page 7-2
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Coverage for Models with Code Blocks and Simulink
Blocks

In this section...

“Set Up the Model to Record Coverage” on page 4-19
“Record Coverage” on page 4-20
“Review Results by Generating a Coverage Report” on page 4-20

“Justify Missing Coverage” on page 4-21

In this example, you record coverage for a model which contains a combination of code
blocks and other Simulink blocks.

Set Up the Model to Record Coverage
1 Open the model.

open_system('ex cc cruise control doublepress sfun');

- £ \
Re_Eng_wilh. Jonast 44 boolean } { CruiseOnOft
CruiseOnOff
engaged
Brake >| boolea | P Brake faganed =
& Brake D-‘
Speed »| uint8 | P Speed
" | E— Speed tD
CoaslSetSw ,‘] boalean l » CoastSetSwin CoastS@ B CoastSetSw :
L J Coastselsw £ tspead
RejectDoublePress_sfun st
— 5 tspeed
AccalRes » boole: - Pl iR
> alean | PR AccelResSwin AccelResSwOut g 55 e -
Signal Builder RejectDoublePress ComputeTargetSpeed

The model is a cruise control system that consists of test cases and input signals from
a Signal Builder block. The signals from the Signal Builder act as inputs to the
Stateflow chart ComputeTargetSpeed, which engages or disengages the cruise
control system and sets the target speed, tspeed.

2 In the Simulink Editor, select Simulation > Model Configuration Parameters.
Before setting code coverage options, on the Code Generation pane in the
Configuration Parameters dialog box, set the System target file in the Target
selection menu to ert. t1lc. Navigate to the Verification tab of the Code
Generation pane. From the Code coverage for SIL or PIL tab, select None (use
Simulink Coverage) as the code coverage tool.

4-19



4 code Coverage

4-20

3 Inthe Coverage pane, set the options for coverage calculated during simulation.

1 Select Enable coverage analysis.
2 In the Include in analysis section, ensure that C/C++ S-Functions is selected.

3 In the Coverage metrics section, select Modified Condition Decision
(MCDC) as the Structural coverage level. Apply the changes by clicking Apply.
4 Open the RejectDoublePress S-Function Builder block. In the Build options of
the Build Info tab, select Enable support for coverage. To build the S-Function,
click Build .

Note To build the S-Function, you must have a compiler installed. For more
information on supported compilers for various platforms, see Supported and
Compatible Compilers.

Record Coverage
1 Open the Signal Builder block.

open_system('ex cc cruise control doublepress sfun/Signal Builder');
2 The Signal Builder consists of eight signal groups with five signals each. In this

example, we simulate all the signal groups and record coverage. Click ! Run all
and produce coverage to start recording coverage. At the end of the simulation, the
Coverage Results Explorer opens, showing the results for the latest coverage
analysis. The blocks in the model are highlighted in different colors corresponding to
the level of coverage achieved by each block.

Review Results by Generating a Coverage Report

The Coverage Results Explorer offers several options for displaying and reporting
coverage results. Select the Not Engaged with Enable group in the Current
Cumulative Data tab of the left pane. Click the Generate report link at the bottom of
the Coverage Results Explorer to generate an HTML coverage report in the built-in
MATLAB web browser. The coverage report lists model coverage for Simulink model
blocks and code coverage for code blocks.

Scroll down to view the coverage metrics for the S-Function block in the coverage report.
Click the Detailed Report link to open the code coverage report for the S-Function
block. For more details on the code coverage report for S-Function blocks, see“View
Coverage Results for Custom C/C++ Code in S-Function Blocks” on page 5-50.


https://www.mathworks.com/support/sysreq/previous_releases.html
https://www.mathworks.com/support/sysreq/previous_releases.html

See Also

Justify Missing Coverage

In this example, we justify coverage for one input signal group by creating a coverage
filter. In the code coverage report for the S-Function block created in “Review Results by
Generating a Coverage Report” on page 4-20, scroll down to Decision/Condition 2.1 !
(CoastSetSwIn[0] && AccelResSwIn[0]). This condition is never False for the
current test case. We can therefore justify this condition in our coverage analysis.

1 Click the Justify or Exclude link under the detailed results for this condition. The
Filter tab of the Coverage Results Explorer opens, and the rule filtering this
transition is added. Change the Mode for this rule to Justified and enter a
description for the Rationale, such as “expression cannot be false”. Click Apply to
apply the changes.

2 After you click Apply, the Generate report link becomes available. Click the link to
generate the report with the updated coverage filter. The new code coverage report
for the RejectDoublePress S-Function block lists the excluded condition under
Objects Filtered from Coverage Analysis. The detailed results for the condition !
(CoastSetSwIn[0] && AccelResSwIn[0]) show that missing coverage for this
condition has been justified. The justified objects are treated as satisfied when
reporting coverage percentages and appear light blue in the “Coverage Summary” on
page 6-12.

Summary

Decision Condition MCDC Statement Decision Condition MCDC Statement Decision Condition MCDC Staement

167%  m— 67%  m— 17% m 100%  om— 33% 33% 33% 0% 100%  s— 83% m—— 7% - 100%  —

apper 1 67%  m— 67%  m— 17% m 100% s 33% 33% 33% 0% 100% s 83% m—— 7% - 100%  ee—

For more information on coverage filters, see “Coverage Filtering” on page 7-2.

See Also

“Types of Coverage Reports” on page 6-2 | “Creating and Using Coverage Filters” |
“Coverage for Custom C/C++ Code in Simulink Models” on page 5-47
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* “Model Coverage Collection Workflow” on page 5-2
* “Create and Run Test Cases” on page 5-3

* “Modified Condition and Decision Coverage (MCDC) Definitions in Simulink Coverage”
on page 5-4

* “Modified Condition and Decision Coverage in Simulink Design Verifier” on page 5-8
* “View Coverage Results in a Model” on page 5-12
* “Model Coverage for Multiple Instances of a Referenced Model” on page 5-17

* “Obtain Cumulative Coverage for Reusable Subsystems and Stateflow® Constructs”
on page 5-27

* “Model Coverage for MATLAB Functions” on page 5-30

* “Coverage for Custom C/C++ Code in Simulink Models” on page 5-47

* “View Coverage Results for Custom C/C++ Code in S-Function Blocks” on page 5-50
* “Model Coverage for Stateflow Charts” on page 5-55
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Model Coverage Collection Workflow

5-2

To develop effective tests with model coverage:

1

Develop one or more test cases for your model. (See “Create and Run Test Cases” on
page 5-3.)

Run the test cases to verify model behavior.
Analyze the coverage reports produced by the Simulink Coverage software.

Using the information in the coverage reports, modify the test cases to increase their
coverage or add new test cases to cover areas not currently covered.

Repeat the preceding steps until you are satisfied with the coverage of your test
suite.

Note The Simulink Coverage software comes with an example of model coverage to
validate model tests. To step through the example, at the MATLAB command prompt,
enter simcovdemo.




Create and Run Test Cases

Create and Run Test Cases

To create and run test cases, model coverage provides the MATLAB commands cvtest
and cvsim. The cvtest command creates test cases that the cvsim command runs. (See
“Run Tests with cvsim” on page 8-4.)

You can also run the coverage tool interactively:

Open the sldemo fuelsys model.
2 In the Simulink model window, select Analysis > Coverage > Settings.

In the Configuration Parameters dialog box, on the “Coverage Pane” on page 3-2,
select Enable coverage analysis, which enables the coverage settings.

3 Under Coverage metrics, select the types of coverage that you want to record in the
coverage report. Click OK.

4 In the Simulink Editor, select Simulation > Run to start simulating the model.

On the “Results Pane” on page 3-7 of the Configuration Parameters dialog box, if you
specify to report model coverage, Simulink Coverage saves coverage data for the
current run in the workspace object covdata and cumulative coverage data in
covCumulativeData, by default. Simulink Coverage also saves these results to

a .cvt file by default. At the end of the simulation, the data appears in an HTML
report that opens in a browser window. For more information on coverage data
settings, see “Specify Coverage Options” on page 3-2.

You cannot run simulations if you select both the model coverage reporting and
acceleration options. In the Simulink Editor, if you select Simulation > Mode >
Accelerator , Simulink Coverage does not record coverage.

When you perform coverage analysis, you cannot select both block reduction and
conditional branch input optimization, because they interfere with coverage
recording.
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Modified Condition and Decision Coverage (MCDC)
Definitions in Simulink Coverage

Simulink Coverage by default uses the masking modified condition and decision coverage
(MCDC) definition for recording MCDC coverage results. Although you can change the
MCDC definition that Simulink Coverage uses during analysis to the unique-cause MCDC
definition, there are some differences in how Simulink Coverage records coverage for
models depending on which definition you use.

In this section...

“Differences between Masking MCDC and Unique-Cause MCDC in Simulink Coverage
Coverage Analysis” on page 5-4

“Certification Considerations for MCDC Coverage” on page 5-6

“Setting the (MCDC) Definition Used for Simulink Coverage Coverage Analysis” on page
5-6

“Modified Condition and Decision Coverage in Simulink Design Verifier” on page 5-7

Differences between Masking MCDC and Unique-Cause MCDC
in Simulink Coverage Coverage Analysis

Masking MCDC accounts for the masking of conditions in subexpressions, allowing for an
increased number of satisfied MCDC objectives compared to the unique-cause definition
of MCDC. As a result, some Simulink models that receive less than complete MCDC
coverage using the unique-cause MCDC definition receive increased coverage when using
the masking MCDC definition. Consider the following example, where two inputs to a
Stateflow chart, condition A and condition C, cannot change independently:
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Modified Condition and Decision Coverage (MCDC) Definitions in Simulink Coverage

This input dependence results in dependent conditions for the expression contained
within the Stateflow chart:

[(A]lB) && (C || D))

O =)
2
{fout = 0;} {fout = 1;}
O- O

For the expression (A||B)&&(C||D), changing the value of condition C also changes the
value of condition A. Due to the interdependence of conditions A and C, unique-cause
MCDC for condition C cannot be achieved:

MC/DC analysis (combinations in parentheses did not occur)
Decision/Condition True Out  False Out
(A || B) && (C || D)

TxT=x FFxx
FIFT FFxx
TxTx {T=FF)
FTFT FTFF

00 o5

However, masking MCDC for condition C can be achieved, because masking MCDC allows
the value of condition A to change in the independence pair for condition C, as long as the
subexpression (A||B) remains true:
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MC/DC analysis (combinations in parentheses did not occur)

Decision/Condition True Out  False Out
(A By&&(C || D)
A TxTx FF=x
B FTIFT FFxx
C TxTx FTFF
D FIF1 FIFE

Certification Considerations for MCDC Coverage

The Certification Authorities Software Team (CAST), in their CAST 6 position paper, states
that masking MCDC is acceptable for meeting the MC/DC objective of DO-178B
certification.

Setting the (MCDC) Definition Used for Simulink Coverage
Coverage Analysis

By default, Simulink Coverage uses the masking MCDC definition during coverage
analysis. There are two ways to change the MCDC definition used for Simulink Coverage
coverage analysis:

Use the Model Configuration Parameters to Set the MCDC Definition Used

1 Open the Configuration Parameters dialog box.
2  Set the CovMcdcMode parameter to Masking or Unique-Cause.

Use the cvtest Object to Set the MCDC Definition Used

Create a cvtest object for your model to set the mcdcMode to 'Masking' or
'"UniqueCause':

cvt = cvtest(model)
cvt.options.mcdcMode = 'UniqueCause’
covdata = cvsim(cvt)


https://www.faa.gov/aircraft/air_cert/design_approvals/air_software/cast/cast_papers/archive/

See Also

Modified Condition and Decision Coverage in Simulink Design
Verifier

Setting CovMcdcMode to 'UniqueCause’ can result in differences between MCDC
reporting in Simulink Coverage and test generation in Simulink Design Verifier. Simulink
Design Verifier always uses the masking MCDC definition for test case generation. For
more information, see “Modified Condition and Decision Coverage in Simulink Design
Verifier” on page 5-8.

See Also

More About
. “MCDC” (Simulink Design Verifier)
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Modified Condition and Decision Coverage in Simulink
Design Verifier

Depending on the settings you apply for Simulink Coverage coverage recording, there can
be a difference between the definition of modified condition and decision (MCDC)
coverage used for model coverage analysis in Simulink Coverage and that used for test
case generation analysis in Simulink Design Verifier.

MCDC Definitions for Simulink Coverage and Simulink Design
Verifier

Simulink Design Verifier always uses the masking MCDC definition for test case
generation. By default, Simulink Coverage also uses the masking MCDC definition when
recording coverage. However, if you set the CovMcdcMode model configuration
parameter to 'UniqueCause’, Simulink Coverage instead uses the unique-cause MCDC
definition when recording coverage. For information on the differences between the
masking MCDC definition and the unique-cause MCDC definition, see “Modified Condition
and Decision Coverage (MCDC) Definitions in Simulink Coverage” on page 5-4.

Setting the CovMcdcMode model configuration parameter to 'UniqueCause’ can result
in differences between MCDC reporting in Simulink Coverage and test generation in
Simulink Design Verifier. An example of this difference can be seen in analysis results for
logical expressions containing a mixture of AND and OR operators, as in this Stateflow
transition.
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Given that A, B, and C are each separate inputs, there are five possible ways to evaluate
the condition on the Stateflow transition, shown in the following table.

A B C (A&& B) || C
1 F X F F
2 F X T T
3 T F F F
4 T F T T
5 T T X T

Satisfying MCDC for a Boolean variable requires a pair of condition evaluations, showing
that a change in that variable alone changes the evaluation of the entire expression. In
this example, MCDC can be satisfied for C with either the pair 1, 2 or the pair 3, 4. In
both of those cases, the value of the expression changed because the value of C changed,
while all other variable values stayed the same.

Each pair has a different set of values for A and B which are held constant, but each pair
contains one evaluation where C and out are true and one evaluation where C and out
are false. To satisfy MCDC for C, Simulink Design Verifier test generation analysis accepts
any pair containing one evaluation of true values and one evaluation of false values for C
and out. In this example, Simulink Design Verifier test generation analysis accepts not
only pair 1, 2 and pair 3, 4 but also pair 1, 4 and pair 2, 3. Simulink Coverage model
coverage analysis using the unique-cause MCDC definition is satisfied only by pair 1, 2 or
by pair 3, 4.

The preceding example assumes that A, B, and C are all separate inputs. When input A is
constrained to be the same value as C, as in this model, only a subset of condition
evaluations are possible.
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This subset of condition evaluations for the Stateflow transition is shown in the following
table.

A B C (A&& B) || C
F X F F
T F T T

5 T T X T

Evaluations 2 and 3 are no longer possible, so neither pair 1, 2 nor pair 3, 4 is possible.
As a result, unique-cause MCDC for C can no longer be satisfied in Simulink Coverage
model coverage analysis. Since pair 1, 4 is still possible, however, Simulink Design
Verifier test generation analysis reports that MCDC for C is satisfiable.

The complexity of MCDC analysis for logical expressions with a mixture of AND and OR
operators causes this difference between results from Simulink Coverage set to unique-
cause MCDC analysis and Simulink Design Verifier. The defaultCovMcdcMode model
configuration parameter value of 'Masking' does not cause this discrepancy. However, if
you require the use of unique-cause MCDC analysis in Simulink Coverage, you can
minimize this effect by using the IndividualObjectives test suite optimization for test
generation analysis in Simulink Design Verifier For more information, see the Tip section
of “Test suite optimization” (Simulink Design Verifier).




See Also

See Also

More About
. “MCDC” (Simulink Design Verifier)
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View Coverage Results in a Model

5-12

In this section...

“Overview of Model Coverage Highlighting” on page 5-12

“Enable Coverage Highlighting” on page 5-13

“View Coverage Details” on page 5-16

Overview of Model Coverage Highlighting

When you simulate a Simulink model, you can configure your model to provide visual
results that enable you to see which objects failed to record 100% coverage. After the
simulation:

In the model window, model objects are highlighted in certain colors according to
what coverage was recorded:
* Green indicates that an object received full coverage during simulation.

* Green with a dashed border indicates that an object had incomplete coverage that
you justified.

* Red indicates that an object received incomplete coverage.
* Gray with a dashed border indicates that you excluded an object from coverage.
* Objects with no color highlighting did not receive coverage.

When you place your cursor over a colored object, you see a tooltip with details about
the coverage recorded for that block. For subsystems and Stateflow charts, the
coverage tooltip lists the summary coverage for all objects in that subsystem or chart.
For other blocks, the coverage tooltip lists specific details about the objects that did
not receive 100% coverage.

The simulation highlights blocks that received these types of model coverage:

“Execution Coverage (EC)” on page 1-3

“Decision Coverage (DC)” on page 1-3

“Condition Coverage (CC)” on page 1-3

“Modified Condition/Decision Coverage (MCDC)” on page 1-4
“Relational Boundary Coverage” on page 1-9




View Coverage Results in a Model

» “Saturate on Integer Overflow Coverage” on page 1-8

* “Objectives and Constraints Coverage” on page 1-7

Enable Coverage Highlighting

Coverage highlighting is enabled by default. To confirm that coverage highlighting is
enabled, on the Results pane of the Configuration Parameters dialog box, select Display
coverage results using model coloring. After you have enabled the coverage
highlighting, simulate your model. You can see which model objects received full, partial,
Or no coverage.

Alternatively, you can click Highlight model with coverage results in the Results
Explorer to enable model coverage highlighting. You access the Results Explorer by
selecting Analysis > Coverage > Open Results Explorer, and then recording coverage.
For more information, see “Accessing Coverage Data from the Results Explorer” on page
3-10. You can also use cvmodelview to enable model highlighting.

Highlighted Coverage Results

Examples of highlighted model objects in colors that correspond to the recorded coverage
are:

Green: Full Coverage

The Switch block received 100% coverage, as indicated by the green highlighting and the
information in the coverage tooltip.

Green with Dashed Border: Justified Coverage

The Relational Operator block received justified coverage, as indicated by the green
highlighting with a dashed border and the information in the coverage tooltip.
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Justified full condition coverage.
Full Execution coverage.
Rationale: 1

Red: Partial Coverage

The shift logic Stateflow chart received this coverage:

Decision 78%  Condition 75%
(25/37) (6/8)

MCDC 50% Execution 100%
(2/4) (2/2)

Inside the shift logic Stateflow chart, the gear state substate was never fourth.

Executed substate was never
“fourth”.
Decision 63% (11/16)

Two of the data ports in the Multiport Switch block were never executed.
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Control input was never Case
RICH {out = in2) or Case

* DISABLED (out = in3). -
Full Execution coverage.

Gray with Dashed Border: Filtered Coverage

The fuel rate control subsystem is highlighted in gray because it was excluded from
coverage recording.

1| Filtered.
¥ | Rationale: Exclude from
|
|
|
|

coverage

fuel_rate_control
No Coloring: Coverage Not Recorded

The Inport block is not highlighted because it does not receive coverage recording.
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View Coverage Details

After you highlight coverage results on the model, you can view coverage details for each
model element in the Coverage Details window. To open the Coverage Details window,
click the Coverage Details icon in the lower-left corner of the Simulink block diagram,
and then click Open Coverage Details:

=] Open Coverage Details

E

You can then click a model object to view its coverage details.
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Model Coverage for Multiple Instances of a Referenced
Model

In this section...

“About Coverage for Model Blocks” on page 5-17
“Record Coverage for Multiple Instances of a Referenced Model” on page 5-17

About Coverage for Model Blocks

Model blocks do not receive coverage directly; if you set the simulation mode of the
Model block to Normal, SIL, or PIL, the Simulink Coverage software records coverage
for the model referenced from the Model block. If the simulation mode for the Model
block is anything other than Normal, SIL, or PIL, the software does not record coverage
for the referenced model.

Your Simulink model can contain multiple Model blocks with the same simulation mode
that reference the same model. When the software records coverage, each instance of the
referenced model can be exercised with different inputs or parameters, possibly resulting
in additional coverage for the referenced model.

The Simulink Coverage software records coverage for all instances of the referenced
model with the same simulation mode and combines the coverage data for that
referenced model in the final results.

Record Coverage for Multiple Instances of a Referenced Model

To see how this works, simulate a model twice. The first time, you record coverage for one
Model block in Normal simulation mode. The second time, you record coverage for two
Model blocks in Normal simulation mode. Both Model blocks reference the same model.

* “Record Coverage for the First Instance of the Referenced Model” on page 5-17
* “Record Coverage for the Second Instance of the Referenced Model” on page 5-23

Record Coverage for the First Instance of the Referenced Model
Record coverage for one Model block.

1  Open your top-level model. This example uses the following model:
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This model contains three Model blocks that reference the
sldemo mdlref counter datamngt example model. The corners of each Model
block indicate the value of their Simulation mode parameter:

Counterl — Simulation mode: Normal

Counter2 — Simulation mode: Accelerator
Counter3 — Simulation mode: Accelerator

Configure your model to record coverage during simulation:

a
b

In the model window, select Analysis > Coverage > Settings.
On the Coverage pane of the Configuration Parameters dialog box, select:

Enable coverage analysis
Referenced Models

Scope3
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¢ Click Select Models. In the Select Models for Coverage Analysis dialog box, you
can select only those referenced models whose simulation mode is Normal, SIL,
or PIL. In this example, only the first Model block that references
sldemo_mdlref counter_datamngt is available for recording coverage.

4 |} sidemo_mdiref_datamngt_mod
o H sldemo_mdlref_counter_datamngt
sldemo_mdlref_counter_datamngt
sldemo_mdlref_counter_datamngt

d Click OK to exit the Select Models for Coverage Analysis dialog box.

Click OK to save your coverage settings and exit the Configuration Parameters dialog
box.

Simulate your model.
When the simulation is complete, the HTML coverage report opens. In this example,

the coverage data for the referenced model, sldemo_mdlref counter datamngt,
shows that the model achieved 69% coverage.

Click the hyperlink in the report for the referenced model.

The detailed coverage report for the referenced model opens, and the referenced
model appears with highlighting to show coverage results.
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Note the following about the coverage for the Range Check subsystem in this
example:

* The Saturate Count block executed 100 times. This block has four Boolean
decisions. Decision coverage was 50%, because two of the four decisions were
never recorded:

¢ The decision input > lower limit was never false.
* The decision input >= upper limit was never true.
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Saturate block "Saturate Count"

Parent: sldemo mdlref counter datamnet/Range Check
Uncovered Links: =

Metric Coverage
Cyclomatic Complexity 2
Decision 50% (2/4) decision outcomes

Decisions analyzed:

input > lower limit 50%
false 0/50
true 50/50

input >= upper limit 50%
false 50/50
true 0/50

* The DetectOverflow function executed 50 times. This script has five decisions.
The DetectOverflow script achieved 60% coverage because two of the five
decisions were never recorded:

* The expression count >= CounterParams.UpperLimit was never true.
* The expression count > CounterParams.LowerLimit was never false.
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MATLAB Function "DetectOverflow"

Parent: sldemo_mdlref counter datamngt/Range Check/Detect Overflow
Uncovered Links: <

Metric Coverage
Cyclomatic Complexity 3
Decision 60% (3/5) decision outcomes

function result = DetectOverflow (count, CounterParams)
% DETECTOVERFLOW Check count
t#codegen

result = SlDemoRangeCheck.UpperLimit;
elseif (count > CounterParams.LowerLimit)

1
2
3
4
_5 if (count >= CounterParams.UpperLimit)
&
1
g result = SlDemoRangeCheck.InRange;
9

else
10 result = SlDemoRangeCheck.LowerLimit;
11 end
iz

#1: function result = DetectOverflow(count, CounterParams)

Decisions analyzed:

function result = DetectOverflow(count,
100%
CounterParams)
executed 50/50
#5: if (count >= CounterParams.UpperLimit)
Decisions analyzed:
if (count >= CounterParams.UpperLimit) 50%
false 30/50
true 0/50
#7: elseif (count = CounterParams.LowerLimit)
Decisions analyzed:
elseif (count > CounterParams.LowerLimit) 50%
false 0/50
true 30/50
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Record Coverage for the Second Instance of the Referenced Model

Record coverage for two Model blocks. Set the simulation mode of a second Model block

to Normal and simulate the model. In this example, the Counter2 block adds to the
coverage for the model referenced from both Model blocks.

1 In the Simulink Editor for your top-level model, right-click a second Model block and

select Block Parameters (ModelReference).

The Function Block Parameters dialog box opens.
2 Set the Simulation mode parameter to Normal.
3 Click OK to save your change and exit the Function Block Parameters dialog box.

The corners of the Model block change to indicate that the simulation mode for this

block is Normal, as in the example below.

¥

sldemo_mdlref_counter_datamngt

outputs

double

Courter 1

)

sldemo_mdlref_counter_datamngt

outputs

Counter2

:

sldema_mdlref_counter_datamngt

outputs

Counter3d

double

double
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To make sure that the software records coverage for both instances of this model:

a Select Analysis > Coverage > Settings.
On the Coverage pane, select Enable coverage analysis.
¢ Select Referenced Models and click Select Models.
In the Select Models for Coverage Analysis dialog box, verify that both instances

of the referenced model are selected. In this example, the list now looks like the
following.

4 |{} sldemo_mdiref_datamngt_mod
v H sldemo_mdlref_counter_datamngt
v Eﬂ sldemo_mdlref_counter_datamngt
sldemo_mdiref_counter_datamngt

If you have multiple instances of a referenced model in Normal mode, you can
choose to record coverage for all of them or none of them.

d Click OK to close the Select Models for Coverage Analysis dialog box.
Simulate your model again.
When the simulation is complete, open the HTML coverage report.

In this example, the referenced model achieved 85% coverage. Note the following
about the coverage data for the Range Check subsystem:

¢ The Saturate Count block executed 179 times. The simulation of the Counter2
block executed the Saturate Count block an additional 79 times, for a total of 179
executions.

The decision input >= upper limit was true 21 times during this simulation,
compared to 0 during the first simulation. The fourth decision input > lower
1imit was still never false. Three out of four decisions were recorded during
simulation, so this block achieved 75% coverage.
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Saturate block "Saturate Count"

Parent: sldemo mdlref counter datamnet/Range Check
Uncovered Links: =

Metric Coverage
Cyclomatic Complexity 2
Decision 75% (3/4) decision outcomes

Decisions analyzed:

input > lower limit 50%
false 0/79
true 79/79

mput == upper limit 100%
false 79/100
true 21/100

* The DetectOverflow function executed 100 times. The simulation of the
Counter2 block executed the DetectOverflow function an additional 50 times.

The DetectOverflow function has five decisions. The expression count >=
CounterParams.UpperLimit was true 21 times during this simulation,
compared to 0 during the first simulation. The expression count >
CounterParams.LowerLimit was never false. Four out of five decisions were

recorded during simulation, so the DetectOverflow function achieved 80%
coverage.
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MATLAB Function "DetectOverflow"

Parent: sldemo_mdlref counter datamngt/Range Check/Detect Overflow

Uncovered Links: <

Metric Coverage
Cyclomatic Complexity 3
Decision 80% (4/5) decision outcomes

function result = DetectOverflow(count, CounterParams)
& DETECTOVERFLOW Check count
t#codegen

result = SlDemoRangeCheck.UpperLimit;
elseif (count > CounterParams.LowerLimit)

1
2
3
4
5 if (count »= CounterParams.UpperLimit)
]
1
8 result = SlDemoRangeCheck.InRange;
9

else
10 result = SlDemoRangeCheck.LowerLimit;
11 end
1z

#1: function result = DetectOverflow(count, CounterParams)

Decisions analyzed:

function result = DetectOverflow(count,
100%
CounterParams)
executed 100/100
#3: if (count >= CounterParams.UpperLimit)
Decisions analyzed:
if (count »= CounterParams.UpperLimit) 100%
false 79/100
true 21/100
#7: elseif (count > CounterParams.LowerLimit)
Decisions analyzed:
elseif (count > CounterParams.LowerLimit) 50%
false 0/79
true 79/79
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Obtain Cumulative Coverage for Reusable Subsystems
and Stateflow® Constructs

This example shows how to create and view cumulative coverage results for a model with
a reusable subsystem.

Simulink® Coverage™ provides cumulative coverage for multiple instances of identically
configured:

* Reusable subsystems
» Stateflow™ constructs

To obtain cumulative coverage, you add the individual coverage results at the command
line. You can get cumulative coverage results for multiple instances across models and
test harnesses by adding the individual coverage results.

Open example model
At the MATLAB® command line, type:

addpath(fullfile(matlabroot, 'toolbox', 'slcoverage', 'slcovdemos', 'internal'))
model = 'slvnvdemo cv_mutual exclusion';
open_system(model);

r
n
Ot
Subsysten 1 >
merge 4 I:l
0 | MOT |
r
n
Ot
Subsystem 2

Copyright 1990-2006 The MathWarks Inc.

This model has two instances of a reusable subsystem. The instances are named
Subsystem 1 and Subsystem 2.
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Get decision coverage for Subsystem 1

Execute the commands for Subsystem 1 decision coverage:

testobjl = cvtest([model '/Subsystem 1']);
testobjl.settings.decision = 1;
covobjl = cvsim(testobjl);

Get decision coverage for Subsystem 2

Execute the commands for Subsystem 2 decision coverage:
testobj2 = cvtest([model '/Subsystem 2']);
testobj2.settings.decision = 1;

covobj2 = cvsim(testobj2);

Add coverage results for Subsystem 1 and Subsystem 2

Execute the command to create cumulative decision coverage for Subsystem 1 and
Subsystem 2:

covobj3 = covobjl + covobj2;

Generate coverage report for Subsystem 1

Create an HTML report for Subsystem 1 decision coverage:
cvhtml('subsysteml', covobjl)

The report indicates that decision coverage is 50% for Subsystem 1. The true condition
for enable logical value is not analyzed.

Generate coverage report for Subsystem 2
Create an HTML report for Subsystem 2 decision coverage:
cvhtml('subsystem2', covobj2)

The report indicates that decision coverage is 50% for Subsystem 2. The false condition
for enable logical value is not analyzed.



Obtain Cumulative Coverage for Reusable Subsystems and Stateflow® Constructs

Generate coverage report for cumulative coverage of Subsystem 1 and
Subsystem 2

Create an HTML report for cumulative decision coverage for Subsystem 1 and Subsystem
2:

cvhtml('cum subsystem', covobj3)

Cumulative decision coverage for reusable subsystems Subsystem 1 and Subsystem 2 is
100%. Both the true and false conditions for enable logical value are analyzed.
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In this section...

“About Model Coverage for MATLAB Functions” on page 5-30
“Types of Model Coverage for MATLAB Functions” on page 5-30
“How to Collect Coverage for MATLAB Functions” on page 5-32
“Examples: Model Coverage for MATLAB Functions” on page 5-33

About Model Coverage for MATLAB Functions

The Simulink Coverage software simulates a Simulink model and reports model coverage
data for the decisions and conditions of code in MATLAB Function blocks. Model coverage
only supports coverage for MATLAB functions configured for code generation.

For example, consider the following if statement:

if (x>0 || y>0)
reset = 1;

The if statement contains a decision with two conditions (x > @ andy > 0). The
Simulink Coverage software verifies that all decisions and conditions are taken during the
simulation of the model.

Types of Model Coverage for MATLAB Functions

The types of model coverage that the Simulink Coverage software records for MATLAB
functions configured for code generation are:

* “Decision Coverage” on page 5-30

* “Condition and MCDC Coverage” on page 5-31

* “Simulink Design Verifier Coverage” on page 5-31

* “Relational Boundary Coverage” on page 5-32

Decision Coverage

During simulation, the following MATLAB Function block statements are tested for
decision coverage:
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* Function header — Decision coverage is 100% if the function or local function is
executed.

* 1f — Decision coverage is 100% if the if expression evaluates to true at least once,
and false at least once.

* switch — Decision coverage is 100% if every switch case is taken, including the fall-
through case.

» for — Decision coverage is 100% if the equivalent loop condition evaluates to true at
least once, and false at least once.

* while — Decision coverage is 100% if the equivalent loop condition evaluates to true
at least once, and evaluates to false at least once.

Condition and MCDC Coverage

During simulation, in the MATLAB Function block function, the following logical
conditions are tested for condition and MCDC coverage:

+ 1if statement conditions

* while statement conditions

* Logical expressions in assignment statements

Simulink Design Verifier Coverage

The following MATLAB functions are active in code generation and in Simulink Design
Verifier:

* sldv.condition

+ sldv.test

* sldv.assume

* sldv.prove

When you specify the Objectives and Constraints coverage metric in the Coverage

pane of the Configuration Parameters dialog box, the Simulink Coverage software records
coverage for these functions.

Each of these functions evaluates an expression expr, for example, sldv.test(expr),

where expr is a valid Boolean MATLAB expression. Simulink Design Verifier coverage
measures the number of time steps that the expression expr evaluates to true.
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If expris true for at least one time step, Simulink Design Verifier coverage for that
function is 100%. Otherwise, the Simulink Coverage software reports coverage for that
function as 0%.

For an example of coverage data for Simulink Design Verifier functions in a coverage
report, see “Simulink Design Verifier Coverage” on page 6-46.

Relational Boundary Coverage

If the MATLAB function block contains a relational operation, the relational boundary
coverage metric applies to this block.

If the MATLAB function block calls functions containing relational operations multiple
times, the relational boundary coverage reports a cumulative result over all instances
where the function is called. If a relational operation in the function uses operands of
different types in the different calls, relational boundary coverage uses tolerance rules for
the stricter operand type. For instance, if a relational operation uses int32 operands in
one call, and double operands in another call, relational boundary coverage uses
tolerance rules for double operands.

For information on the tolerance rules and the order of strictness of types, see “Relational
Boundary Coverage” on page 1-9.

How to Collect Coverage for MATLAB Functions

When you simulate your model, the Simulink Coverage software can collect coverage data
for MATLAB functions configured for code generation. To enable model coverage, select
Analysis > Coverage > Settings and select Enable coverage analysis.

You collect model coverage for MATLAB functions as follows:

e Functions in a MATLAB Function block
* Functions in an external MATLAB file

To collect coverage for an external MATLAB file, Coverage pane of the Configuration
Parameters dialog box, select Coverage for MATLAB files.

» Simulink Design Verifier functions:

e sldv.condition
e sldv.test
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 sldv.assume
* sldv.prove

To collect coverage for these functions, on the Coverage pane of the Configuration
Parameters dialog box, select the Objectives and Constraints coverage metric.

The following section provides model coverage examples for each of these situations.

Examples: Model Coverage for MATLAB Functions

* “Model Coverage for MATLAB Function Blocks” on page 5-33
* “Model Coverage for MATLAB Functions in an External File” on page 5-43
* “Model Coverage for Simulink Design Verifier MATLAB Functions” on page 5-44

Model Coverage for MATLAB Function Blocks

Simulink Coverage software measures model coverage for functions in a MATLAB
Function block.

The following model contains two MATLAB functions in its MATLAB Function block:

[ ]

Scope

."L ot

run_intersect_test

Y

MATLAB Function

In the Configuration Parameters dialog box, on the Solver pane, under Solver selection,
the simulation parameters are set as follows:

+ Type — Fixed-step
* Solver — discrete (no continuous states)
* Fixed-step size (fundamental sample time) — 1

The MATLAB Function block contains two functions:

* The top-level function, run_intersect test, sends the coordinates for two
rectangles, one fixed and the other moving, as arguments to rect _intersect.
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* The local function, rect_intersect, tests for intersection between the two
rectangles. The origin of the moving rectangle increases by 1 in the x and y directions
with each time step.

The coordinates for the origin of the moving test rectangle are represented by persistent
data x1 and y1, which are both initialized to - 1. For the first sample, x1 and y1 both
increase to 0. From then on, the progression of rectangle arguments during simulation is
as shown in the following graphic.

10

g

t=5

t=4
3+ t=3| \
- Test

rectangles
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The fixed rectangle is shown in bold with a lower-left origin of (2,4) and a width and
height of 2. At time t = 0, the first test rectangle has an origin of (0,0) and a width and
height of 2. For each succeeding sample, the origin of the test rectangle increments by
(1,1). The rectangles at sample times t = 2, 3, and 4 intersect with the test rectangle.

The local function rect intersect checks to see if its two rectangle arguments
intersect. Each argument consists of coordinates for the lower-left corner of the rectangle
(origin), and its width and height. x values for the left and right sides and y values for the
top and bottom are calculated for each rectangle and compared in nested if-else
decisions. The function returns a logical value of 1 if the rectangles intersect and 0 if they
do not.

Scope output during simulation, which plots the return value against the sample time,
confirms the intersecting rectangles for sample times 2, 3, and 4 .

B scope =)
20 e 0%% 085 -

After the simulation, the model coverage report appears in a browser window. After the
summary in the report, the Details section of the model coverage report reports on each
parts of the model.

The model coverage report for the MATLAB Function block shows that the block itself has
no decisions of its own apart from its function.
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The following sections examine the model coverage report for the example model in
reverse function-block-model order. Reversing the order helps you make sense of the
summary information at the top of each section.

Coverage for the MATLAB Function run_intersect_test

Model coverage for the MATLAB Function block function run_intersect test appears
under the linked name of the function. Clicking this link opens the function in the editor.

Below the linked function name is a link to the model coverage report for the parent
MATLAB Function block that contains the code for run_intersect test.

MATLAB Function "run_intersect test™

Parent: ex mec eml intersecting rectangles/MATLAB Function
Uncovered Links:

Metric Coverage

Cyclomatic Complexity 7

Decision 100% (8/8) decision outcomes

Condition 88% (7/8) condition outcomes

MCDC 78% (3/4) conditions reversed the outcome

The top half of the report for the function summarizes its model coverage results. The
coverage metrics for run_intersect test include decision, condition, and MCDC
coverage. You can best understand these metrics by examining the code for
run_intersect test.
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_1 function out = run interssct test
2 % Call rect_intersect to see Iif a moving test rectangle
3 % and a stationary rectangle intersect
g
5 persistent xl1 vl:
_6 if isemptvixl)
7 xl = -1, vl = —-1:
g8 end
=]
10 =1 = x1 + 1:
11l vl = vl + 1:
12 out = rect intersect([xl ¥l 2 2]1', [2 4 2 21"}
13

14 function out = rect intersect(rectl, rectl):
15 % PBeturn |l if two rectangs arguments intersect, 0 if not.

17 1leftl = rectlil):

18 bottoml = rectl(l):

19 rightl = leftl + rectl(3):
topl = bhottoml + rectl(d):

leftl = rectl(l):

bottomZl = recti (2):

rightZ = leftl + rectl (3):
topl = bottomZ + rectlid);

[ % T S IO % R O T S I % R N Y B |
=] Moo L) = O

27 if (topl < hottom || topl < hottoml)

28 cut = 0;

289 else

30 if (rightl < left2 || rightZ < leftl)
31 out = 0:

3z else

33 out = 1:

34 end

35 end

Lines with coverage elements are marked by a highlighted line number in the listing:

* Line 1 receives decision coverage on whether the top-level function
run_intersect test is executed.

» Line 6 receives decision coverage for its i f statement.

* Line 14 receives decision coverage on whether the local function rect intersect is
executed.

5-37



5 Coverage Collection During Simulation

5-38

» Lines 27 and 30 receive decision, condition, and MCDC coverage for their if
statements and conditions.

Each of these lines is the subject of a report that follows the listing.

The condition rightl < left2 inline 30 is highlighted in red. This means that this
condition was not tested for all of its possible outcomes during simulation. Exactly
which of the outcomes was not tested is in the report for the decision in line 30.

The following sections display the coverage for each run_intersect test decision
line. The coverage for each line is titled with the line itself, which if clicked, opens the
editor to the designated line.

Coverage for Line 1

The coverage metrics for line 1 are part of the coverage data for the function
run_intersect test.

The first line of every MATLAB function configured for code generation receives coverage
analysis indicative of the decision to run the function in response to a call. Coverage for
run_intersect test indicates that it executed at least once during simulation.

#1: function out = run_intersect_test

Decisions analyzed:

function out = run_intersect_test 100%

executed 1111

Coverage for Line 6

The Decisions analyzed table indicates that the decision in line 6, if isempty(x1),
executed a total of eight times. The first time it executed, the decision evaluated to true,
enabling run_intersect test to initialize the values of its persistent data. The
remaining seven times the decision executed, it evaluated to false. Because both
possible outcomes occurred, decision coverage is 100%.
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#6: if isempty(x1)

Decisions analyzed:

if isempty(x1) 100%

false 10/11

true 1111

Coverage for Line 14

The Decisions analyzed table indicates that the local function rect _intersect executed
during testing, thus receiving 100% coverage.

#14: function out = rect_intersect{rectl, rect?);

Decisions analyzed:

function out = rect_intersect(rect1, rect2); 100%

executed 1111

Coverage for Line 27

The Decisions analyzed table indicates that there are two possible outcomes for the
decision in line 27: true and false. Five of the eight times it was executed, the decision
evaluated to false. The remaining three times, it evaluated to true. Because both
possible outcomes occurred, decision coverage is 100%.

The Conditions analyzed table sheds some additional light on the decision in line 27.
Because this decision consists of two conditions linked by a logical OR (| |) operation,
only one condition must evaluate true for the decision to be true. If the first condition
evaluates to true, there is no need to evaluate the second condition. The first condition,
topl < bottom2, was evaluated eight times, and was true twice. This means that the
second condition was evaluated only six times. In only one case was it true, which brings
the total true occurrences for the decision to three, as reported in the Decisions
analyzed table.
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MCDC coverage looks for decision reversals that occur because one condition outcome
changes from T to F or from F to T. The MCDC analysis table identifies all possible
combinations of outcomes for the conditions that lead to a reversal in the decision. The
character x is used to indicate a condition outcome that is irrelevant to the decision
reversal. Decision-reversing condition outcomes that are not achieved during simulation
are marked with a set of parentheses. There are no parentheses, therefore all decision-
reversing outcomes occurred and MCDC coverage is complete for the decision in line 27.

#27: if (top1 < hottom? || top? < bottom1

Decisions analyzed:

if (fop1 < bottomn?2 || top2 < bottomT) 100%
false M
true B/11

Conditions analyzed:

Description: True | False
top! < bottom?2 2 9
top2 < hottom1 4 5

MC/DC analysis (combinations in parentheses did not occur)

Decision/Condition: True Qut False Qut

top1 < hottom2 || top2 < bottom

top1 < hottom?2 Tx FF

top2 < bottom FT FF

Coverage for Line 30

The line 30 decision, if (rightl < left2 || right2 < leftl), is nested in the if
statement of the line 27 decision and is evaluated only if the line 27 decision is false.
Because the line 27 decision evaluated false five times, line 30 is evaluated five times,
three of which are false. Because both the true and false outcomes are achieved,
decision coverage for line 30 is 100%.
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Because line 30, like line 27, has two conditions related by a logical OR operator (| |),
condition 2 is tested only if condition 1 is false. Because condition 1 tests false five
times, condition 2 is tested five times. Of these, condition 2 tests true two times and
false three times, which accounts for the two occurrences of the true outcome for this

decision.

Because the first condition of the line 30 decision does not test true, both outcomes do
not occur for that condition and the condition coverage for the first condition is
highlighted with a rose color. MCDC coverage is also highlighted in the same way for a
decision reversal based on the true outcome for that condition.

#30: if (right1 < lefi? || right? < left1)

Decisions analyzed:

if (right1 < 1eft2 || right2 < |eft1) 100%
false 3/5
true 25

Conditions analyzed:

Description: True | False
right1 < left2 0 5
right2 < left1 2 3

MC/DC analysis (comhbinations in parentheses did not occur)

Decision/Condition: True Out False Out

right1 < left2 || right2 < leftl
right! < left2 (Tx) FF
right2 < left1 FT FF
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Coverage for run_intersect_test

On the Details tab, the metrics that summarize coverage for the entire
run_intersect test function are reported and repeated as shown.

MATLAB Function "run_intersect test™

Parent: ex mc eml intersecting rectangles/MATLAB Function
Uncovered Links:

Metric Coverage

Cyclomatic Complexity 7

Decisian 100% (8/8) decision outcomes

Condition B88% (7/8) condition outcomes

MCDC 75% (3/4) conditions reversed the outcome

The results summarized in the coverage metrics summary can be expressed in the
following conclusions:

There are eight decision outcomes reported for run_intersect test in the line
reports:

¢ One forline 1 (executed)
¢ Two for line 6 (true and false)
* One for line 14 (executed)

* Two forline 27 (true and false)
* Two for line 30 (true and false).

The decision coverage for each line shows 100% decision coverage. This means that
decision coverage for run_intersect test is eight of eight possible outcomes, or
100%.

There are four conditions reported for run_intersect test in the line reports.
Lines 27 and 30 each have two conditions, and each condition has two condition
outcomes (true and false), for a total of eight condition outcomes in
run_intersect test. All conditions tested positive for both the true and false
outcomes except the first condition of line 30 (rightl < left2). This means that
condition coverage for run_intersect test is seven of eight, or 88%.
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* The MCDC coverage tables for decision lines 27 and 30 each list two cases of decision
reversal for each condition, for a total of four possible reversals. Only the decision
reversal for a change in the evaluation of the condition rightl < left2 of line 30
from true to false did not occur during simulation. This means that three of four, or
75% of the possible reversal cases were tested for during simulation, for a coverage of
75%.

Model Coverage for MATLAB Functions in an External File

Using the same model in “Model Coverage for MATLAB Function Blocks” on page 5-33,
suppose the MATLAB functions run_intersect test and rect intersect are stored
in an external MATLAB file named run_intersect test.m.

To collect coverage for MATLAB functions in an external file, on the Coverage pane of the
Configuration Parameters dialog box, select Coverage for MATLAB files.

After simulation, the model coverage report summary contains sections for the top-level
model and for the external function.

Coverage by Model

Complexity Condition Decisicn MCDC
TOTAL COVERAGE 883 I 100%:; I 76% I
1., .. un_intsrsect test B 58% I 100% I TE%% I
2. ... intsrsscting rectsngles? 3 - 100% I

The model coverage report for run_intersect test.mreports the same coverage data
as if the functions were stored in the MATLAB Function block.

For a detailed example of a model coverage report for a MATLAB function in an external
file, see “External MATLAB File Coverage Report” on page 6-5.

5-43



5 Coverage Collection During Simulation

Model Coverage for Simulink Design Verifier MATLAB Functions

If the MATLAB code includes any of the following Simulink Design Verifier functions
configured for code generation, you can measure coverage:

* sldv.condition

+ sldv.test

* sldv.assume

* sldv.prove

For this example, consider the following model that contains a MATLAB Function block.

ap Me A vp— 1)

fon St
MATLAB Function

Constant

The MATLAB Function block contains the following code:

function y = fcn(u)
% This block supports MATLAB for code generation.

sldv.condition(u > -30)
sldv.test(u == 30)
y =1

To collect coverage for Simulink Design Verifier MATLAB functions, on the Coverage
pane in the Configuration Parameters dialog box, under Other metrics, select
Objectives and Constraints.

After simulation, the model coverage report listed coverage for the sldv.condition and
sldv.test functions. For sldv.condition, the expression u > -30 evaluated to true
51 times. For sldv. test, the expression u == 30 evaluated to true 51 times.
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eM Function “fcn”

Parent: ex_mec_eml_sldv_blocks/MATLAB Function
Metric Coverage

Cyclomatic Complexity 1

Decision 100% (171) decision outcomes
Test Objective 100% (1/1) objective outcomes
Test Condition 100% (1/1) ohjective autcomes

1 function v = foniu)

2 % This block supports MATLAE for code generation.
3

4 sldv.condition{u > -30)

5 sldwv.testiu == 30)

e v = 1:

e
-y

: function y = feniu)

Decisions analyzed:
function y = fen(u) 100%

executed 51451

#4: sldv.condition(u > -30)

Test Condition analyzed:
sldv.condition(u > -30) 51/51

#5: sldv.test{u == 30)

Test Objective analyzed:
sldv.test{u == 30) 51/51
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For an example of model coverage data for Simulink Design Verifier blocks, see
“Objectives and Constraints Coverage” on page 1-7.
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Coverage for Custom C/C++ Code in Simulink Models

When you record coverage for models containing supported C/C++ S-Functions, MATLAB
Function blocks that call external C/C++ code, C Caller blocks with C/C++ code , or
Stateflow charts that integrate custom C/C++ code for simulation, coverage is recorded
for the C/C++ code within the C/C++ S-Functions, MATLAB Function blocks, or
Stateflow charts. The coverage results the custom code can be viewed in the same report
as the rest of the model. For each S-Function block, MATLAB Function block, or Stateflow
chart, the report links to a detailed coverage report for the C/C++ code in the block.

Enable Code Coverage for Custom C/C++ code in MATLAB
Function Blocks, C Caller Blocks, and Stateflow Charts

To enable code coverage for custom C/C++ code in your Simulink model:

1  On the Simulation Target pane of the Configuration Parameters, select Import
custom code.

2  On the Simulation Target pane of the Configuration Parameters, select Enable
custom code analysis.

Simulink Coverage records code coverage for custom C/C++ code in MATLAB Function
blocks, C Caller blocks, and Stateflow charts.

Code Coverage for S-Functions

Make S-Function Compatible with Model Coverage

If you use the legacy code function, S-Function Builder block or mex function to create
your S-Functions, adapt your method appropriately to make the S-Function compatible

with model coverage.

For more information on the three approaches, see “Implement C/C++ S-Functions”
(Simulink).

* “S-Function Using legacy code Function” on page 5-48
* “S-Function Using S-Function Builder” on page 5-48
* “S-Function Using mex Function” on page 5-48
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S-Function Using legacy_code Function

1 [Initialize a MATLAB structure with fields that represent Legacy Code Tool properties.

def = legacy code('initialize')
2 To enable model coverage, turn on the option def.Options.supportCoverage.

def.Options.supportCoverageAndDesignVerifier = true;
3  Use the structure def in the usual way to generate an S-function. For an example,
see “Coverage for S-Functions”.

S-Function Using S-Function Builder

1 Copy an instance of the S-Function Builder block from the User-Defined Functions
library in the Library Browser into the your model.

2 Double-click the block to open the S-Function Builder dialog box.
3 On the Build Info tab, select Enable support for coverage.

S-Function Using mex Function

If you use the mex function to compile and link your source files, use the slcovmex
function instead. The slcovmex function compiles your source code and also makes it
compatible with coverage.

This function has the same syntax and takes the same options as the mex function. In
addition, you can provide some options relevant for model coverage. For more
information, see slcovmex.

Generate Coverage Report for S-Function

1 Select Analysis > Coverage > Settings.

2 On the Coverage pane of the Configuration Parameters dialog box, select C/C++ S-
functions.

When you run a simulation, the coverage report contains coverage metrics for C/C++ S-
Function blocks in your model. For each S-Function block, the report links to a detailed
coverage report for the C/C++ code in the block.



See Also

See Also

Related Examples

. “View Coverage Results for Custom C/C++ Code in S-Function Blocks” on page 5-
50
More About

. “C/C++ S-Function” on page 2-25
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View Coverage Results for Custom C/C++ Code in S-
Function Blocks

5-50

This example shows how to view coverage results for the C/C++ code in S-Function
blocks in your model. To view coverage results for the C/C++ code in the blocks:

* Enable support for S-Function coverage. For more information, see “Coverage for
Custom C/C++ Code in Simulink Models” on page 5-47.

* Run simulation and view the coverage report.

The coverage results for S-Function blocks can be viewed in the same report as the
rest of the model. For each S-Function block, the report links to a detailed coverage
report for the C/C++ code in the block.

To view the full code coverage report used in this example, follow the steps in “Coverage
for S-Functions”.

1 In the coverage report, view the coverage metrics for the S-Function block.

S-Function block "sldemo sfun counterbus"

Parent: sldemo_let_bus/TestCounter

Uncovered Links: »

Metric Coverage

Cvclomatic Complexity 3

Condition 67% (4/6) condition outcomes

Decision 75% (3/4) decision outcomes

MCDC 30% (1/2) conditions reversed the outcome

Detailed Report: sldemo_lct_bus_sldemo_sfun_counterbus_instance_1_cov himl

For more information on the coverage report format, see “Top-Level Model Coverage
Report” on page 6-12.



View Coverage Results for Custom C/C++ Code in S-Function Blocks

2 Select the Detailed Report link. The code coverage report for the S-Function block
opens.

3 Select each of the links in Table Of Contents to navigate to various sections of the
report.

Code Coverage Report for S-Function sldemo_sfun_counterbus

Table Of Contents

Analysis Information
Tests

Summary

Details

Code

U

Section Title Purpose

Analysis information |Contains information such as time when model was
created and last modified, and file size.

Tests Contains information about the simulation such as
start and end time.

Summary Contains coverage information about the files and
functions in the S-Function block. For each file and
function, the percentage coverage is displayed. The
coverage types relevant for the code are the
following:

Coverage Type Label

“Cyclomatic Complexity |Complexity
for Code Coverage” on
page 4-5

“Condition Coverage for |Condition.
Code Coverage” on page
4-3

“Decision Coverage for |Decision
Code Coverage” on page
4-3
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Section Title Purpose

“Modified Condition/ MCDC
Decision Coverage
(MCDC) for Code
Coverage” on page 4-4

“Relational Boundary for (Relational Boundary
Code Coverage” on page
4-5

Percentage of statements |Stmt
covered

Details Contains coverage information about the statements
that receive condition, decision or MCDC coverage.
The information is grouped by file and function.

Code Contains the C/C++ code. Statements that are not
covered are highlighted in pink.

4 In the Summary section, select each file or function name to see details of coverage
for statements in the file or function.

File Contents  Complexity Decision Condition MCDC Stmt
1. counterbus.c 3 T500 w— 6700 m— 5000 = 9000 —
2 couniterbusFon 3 T3% — 670 m— 0%, == 009  —

5 The condition, decision or MCDC outcomes that were not tested during simulation
are highlighted in pink. Within the details for a file or function, scroll down to note
these cases and investigate them further.
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2.1 Decision/Condition (ml->limits.opper saturation l1imit >= limit) && inputGElower

Function: counterkbusFen (line 6)

Metric Coverage

Decision 100% (2/2) decision outcomes

Condition 75% (3/4) condition outcomes

MCDC 50% (1/2) conditions reversed the outcome

Decisions analvzed:

(ul->limits.upper saturation limit >= limit) && inputGElower 100%

false 61/201
true 140/201

Conditions analvzed:

Description: True || False
ul->limits.upper saturation limit >= ldimitc 140 61
inputGElower 140 0

6 To obtain an overview of the statements that were not covered, navigate to the Code
section. This section contains your code with the uncovered statements highlighted in

pink.
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i R

#include "counterbus.h"

E | void counterbusFcn (COUNTERBUS *ul, int32 T w2, COUNTEREUS *yl, int32 T =y2)
T4

8 int32 T limit;

=] boolean T inputGElower;

11 limit = ul->inputsignal.input + u2;

12
13 inputGElower = (limit >= ul->limits.lower saturation limit):
15 if{(ul->limits.upper saturation limit >= limit) && inputGElower) f
1& #y2 = limit;

17 else {
19 if (inputGElower) {

0 limit = ul->limits.upper saturation limic:

else {

limit = ul->1limits.lower saturation limit;

L ka

#y2 = limit;

1 &n L

vil->Finputsignal.input = *y2;
vl->limits = ul->limits;

L L R R ORI ORI RD R ORI ORI ORI ORI
[=Ts]

See Also

More About
. “C/C++ S-Function” on page 2-25
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Model Coverage for Stateflow Charts

In this section...

“How Model Coverage Reports Work for Stateflow Charts” on page 5-55
“Specify Coverage Report Settings for Stateflow Charts” on page 5-56
“Cyclomatic Complexity for Stateflow Charts” on page 5-56

“Decision Coverage for Stateflow Charts” on page 5-57

“Condition Coverage for Stateflow Charts” on page 5-60

“MCDC Coverage for Stateflow Charts” on page 5-61

“Relational Boundary Coverage for Stateflow Charts” on page 5-61
“Simulink Design Verifier Coverage for Stateflow Charts” on page 5-61
“Model Coverage Reports for Stateflow Charts” on page 5-63

“Model Coverage for Stateflow State Transition Tables” on page 5-72
“Model Coverage for Stateflow Atomic Subcharts” on page 5-73
“Model Coverage for Stateflow Truth Tables” on page 5-76

“Colored Stateflow Chart Coverage Display” on page 5-81

“Code Coverage for C/C++ code in Stateflow Charts” on page 5-83

How Model Coverage Reports Work for Stateflow Charts

To generate a Model Coverage report, select Analysis > Coverage > Settings and
specify the desired options on the Coverage > Results pane in the Configuration
Parameters dialog box. For Stateflow charts, the Simulink Coverage software records the
execution of the chart itself and the execution of states, transition decisions, and
individual conditions that compose each decision. After simulation ends, the model
coverage reports on how thoroughly a model was tested. The report shows:

* How many times each exclusive substate is executed or exited from its parent
superstate and entered due to parent superstate history

+ How many times each transition decision has been evaluated as true or false
* How many times each condition has been evaluated as true or false

Note To measure model coverage data for a Stateflow chart, you must:
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* Have a Stateflow license.
* Have debugging/animation enabled for the chart.

Specify Coverage Report Settings for Stateflow Charts

To specify coverage recording settings, select Analysis > Coverage > Settings in the
Simulink Editor. Then select Enable coverage analysis.

By selecting the Generate report automatically after analysis option in the Coverage
> Results pane of the Configuration Parameters dialog box, you can create an HTML
report containing the coverage data generated during simulation of the model. The report
appears in the MATLAB Help browser at the end of simulation.

Enabling coverage analysis also enables the selection of different coverages that you can
specify for your reports. The following sections address only coverage metrics that affect
reports for Stateflow charts. These metrics include decision coverage, condition coverage,
and MCDC coverage.

Cyclomatic Complexity for Stateflow Charts

Cyclomatic complexity is a measure of the complexity of a software module based on its
edges, nodes, and components within a control-flow chart. It provides an indication of
how many times you need to test the module.

The calculation of cyclomatic complexity is as follows:
CC=E-N+p

where CC is the cyclomatic complexity, E is the number of edges, N is the number of
nodes, and p is the number of components.

Within the Model Coverage tool, each decision is exactly equivalent to a single control
flow node, and each decision outcome is equivalent to a control flow edge. Any additional
structure in the control-flow chart is ignored since it contributes the same number of
nodes as edges and therefore has no effect on the complexity calculation. Therefore, you
can express cyclomatic complexity as follows:

CC = OUTCOMES - DECISIONS + p

For analysis purposes, each chart counts as a single component.
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Decision Coverage for Stateflow Charts

Decision coverage interprets a model execution in terms of underlying decisions where
behavior or execution must take one outcome from a set of mutually exclusive outcomes.

Note Full coverage for an object of decision means that every decision has had at least
one occurrence of each of its possible outcomes.

Decisions belong to an object making the decision based on its contents or properties.
The following table lists the decisions recorded for model coverage for the Stateflow
objects owning them. The sections that follow the table describe these decisions and their
possible outcomes.

Object Possible Decisions

Chart If a chart is a triggered Simulink block, it must decide whether or not to
execute its block.

If a chart contains exclusive (OR) substates, it must decide which of its
states to execute.

State If a state is a superstate containing exclusive (OR) substates, it must
decide which substate to execute.

If a state has on event name actions (which might include temporal
logic operators), the state must decide whether or not to execute the
actions.

Transition If a transition is a conditional transition, it must decide whether or not to
exit its active source state or junction and enter another state or
junction.

Chart as a Triggered Simulink Block Decision

If the chart is a triggered block in a Simulink model, the decision to execute the block is
tested. If the block is not triggered, there is no decision to execute the block, and the
measurement of decision coverage is not applicable (NA).
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Chart Containing Exclusive OR Substates Decision

If the chart contains exclusive (OR) substates, the decision on which substate to execute
is tested. If the chart contains only parallel AND substates, this coverage measurement is
not applicable (NA).

Superstate Containing Exclusive OR Substates Decision

Since a chart is hierarchically processed from the top down, procedures such as exclusive
(OR) substate entry, exit, and execution are sometimes decided by the parenting
superstate.

Note Decision coverage for superstates applies only to exclusive (OR) substates. A
superstate makes no decisions for parallel (AND) substates.

Since a superstate must decide which exclusive (OR) substate to process, the number of
decision outcomes for the superstate is the number of exclusive (OR) substates that it
contains. In the examples that follow, the choice of which substate to process can occur in
one of three possible contexts.

Note Implicit transitions appear as dashed lines in the following examples.




Model Coverage for Stateflow Charts

Context

Example

Decisions That Occur

Active call

States A and Al are active.

[C3]

* The parent of states A and B
must decide which of these
states to process. This decision
belongs to the parent. Since A is
active, it is processed.

» State A, the parent of states Al
and A2, must decide which of
these states to process. This
decision belongs to state A.
Since Al is active, it is
processed.

During processing of state Al, all
outgoing transitions are tested. This
decision belongs to the transition
and not to the parent state A. In
this case, the transition marked by
condition C2 is tested and a
decision is made whether to take
the transition to A2 or not.

Implicit substate
exit

A transition takes place whose source is
superstate A and whose destination is state

B.

—
A

Al
?
*
.
.
N
P
./l(
A2 hi
;
?

—

If the superstate has two exclusive
(OR) substates, it is the decision of
superstate A which substate
performs the implicit transition
from substate to superstate.
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Context

Example Decisions That Occur

Substate entry |A history junction records which substate  |If that superstate becomes the
with a history was last active before the superstate was  |destination of one or more

junction

exited. transitions, the history junction
decides which previously active
‘A, ) substate to enter.
Ad
\3—-.\ '?

A2 !

. A

5-60

For more information, see “State Details Report Section” on page 5-66.
State with On Event_Name Action Statement Decision

A state that has an on event name action statement must decide whether to execute
that statement based on the reception of a specified event or on an accumulation of the
specified event when using temporal logic operators.

Conditional Transition Decision

A conditional transition is a transition with a triggering event and/or a guarding
condition. In a conditional transition from one state to another, the decision to exit one
state and enter another is credited to the transition itself.

Note Only conditional transitions receive decision coverage. Transitions without
decisions are not applicable to decision coverage.

Condition Coverage for Stateflow Charts

Condition coverage reports on the extent to which all possible outcomes are achieved for
individual subconditions composing a transition decision or for logical expressions in
assignment statements in states and transitions.



Model Coverage for Stateflow Charts

For example, for the decision [A & B & C] on a transition, condition coverage reports on
the true and false occurrences of each of the subconditions A, B, and C. This results in
eight possible outcomes: true and false for each of three subconditions.

Outcome A B C
1 T T T
2 T T F
3 T F T
4 T F F
5 F T T
6 F T F
7 F F T
8 F F F

For more information, see “Transition Details Report Section” on page 5-69.

MCDC Coverage for Stateflow Charts

The Modified Condition Decision/Coverage (MCDC) option reports a test's coverage of
occurrences in which changing an individual subcondition within a logical expression
results in changing the entire expression from true to false or false to true.

For example, if a transition executes on the condition [C1 & C2 & C3 | C4 & (5], the
MCDC report for that transition shows actual occurrences for each of the five

subconditions (C1, C2, C3, C4, (5)in which changing its result from true to false is
able to change the result of the entire condition from true to false.

Relational Boundary Coverage for Stateflow Charts

If a transition in a Stateflow chart involves a relational operation, it receives relational
boundary coverage. For more information, see “Relational Boundary Coverage” on page
1-9.

Simulink Design Verifier Coverage for Stateflow Charts

You can use the following Simulink Design Verifier functions inside Stateflow charts:
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* sldv.condition
* sldv.test

* sldv.assume

* sldv.prove

If you do not have a Simulink Design Verifier license, you can collect model coverage for a
Stateflow chart containing these functions, but you cannot analyze the model using the
Simulink Design Verifier software.

When you specify the Objectives and Constraints coverage metric in the Coverage
pane of the Configuration Parameters dialog box, the Simulink Coverage software records
coverage for these functions.

Each of these functions evaluates an expression expr, for example, sldv.test(expr),
where expr is any valid Boolean MATLAB expression. Simulink Design Verifier coverage
measures the number of time steps that the expression expr evaluates to true.

If expr is true for at least one time step, Simulink Design Verifier coverage for that
function is 100%. Otherwise, the Simulink Coverage software reports coverage for that
function as 0%.

Consider a model that contains this Stateflow chart:

(ctate
ern
sldv. condition(1==1)
sldv. assume(2==2)
sldv. prove(3==3)
sldv. test{4==4)

N [ )

To collect coverage for Simulink Design Verifier functions, on the Coverage pane in the
Configuration Parameters dialog box, select Objectives and Constraints.

After simulation, the model coverage report lists coverage for the sldv.condition,
sldv.assume, sldv.prove, and sldv. test functions.
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Metric
Cyclomatic Complexity

Coverage
0

100% (11
100% (11
100% (11
100% (11

objective outcomes
ohjective outcomes
objective outcomes
ohjective outcomes

Proof Assumption
Test Condition
Proof Objective
Test Ohjective

[ ——

Proof Assumption analyzed:
sldv.assume(2==2) 1M |

Test Condition analyzed:
sldv.condition{1==1) 1M |

Proof Objective analyzed:
sldv. prove(3==3) 1M |

Test Objective analyzed:
sldv.test(4==4) 1M |

Model Coverage Reports for Stateflow Charts

* “Summary Report Section” on page 5-63

* “Subsystem and Chart Details Report Sections” on page 5-64

» “State Details Report Section” on page 5-66

* “Transition Details Report Section” on page 5-69

The following sections of a Model Coverage report were generated by simulating the

sf boiler model, which includes the Bang-Bang Controller chart. The coverage metrics
for MCDC are enabled for this report.

Summary Report Section

The Summary section shows coverage results for the entire test and appears at the
beginning of the Model Coverage report.
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Summary

Model Hierarchy/Complexity:

1. sf boiler 20 89%
2. . .. Bang-Bang Controller 16 95%
- S SF: Bang-Bang Controller 15 95%
4 SE: Heater 12 94%
o T SE: Off 2 100%
6. . SE: On 4 88%
7o SE:flash LED 1 100%
8 . SE: turn_boiler 1 100%
9. .. . Boiler Plant model 3 67%
100 ... .. digital thermometer 2 50%
| ) ADC 2 50%

D1
—
—
—
—
—
—
—
—
—
—
—

Test 1
Cl
T1% —
T1% —
T1% —
T1% e—
T5% —
NA
NA
NA
NA
NA
NA

MCDC
43% -
43% w—
43% -
43% —
50% —

NA
NA
NA
NA
NA
NA

Each line in the hierarchy summarizes the coverage results at that level and the levels
below it. You can click a hyperlink to a later section in the report with the same assigned
hierarchical order number that details that coverage and the coverage of its children.

The top level, st boiler, is the Simulink model itself. The second level, Bang-Bang
Controller, is the Stateflow chart. The next levels are superstates within the chart, in
order of hierarchical containment. Each superstate uses an SF: prefix. The bottom level,
Boiler Plant model, is an additional subsystem in the model.

Subsystem and Chart Details Report Sections

When recording coverage for a Stateflow chart, the Simulink Coverage software reports
two types of coverage for the chart—Subsystem and Chart.
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* Subsystem — This section reports coverage for the chart:

* Coverage (this object): Coverage data for the chart as a container object

* Coverage (inc.) descendants: Coverage data for the chart and the states and
transitions in the chart.

If you click the hyperlink of the subsystem name in the section title, the Bang-Bang
Controller block is highlighted in the block diagram.

Decision coverage is not applicable (NA) because this chart does not have an explicit
trigger. Condition coverage and MCDC are not applicable (NA) for a chart, but apply to
its descendants.

2. SubSystem block "Bang-Bang Controller"

Parent: /st_boiler
Child Systems: Bang-Bang Controller

Coverage (inc.

Metric Coverage (this object) descendants)

Cyclomatic Complexity 1 16

Condition (C1) NA 71% (10/14) condition outcomes

Decision (D1) NA 95% (21/22) decision outcomes

MCDC (C1) NA 43% (3/7) conditions reversed the outcome

* Chart — This section reports coverage for the chart:

* Coverage (this object): Coverage data for the chart and its inputs

* Coverage (inc.) descendants: Coverage data for the chart and the states and
transitions in the chart.

If you click the hyperlink of the chart name in the section title, the chart opens in the
Stateflow Editor.

Decision coverage is listed appears for the chart and its descendants. Condition
coverage and MCDC are not applicable (NA) for a chart, but apply to its descendants.
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3. Chart "Bang-Bang Controller"

Parent: sf boiler/Bang-Bang Controller
Child Systems: Heater, flash LED, turn boiler

Coverage (inc.

Metric Coverage (this object) descendants)
Cyclomatic Complexity 1 15
Condition (C1) NA 71% (10/14) condition outcomes
Decision (D1) 100% (2/2) decision outcomes 95% (21/22) decision outcomes
MCDC (C1) NA 43% (3/7) conditions reversed the outcome
Decisions analyzed:
Substate executed 100%
State "Off" 1160/1400
State "On" 240/1400

State Details Report Section

For each state in a chart, the coverage report includes a State section with details about
the coverage recorded for that state.

In the sf boiler model, the state On resides in the box Heater. On is a superstate that
contains:

* Two substates HIGH and NORM
* A history junction
e The function warm
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(on

\.

en: turn_boiler{ON)
du: flash_LED{)

®

~

HIGH [WarmL[T [Heater.On.warm()]

N

function b = warmi)

\Efg: Icold()}

The coverage report includes a State section on the state On.

5-67



5 Coverage Collection During Simulation

6. State "On"

Parent: sf boiler/Bang-Bang Controller.Heater
Uncovered Links: @®sp

Coverage (inc.

Metric Coverage (this object) descendants)
Cyclomatic Complexity 3 4
Decision (D1) 83% (5/6) decision outcomes 88% (7/8) decision outcomes
Decisions analyzed:
Substate executed 100%
State "HIGH" 150/233
State "NORM" 83/233
Substate exited when parent exits 50%
State "HIGH" 717
State "NORM" 0/7

Previously active substate entered due to history  100%
State "HIGH" 7/28
State "NORM" 21/28

The decision coverage for the On state tests the decision of which substate to execute.
The three decisions are listed in the report:

* Under Substate executed, which substate to execute when On executes.
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» Under Substate exited when parent exited, which substate is active when On exits.
NORM is listed as never being active when On exits because the coverage tool sees the
supertransition from NORM to Off as a transition from On to Off.

* Under Previously active substate entered due to history, which substate to reenter
when On re-executes. The history junction records the previously active substate.

Because each decision can result in either HIGH or NORM, the total possible outcomes are
3 x 2 = 6. The results indicate that five of six possible outcomes were tested during
simulation.

Cyclomatic complexity and decision coverage also apply to descendants of the On state.
The decision required by the condition [warm() ] for the transition from HIGH to NORM
brings the total possible decision outcomes to 8. Condition coverage and MCDC are not
applicable (NA) for a state.

Note Nodes and edges that make up the cyclomatic complexity calculation have no direct
relationship with model objects (states, transitions, and so on). Instead, this calculation
requires a graph representation of the equivalent control flow.

Transition Details Report Section

Reports for transitions appear under the report sections of their owning objects.
Transitions do not appear in the model hierarchy of the Summary section, since the
hierarchy is based on superstates that own other Stateflow objects.
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Transition "after(40.sec) [cold()]" from "Ofi" to "On"

Parent: sf boiler/Bang-Bang Controller.Heater
Uncovered Links: @®w

Metric Coverage

Cyclomatic Complexity 3

Condition (C1) 67% (4/6) condition outcomes

Decision (D1) 100% (2/2) decision outcomes

MCDC (C1) 3390 (1/3) conditions reversed the outcome

Decisions analyzed:

Transition trigger expression 100%
false 1131/1160
true 29/1160

Conditions analyzed:

Description: True | False
Condition 1, "sec" 1160 0
Condition 2, "after(40,sec)" 29 | 1131
Condition 3, "cold()" 29 0

MC/DC analysis (combinations in parentheses did not occur)

Decision/Condition: 1;;':: F(:;:lste
Transition trigger expression
Condition 1, "sec" TTT (Fxx)
Condition 2, "after(40,sec)" TTT TFx
Condition 3, "cold()" TTT (TTF)

The decision for this transition depends on the time delay of 40 seconds and the condition
[cold()].If, after a 40 second delay, the environment is cold (cold() = 1), the
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decision to execute this transition and turn the Heater on is made. For other time
intervals or environment conditions, the decision is made not to execute.

For decision coverage, both true and false outcomes occurred. Because two of two
decision outcomes occurred, coverage was full or 100%.

Condition coverage shows that only 4 of 6 condition outcomes were tested. The temporal
logic statement after (40, sec) represents two conditions: the occurrence of sec and
the time delay after (40, sec). Therefore, three conditions on the transition exist: sec,
after(40,sec), and cold(). Since each of these decisions can be true or false, six
possible condition outcomes exist.

The Conditions analyzed table shows each condition as a row with the recorded number
of occurrences for each outcome (true or false). Decision rows in which a possible
outcome did not occur are shaded. For example, the first and the third rows did not
record an occurrence of a false outcome.

In the MCDC report, all sets of occurrences of the transition conditions are scanned for a
particular pair of decisions for each condition in which the following are true:

» The condition varies from true to false.

» All other conditions contributing to the decision outcome remain constant.

* The outcome of the decision varies from true to false, or the reverse.

For three conditions related by an implied AND operator, these criteria can be satisfied by
the occurrence of these conditions.

Condition Tested True Outcome False Outcome
1 TTT Fxx
2 TTT TFx
3 TTT TTF

Notice that in each line, the condition tested changes from true to false while the other
condition remains constant. Irrelevant contributors are coded with an "x" (discussed
below). If both outcomes occur during testing, coverage is complete (100%) for the
condition tested.

The preceding report example shows coverage only for condition 2. The false outcomes
required for conditions 1 and 3 did not occur, and are indicated by parentheses for both
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conditions. Therefore, condition rows 1 and 3 are shaded. While condition 2 has been
tested, conditions 1 and 3 have not and MCDC is 33%.

For some decisions, the values of some conditions are irrelevant under certain
circumstances. For example, in the decision [C1 & C2 & C3 | C4 & C5] the left side of
the | is false if any one of the conditions C1, C2, or C3 is false. The same applies to the
right side result if either C4 or C5 is false. When searching for matching pairs that change
the outcome of the decision by changing one condition, holding some of the remaining
conditions constant is irrelevant. In these cases, the MCDC report marks these conditions
with an "x" to indicate their irrelevance as a contributor to the result. These conditions
appear as shown.

Transition "[c1&c?&c3 | cd&c5]". . .

MC/DC analysis ([combinations in parentheses did not occurj

Decision/Condition: MJJ:'E " (I):stlse
Transition trigger expression
Condition 1, "c1” TTTxx FunFx
Condition 2, "c2" TTTxx TFxFx
Condition 3, "c3" TTTxx TTFFx%
Condition 4, "c4" FuxTT FuxxFx
Condition 5, "c&" FuxTT FxxTF

Consider the first matched pair. Since condition 1 is true in the True outcome column, it
must be false in the matching False outcome column. This makes the conditions C2 and
C3 irrelevant for the false outcome since C1 & C2 & C3 is always false if C1 is false.
Also, since the false outcome is required to evaluate to false, the evaluation of C4 & C5
must also be false. In this case, a match was found with C4 = F making condition C5
irrelevant.

Model Coverage for Stateflow State Transition Tables

State transition tables are an alternative way of expressing modal logic in Stateflow.
Stateflow charts represent modal logic graphically, and state transition tables can
represent equivalent modal logic in tabular form. For more information, see “State
Transition Tables” (Stateflow).
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Coverage results for state transition tables are the same as coverage results for
equivalent Stateflow charts, except for a slight difference that arises in coverage of
temporal logic. For example, consider the temporal logic expression after (4, tick) in
the Mode Logic chart of the slvnvdemo covfilt example model.

after(4, tick)

In chart coverage, the after(4, tick) transition represents two conditions: the
occurrence of tick and the time delay after (4, tick). Since the temporal event tick
is never false, the first condition is not satisfiable, and you cannot record 100% condition
and MCDC coverage for the transition after(4, tick).

In state transition table coverage, the after(4, tick) transition represents a single
decision, with no subcondition for the occurrence of tick. Therefore, only decision
coverage is recorded.

For state transition tables containing temporal logic decisions, as in the above example,
condition coverage and MCDC is not recorded.

Model Coverage for Stateflow Atomic Subcharts

In a Stateflow chart, an atomic subchart is a graphical object that allows you to reuse the
same state or subchart across multiple charts and models.

When you specify to record coverage data for a model during simulation, the Simulink
Coverage software records coverage for any atomic subcharts in your model. The
coverage data records the execution of the chart itself, and the execution of states,
transition decisions, and individual conditions that compose each decision in the atomic
subchart.

Simulate the doc_atomic subcharts map iodata example model and record decision
coverage:
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Open the doc_atomic _subcharts map iodata model.

This model contains two Sine Wave blocks that supply input signals to the Stateflow
chart. Chart contains two atomic subcharts—A and B—that are linked from the same
library chart, also named A. The library chart contains the following objects:

In the Simulink Editor, select Analysis > Coverage > Settings

The Coverage pane of the Configuration Parameters dialog box appears.
Select Enable coverage analysis and then select Entire System.

On the Coverage > Results pane, select Generate report automatically after
analysis.

Click OK to close the Configuration Parameters dialog box.
Simulate the doc_atomic subcharts map iodata model.

When the simulation completes, the coverage report opens.

The report provides coverage data for atomic subcharts A and B in the following forms:

For the atomic subchart instance and its contents. Decision coverage is not applicable
(NA) because this chart does not have an explicit trigger.



Model Coverage for Stateflow Charts

4. Atomic Subchart "A"

Parent:
Child Systems:

Metric
Cyclomatic Complexity

Decision (D1)

doc atomic subcharts map iodata/Chart

i

)

Coverage (inc.
descendants)
0 4

o (78 .
A 88% (7/8) decision
outcomes

Cowverage (this object)

* For the library chart A and its contents. The chart itself achieves 100% coverage on
the input ul, and 88% coverage on the states and transitions inside the library chart.

5. Chart "A"

Parent:

Ietric
Cyclomatic Complexity

Decision (D1)

Decisions analyzed:

doc atomic subcharts map iodata/Chart A

Coverage (this object) Coverage (inc.

descendants)
1 4
100% (2/2) decision 8d% (7/8) decision
outcomes outcomes

Substate executed
State "Meqg”
State "Pos”

100%
410
510

Atomic subchart B is a copy of the same library chart A. The coverage of the contents
of subchart B is identical to the coverage of the contents of subchart A.
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Model Coverage for Stateflow Truth Tables

* “Types of Coverage in Stateflow Truth Tables” on page 5-76
* “Analyze Coverage in Stateflow Truth Tables” on page 5-76

Types of Coverage in Stateflow Truth Tables

Simulink Coverage software reports model coverage for the decisions the objects make in
a Stateflow chart during model simulation. The report includes coverage for the decisions
the truth table functions make.

For this type of The report includes coverage data for...

truth table...

Stateflow Classic Conditions only.

MATLAB Conditions and only those actions that have decision points.

Note With the MATLAB for code generation action language, you
can specify decision points in actions using control flow
constructs, such as loops and switch statements.

Note To measure model coverage data for a Stateflow truth table, you must have a
Stateflow license. For more information about Stateflow truth tables, see “Obtain
Cumulative Coverage for Reusable Subsystems and Stateflow® Constructs” on page 5-27.

Analyze Coverage in Stateflow Truth Tables

If you have a Stateflow license, you can generate a model coverage report for a truth
table.

Consider the following model.
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' )
1 2 El
Constant O }
0 >e ab—f 1]
Constant1 t Display
0 |
Corstant2 . A

The Stateflow chart contains the following truth table:
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Condition Table

DESCRIFTION CONDITION D1 D2 D3
1 xis egual to 1 XEQ1:
x== T F F
2 yis equal to 1 YE@Q1:
y == F T F
3 zis egual to1 ZEQ1:
z== F F T
ACTIONS: SPECIFY A ROW
FROM THE ACTION TABLE AZ =
Action Table
DESCRIFTION ACTION
1 Initial action: INIT:
Display message mi.disp{truth table ttable entered’);
2 setito1 Al
t=1;
3 gettto? A2
t=2;
4 zettto 3 A3
t=3;
5 setttod Ad:
t=4;
&  Final action: FIMNAL:
Display message mi.disp{truth table ttable exited");
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When you simulate the model and collect coverage, the model coverage report includes
the following data:

4, Truth Table "ttable"

Justifv or Exclude

Parent:

Metric

ex_first truth table/'Chart

Cvclomatic Complexity

Condition
Decision
MCDC

Coverage (this object)

0

NA
NA
NA

Coverage (inc. descendants)
9

17% (3/18) condition outcomes
17% (1/6) dectsion outcomes

0% (0/9) conditions reversed the outcome

Condition table analysis (missing values are in parentheses)

x 15 equal to 1 XEQL: . g g i
s eq x=1 || (F) || (TF) | (TF)
N YEQI: || F T F
yisequalto 1} " 50 oy | rF) | oTR) || C
< cowaliol || ZEQL | E | F T
z is equal to - (T || (TF) || (TF) _
. Al || A2 || A3
Actions ® || a@p | TP A4

The Coverage (this object) column shows no coverage. The reason is that the container
object for the truth table function—the Stateflow chart—does not decide whether to
execute the ttable truth table.

The Coverage (inc. descendants) column shows coverage for the graphical function.
The graphical function has the decision logic that makes the transitions for the truth
table. The transitions in the graphical function contain the decisions and conditions of the
truth table. Coverage for the descendants in the Coverage (inc. descendants) column
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includes coverage for these conditions and decisions. Function calls to the truth table test
the model coverage of these conditions and decisions.

Note See “View Generated Content for Stateflow Truth Tables” (Stateflow) for a
description of the graphical function for a truth table.

Coverage for the decisions and their individual conditions in the ttable truth table

function are as follows.

Coverage

Explanation

No model coverage for the default
decision, D4

All logic that leads to taking a default decision
is based on a false outcome for all preceding
decisions. This means that the default decision
requires no logic, so there is no model
coverage.

17% (1/6) decision coverage

The three constants that are inputs to the
truth table (1, 0, 0) cause only decision DI to
be true. These inputs satisfy only one of the
six decisions (D1 through D3, T or F).

Because each condition can have an outcome
value of T or F, three conditions can have six
possible values.

3 of the 18 (17%) condition coverage

Three decisions D1, D2, and D3 have condition
coverage, because the set of inputs (1, 0, 0)
make only decision D1 true.

No (0/9) MCDC coverage

MCDC coverage looks for decision reversals
that occur because one condition outcome
changes from T to F or F to T. The simulation
tests only one set of inputs, so the model
reverses no decisions.

Missing coverage

The red letters T and F indicate that model
coverage is missing for those conditions. For
decision D1, only the T decision is satisfied.
For decisions D2, D3, and D4, none of the
conditions are satisfied.
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Colored Stateflow Chart Coverage Display

The Model Coverage tool displays model coverage results for individual blocks directly in
Simulink diagrams. If you enable this feature, the Model Coverage tool:

Highlights Stateflow objects that receive model coverage during simulation

Provides a context-sensitive display of summary model coverage information for each
object

Note The coverage tool changes colors only for open charts at the time coverage
information is reported. When you interact with the chart, such as selecting a
transition or a state, colors revert to default values.

For details on enabling and selecting this feature in the Simulink window, see “Enable
Coverage Highlighting” on page 5-13.

Display Model Coverage with Model Coloring

Once you enable display coverage with model coloring, anytime that the model generates
a model coverage report, individual chart objects receiving coverage appear highlighted
with light green or light red.

Open the st car model.
Select Analysis > Coverage > Settings.

In the Coverage pane of the Configuration Parameters dialog box, select Enable
coverage analysis.

In the Coverage > Results pane, select Display coverage results using model
coloring.

Click OK.
Simulate the model.

After simulation ends, chart objects with coverage appear highlighted.
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sf_car » Eshif‘t_logic 4

Simulink Function
[down_th up_th] = calc_th(gear throttle)

i/

E gear_state up up Up E

: | S —o T— :

! 2 E - | Eo— {
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Object highlighting indicates coverage as follows:

* Light green for full coverage
* Light red for partial coverage
* No color for zero coverage

Note To revert the chart to show original colors, select and deselect any objects.

7 Click selection_ state in the chart.

The following summary report appears.
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-

E Coverage: sf_car E'@
- B2

i)
State "selection state"

Decision 88% (14/16) Condition 67% (8/12)
MCDC 33% (2/6)

When you click a highlighted Stateflow object, the summarized coverage for that
object appears in the Coverage Display Window. Clicking the hyperlink opens the
section of the coverage report for this object.

Tip You can set the Coverage Display Window to appear for a block in response to a
hovering mouse cursor instead of a mouse click in one of two ways:

* Select the downward arrow on the right side of the Coverage Display Window and
select Focus.

* Right-click a colored block and select Coverage > Display details on mouse-
over.

Code Coverage for C/C++ code in Stateflow Charts

Simulink Coverage can record code coverage if your Stateflow chart contains custom C/C

++ code. For more information, see “Coverage for Custom C/C++ Code in Simulink
Models” on page 5-47.
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* “Types of Coverage Reports” on page 6-2
» “Top-Level Model Coverage Report” on page 6-12
» “Export Model Coverage Web View” on page 6-48



6 Results Review

Types of Coverage Reports

If you choose to generate a coverage report automatically after analysis from the
Coverage > Results pane of the Configuration Parameters dialog box or you generate a
report from the Results Explorer, the Simulink Coverage software creates one or more
model coverage reports after a simulation.

Report Type

Description

HTML Report File Name

“Top-Level Model Coverage Report”
on page 6-12

Provides coverage
information for all model
elements, including the model
itself.

model name cov.html

“Model Summary Report” on page 6-
3

Provides links to coverage
results for referenced models
and external MATLAB files in
the model hierarchy. Created
when the top-level model
includes Model blocks or calls
one or more external files.

model name
_summary_cov.html

“Model Reference Coverage Report”
on page 6-4

Created for each referenced
model in the model hierarchy;
has the same format as the
model coverage report.

reference _model name
_cov.html

“External MATLAB File Coverage
Report” on page 6-5

Provides detailed coverage
information about any
external MATLARB file that the
model calls. There is one
report for each external file
called from the model.

MATLAB_file name
_cov.html

“Subsystem Coverage Report” on
page 6-9

Model coverage report
includes only coverage results
for the subsystem, if you
select one.

model name cov.html;
model name is the name of
the top-level model

“Code Coverage Report” on page 6-
11

Provides coverage
information for C/C++ code
in S-Function blocks, or for
models in SIL mode.

model name block name
_instance n cov.html, or
model name cov.html
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Model Summary Report

If the top-level model contains Model blocks or calls external files, the software creates a
model summary coverage report named model name summary cov.html. The title of
this report is Coverage by Model.

The summary report lists and provides links to coverage reports for Model block
referenced models and external files called by MATLAB code in the model. For more
information, see “External MATLAB File Coverage Report” on page 6-5.

The following graphic shows an example of a model summary report. It contains links to
the model coverage report (nExternalMfile), a report for the Model block
(mExternalMfileRef), and three external files called from the model
(externalmfile,l externalmfilel, andexternalmfile?2).
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Coverage Report by Model

Top Model: mExternalMfile

Complexity Decision Condition MCDC
TOTAL COVERAGE 00% ——— 75%; —— 25% mm
1. . . mExternalMfile 5 50% -- --
2. . .. externalmfilel 5 S8%  e—— T5% — 0%q
3. ... mExternal\VfleRef 3 100% eo— -- --
4. .. . externalmfile 5 100%  — T5% — 50%  —
5. ... externalmfile2 2 100% eo— -- -

The following models have signal range coverage:

mExternalivfile
mExternalvifileR ef

Model Reference Coverage Report

If your top-level model references a model in a Model block, the software creates a
separate report, named reference_model name cov.html, that includes coverage for
the referenced model. This report has the same format as the “Top-Level Model Coverage
Report” on page 6-12. Coverage results are recorded as if the referenced model was a
standalone model; the report gives no indication that the model is referenced in a Model
block.
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External MATLAB File Coverage Report

If your top-level model calls any external MATLAB files, select MATLAB files on the
Coverage pane in the Configuration Parameters dialog box. The software creates a
report, named MATLAB file name_cov.html, for each distinct file called from the
model. When there are several calls to a given file from the model, the software creates
only one report for that file, but it accumulates coverage from all the calls to the file. The
external MATLAB file coverage report does not include information about what parts of
the model call the external file.

The first section of the external MATLAB file coverage report contains summary
information about the external file, similar to the model coverage report.
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6-6

Coverage Report for externalmfilel

Table of Contents

Analysis Information
Summary
Details

N VI R

Analysis Information

MATLAB Function File Information
Last saved 13-Nov-2008 12:39:55

Simulation Optimization Options

Inline parameters off
Block reduction forced off
Conditional branch optimization on

Coverage Options

Analyzed model externalmfilel
Logic block short circuiting off

Tests

Test 1

Started execution 20-Dec-2013 15:45:08
Ended execution 20-Dec-2013 15:45:00

Summary
Model Hierarchy/Complexity Test 1

D1 C1 MCDC
1. externalmfile] 5 §8% e 750; m———(%
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The Details section reports coverage for the external file and the function in that file.

Details

1. MATLAB Function file "externalmfilel"

Coverage (inc.

Metric Coverage (this object) descendants)

Cyclomatic Complexity 1 5

Condition (C1) NA 75% (3/4) condition outcomes

Decision (D1) NA 88% (7/8) decision outcomes

MCDC (C1) NA 0% (0/2) conditions reversed the outcome
MATLAB Function "externalmfilel"

Parent: externalmfile]

Uncovered Links:

Metric Coverage

Cyclomatic Complexity 4

Condition (C1) 75% (3/4) condition outcomes

Decision (D1) 88% (7/8) decision outcomes

MCDC (C1) 0% (0/2) conditions reversed the outcome

The Details section also lists the content of the file, highlighting the code lines that have
decision points or function definitions.



6 Results Review

1 %#eml
2 function y = externalmfilel (u)
3
4 % Copyright 2008 The MathWorks, Inc.
5
B if u>l1 && u<b
7 a = 2;
g2 else
=] a = 3;
10 end
11
12 for 1=1:5
13 a = ati;
14 end
15
1¢ v = atlocaltest(a):
17

18 [x,v] = polZcart(u,u);
15 [y2,y3] = cartZpol(x,vy):

20

21 function v = localtest (u)
22

23 vy = 0;

24 flg = true;

25 while flg

26 u = u/2;
27 v = y+1;
28 flg = ux2;
2% end

30

Coverage results for each of the highlighted code lines follow in the report. The following
graphic shows a portion of these coverage results from the preceding code example.
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#2: function v = externalmfilel(u)

Decisions analyvzed
function y = externalmfile1(u) 100%

executed 102/102

#6: ifu=1 && u<3

Decisions analyvzed

ifu=1l && u<s 50%
false 102/102
true 0/102

Subsystem Coverage Report

In the Coverage pane of the Configuration Parameters dialog box, when you select
Enable coverage analysis, you can click Select Subsystem to request coverage for
only the selected subsystem in the model. The software creates a model coverage report
for the top-level model, but includes coverage results only for the subsystem.

However, if the top-level model calls any external files and you select MATLAB files in
the Coverage pane in the Configuration Parameters dialog box, the results include
coverage for all external files called from:

* The subsystem for which you are recording coverage
* The top-level model that includes the subsystem

If the subsystem parameter Read/Write Permissions is set to NoReadOrWrite, the
software does not record coverage for that subsystem.

For example, in the fuelsys model, you click Select Subsystem, and select coverage
for the feedforward fuel rate subsystem.
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Subsystem Selection

L I Ty Wl

Enumerated Constant

=l control_logic
Pressure.map_estimate
Speed.speed_estimate
“~Throttle.throttle_estimate
=-fuel_calc

feedfumard_fuel_rate

= switchable_compensation |~
disabled_mode

Lo leaee mandn

m

-

| ok || cancel |

The report is similar to the model coverage report, except that it includes only results for
the feedforward fuel rate subsystem and its contents.
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Summary

Model Hierarchy/Complexity: Test 1
D1
1. feedforward_fuel rate 333% wm

Details:

1. SubSystem block "feedforward fuel rate"

Parent: sldemo fuelsys/fuel rate control/fuel calc

Coverage (inc.

Metric Coverage (this object) descendants)
Cyclomatic Complexity 1 3
Decision (D1) NA 33% (1/3) decision outcomes

Code Coverage Report

For each S-Function block, the model coverage report links to a detailed code coverage
report for the C/C++ code in the block. For more information on how to navigate the
report, see “View Coverage Results for Custom C/C++ Code in S-Function Blocks” on
page 5-50.

If you have Embedded Coder installed, you can also generate code coverage reports from
models in SIL or PIL mode. For more information on how to generate code coverage
reports for models in SIL or PILmode, see “Code Coverage for Models in Software-in-the-
Loop (SIL) Mode and Processor-in-the-Loop (PIL) Mode” on page 4-7.

6-11



6 Results Review

Top-Level Model Coverage Report

6-12

If you specify to Generate report automatically after analysis in the Coverage >
Results on page 3-7 pane in the Configuration Parameters dialog box, the Simulink
Coverage software creates a model coverage report for the specified model named
model name_cov.html. The model coverage report contains several sections:

In this section...

“Coverage Summary” on page 6-12
“Details” on page 6-14

“Cyclomatic Complexity” on page 6-23
“Decisions Analyzed” on page 6-25
“Conditions Analyzed” on page 6-27

“MCDC Analysis” on page 6-27

“Cumulative Coverage” on page 6-29
“N-Dimensional Lookup Table” on page 6-31
“Block Reduction” on page 6-37

“Relational Boundary” on page 6-38
“Saturate on Integer Overflow Analysis” on page 6-42
“Signal Range Analysis” on page 6-43

“Simulink Design Verifier Coverage” on page 6-46

“Signal Size Coverage for Variable-Dimension Signals” on page 6-45

Coverage Summary

The coverage summary section contains basic information about the model being

analyzed:

* Model Information
* Simulation Optimization Options

* Coverage Options



Top-Level Model Coverage Report

Coverage Report for sldemo_fuelsys

Table of Contents

. Analvsis Information
Tests

. Summary

_ Details

. Sional Ranges

L e !w-J'—‘

Analysis Information

Model Information

Model version 1736
Author The MathWorks. Inc.
Last saved Fri Sep 23 19:02:33 2016

Simulation Optimization Options

Default parameter behavior inlined
Block reduction forced off
Conditional branch optimization on

Coverage Options

Analyzed model sldemo_fuelsys

Logic block short circuiting off

The coverage summary has two subsections:

» Tests — The simulation start and stop time of each test case and any setup commands
that preceded the simulation. The heading for each test case includes any test case
label specified using the cvtest command.

*  Summary — Summaries of the subsystem results. To see detailed results for a specific
subsystem, in the Summary subsection, click the subsystem name.
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Tests

Test# Slartenfl Ended. Description
execution execution
This 1s a model of a fuel control svstem where Stateflow(R) is used to handle the fault
management of the svstem. The svstem contains four separate sensors: a throttle sensor. a
speed sensor. an oxygen sensor. and a pressure sensor. Each of these sensors is represented
by a parallel state in Stateflow. Each parallel state contains two substates. a normal state and
a failed state (the exception being the oxygen sensor. which also contains a warmup state).

Test 07-Oct- 07-Oct- If anv of the sensor readings is outside an acceptable range. then a fault is registered in
1 2016 2016 Stateflow. and the substate of the corresponding subsystem transitions to the failed state. If a
09:06:06 09:08:25  subsystem recovers, it can transition back to the normal state. The number of failures in the

system at any given time 1s represented m the Fail parallel state. The last parallel state i the
Stateflow chart is called Fueling Mode. This state regulates the oxyzen to fuel mixture
ratto. If a fatlure 15 detected, then the oxygen to fuel ratio 15 mcreased. If multiple failures
are detected, then the fuel system 1s disabled until there are no longer multiple failures in the
system

Summary

Model Hierarchy/Complexity Testl

. Saturation on
Decision Condition MCDC Execution Relational integer
Boundary
. overflow

1. sldemo_fiselsys 20 34% mm 349 = oo w 0% oo 0% ® 0%  m—

2... Engine Gas Dynamics 13 71%  e— NA NA 100% o——— 0%  — 0%  m—

S Mixing & Combustion 3 67% = NA NA 100% —— A 0% —

4 EGO Sensor 2 100% e—— WA NA NA NA NA

5. System Lag NA NA NA 100% —— A NA

G....... Throttle & Manifold 10 73% o NA NA 100% o——— 0%  — 0%  m—

T Intake Manifold 2 100% e—— WA NA 100% —— A 0% —

8 MATLAB Y 100% - XA X A N

Function

LT Throttle 6 23% e WA NA 100% e——— 100% — 00—

Details

The Details section reports the detailed model coverage results. Each section of the
detailed report summarizes the results for the metrics that test each object in the model:
* “Filtered Objects” on page 6-15

» “Model Details” on page 6-15

* “Subsystem Details” on page 6-16

* “Block Details” on page 6-17
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* “Chart Details” on page 6-19

* “Coverage Details for MATLAB Functions and Simulink Design Verifier Functions”
on page 6-20

You can also access a model element Details subsection as follows:

1 Right-click a Simulink element.
2 In the context menu, select Coverage > Report.

Filtered Objects

The Filtered Objects section lists all the objects in the model that were filtered from
coverage recording, and the rationale you specified for filtering those objects. If the filter
rule specifies that all blocks of a certain type be filtered, all those blocks are listed here.

In the following graphic, several blocks, subsystems, and transitions were filtered. Two
library-linked blocks, protected division and protected divisionl, were filtered because
their block library was filtered.

Blocks Eliminated from Coverage Analysis

Model Object Rationale

slvnvdemo covfilt/Saturation It might not be executed because of Conditional input branch optimization
slvnvdemo covfilt/protected division/Compare To Zero/Compare It might not be executed because of Conditional input branch optimization
slvnvdemo covfilt/protected division/Switch It might not be executed because of Conditional input branch optimization
slvnvdemo covfilt/protected division/Switchl It might not be executed because of Conditional input branch optimization
slvnvdemo covfilt/protected division1/Switch It might not be executed because of Conditional input branch optimization

Model Details

The Details section contains a results summary for the model as a whole, followed by a
list of elements. Click the model element name to see its coverage results.

The following graphic shows the Details section for the sldemo_fuelsys example model.
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Details

1. Model "sldemo_ fuelsys"

6-16

Child Systems: Engine Gas Dvnamics. Throttle Command. To Controller. To Plant. fuel rate_control
Metric Coverage (this object) Coverage (inc. descendants)

Cyclomatic Complexity 1 80

Condition NA 34% (11/32) condition outcomes

Decision NA 34% (41/122) decision outcomes

MCDC NA 7% (1/14) conditions reversed the outcome
Lookup Table NA 1% (13/151 1 )interpolation/extrapolation intervals
Execution NA 90% (64/71) objective outcomes

Relational Boundary NA 10% (5/50) objective outcomes

Saturation on wteger overflow NA 50% (10/20) objective outcomes

Subsystem Details

Each subsystem Details section contains a summary of the test coverage results for the
subsystem and a list of the subsystems it contains. The overview is followed by sections
for blocks, charts, and MATLAB functions, one for each object that contains a decision
point in the subsystem.

The following graphic shows the coverage results for the Engine Gas Dynamics subsystem
in the sldemo fuelsys example model.
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2. SubSystem block "Engine Gas Dyvnamics"

Justifv or Exclude

Parent: sldemo_fuelsvs

Child Systems: Mixing & Combustion. Throttle & Manifold

Metric Coverage (this object) Coverage (inc. descendants)
Cvclomartic Complexity 0 13

Decizion NA 71% (10/14) decision outcomes
Execution NA 100% (17/17) objective outcomes
E.elational Boundary NA 30% (3/6) objective outcomes
Saturation on integer overflow NA 50% (10/20) objective outcomes

Block Details

The following graphic shows decision coverage results for the MinMax block in the
Mixing & Combustion subsystem of the Engine Gas Dynamics subsystem in the
sldemo fuelsys example model.
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MinMazx block "MinMax"

Justifv or Exclude

Parent: sldemoe fuelsve/Enoine Gas Dvnamics Mixing & Combustion
Uncovered Links: an

Metric Coverage

Cvclomatic Complexity 1

Decision 50% (1/2) decision outcomes
Execution 100% (1/1) objective outcomes

Decisions analvzed

Logic to determine output 0%
input 1 15 the maximum 204508/204508
. . . 2045
input 2 15 the maximum L '1'.! =

The Uncovered Links element first appears in the Block Details section of the first block
in the model hierarchy that does not achieve 100% coverage. The first Uncovered Links
element has an arrow that links to the Block Details section in the report of the next block
that does not achieve 100% coverage.

Subsequent blocks that do not achieve 100% coverage have links to the Block Details
sections in the report of the previous and next blocks that do not achieve 100% coverage.

Saturate block "Limit to Positive"

Parent: sldemo fuelsys/Engine Gas Dyvnamics/Throttle & Manifold
Uncovered Links: @m
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Chart Details

The following graphic shows the coverage results for the Stateflow chart control logic in
the sldemo fuelsys example model.

17. SubSystem block "control logic"

Justifv or Exclude

Parent: sldemo_fuelsvs/fuel rate_control

Child Systems: fuel_rate_control/'control logic

Metric Coverage (this object) Coverage (inc. descendants)

Cyclomatic Complexity 1 36

Condition NA 21% (3/24) condition outcomes

Decision NA 25% (23/92) decision outcomes

MCDC NA 0% (0/12) conditions reversed the outcome
Lookup Table NA 0% (0/1082)nterpolation/extrapolation wtervals
Execution NA 0% (0/4) objective outcomes

Relational Boundary NA 0% (0/34) objective outcomes

18. Chart "fuel rate control/control logic"

Justifv or Exclude

Parent: sldemo_fuelsys/fuel rate_control'control logic

Child Svstems: Fail. Fueling Mode. O2. Pressure. Speed. Throttle

Metric Coverage (this object) Coverage (inc. descendants)

Cvclomatic Complexity ] 535

Condition NA 21% (3/24) condition outcomes

Decision NA 25% (23/92) decision outcomes

MCDC NA 0% (0/12) conditions reversed the outcome
Loockup Table NA 0% (0/1082)interpolation/extrapolation intervals
Execution NA 0% (0/4) objective outcomes

Felational Boundarv NA 0% (0/34) obyective outcomes

For more information about model coverage reports for Stateflow charts and their
objects, see “Model Coverage for Stateflow Charts” on page 5-55.
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Coverage Details for MATLAB Functions and Simulink Design Verifier Functions

By default, Simulink Coverage records coverage for all MATLAB functions in a model.
MATLAB functions are in MATLAB Function blocks, Stateflow charts, or external MATLAB
files.

Note For a detailed example of coverage reports for external MATLAB files, see
“External MATLAB File Coverage Report” on page 6-5.

To record Simulink Design Verifier coverage for sldv. * functions called by MATLAB
functions, and any Simulink Design Verifier blocks, select Objectives and Constraints
on the Coverage pane of the Configuration Parameters dialog box.

The following example shows coverage details for a MATLAB function,
hFcnsInExternalEML, that calls four Simulink Design Verifier functions. In this
example, the code for hFcnsInExternalEML resides in an external file.

This example also shows Simulink Design Verifier coverage details for the following
functions:

* sldv.assume

* sldv.condition

* sldv.prove

+ sldv.test

In the coverage results, code that achieves 100% coverage is green. Code that achieves
less than 100% coverage is red.
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Embedded MATLAB function "hfcnsinexternalem!"

Parent: hfcnsinexternalem|
Uncovered Links:

Metric Coverage
Cyclomatic Complexity 4
Decision (D1) 40% (2/5) decision outcomes
Test Objective 50% {1/2) ohjective outcomes
Proof Objective 0% {0/1) objective outcomes
Test Condition 100% (1/1) objective outcomes
Proof Assumption 0% {0/1) objective outcomes
1 function ¥ = hFcnsInExternalEML (ul, ulZ)
2 % use all four functions.
3 ffeml
_4 sldv.assome(nl > n2);
_ 8 sldv.condition(ul == 0);
_6 =switch ul
T case 0
8 Vo= ud;
3 case 1
11 case 2
12 v = 0;
14 v = 0;
13 zldv.prove(n2 < ul);
16 end
17 =ldv.testi(y > ul): sldv.test(y == 4);

Coverage for the hFcnsInExternalEML function and the sldv.* calls is:

* Line 1, the function declaration for hFcnsInExternalEMLis green because the
simulation executes that function at least once. fcn calls hFcnsInExternalEML 11
times during simulation.
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#1: function y = hFcnsinExternalEML{u1, u2)

Decisions analyzed:
function v = hFcnsinExtemalEML{u1, uZ) 100%

executed 1111

Line 4, sldv.assume(ul > u2), achieves 0% coverage because ul > u2 never
evaluates to true.

#4: sldv.assume(ul = u);

Proof Assumption analyzed:

sldv.assumeful = u2) 011

* Line 5, sldv.condition(ul == 0), achieves 100% coverage because ul ==
evaluates to true for at least one time step.

#5: sldv.condition{ul == 0);

Test Condition analyzed:

sldv.condition{ul == 0| 1111

* Line 6, switch ul, achieves 25% coverage because only one of the four outcomes in
the switch statement (case 0) occurs during simulation.
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#6: switch u1

Decisions analyzed:

switch u 25%
otherwise 011
case 0 1/
case 1 011
case 2 011

* Line17,sldv.test(y > ul); sldv.test (y == 4) achieves 50% coverage. The
first sldv.test call achieves 100% coverage, but the second sldv.test call
achieves 0% coverage.

#17: sldv.testly = ul); sldv.testly == 4);

Test Objective analyzed:
sldv test{y = ul) 1111

sldv test{y == 4) 011

For more information about coverage for MATLAB functions, see “Model Coverage for
MATLAB Functions” on page 5-30.

For more information about coverage for Simulink Design Verifier functions, see
“Objectives and Constraints Coverage” on page 1-7.

Cyclomatic Complexity

You can specify that the model coverage report include cyclomatic complexity numbers in
two locations in the report:
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* The Summary section contains the cyclomatic complexity numbers for each object in
the model hierarchy. For a subsystem or Stateflow chart, that number includes the
cyclomatic complexity numbers for all their descendants.

Summary

Model Hierarchy/Complexity:
1. fuelsys 78
2.. .. engine gas dynamics 5
3. Mixing & Combustion 1
E R Throttle & Manifold
T Throttle 2
6. . . . fuel rate coniroller 72
T Airflow calculation 1
8. Fuel Calculation 11
9 Switchable Compensation 7
1000 LOW Mode 2
1. RICH Mode 2
12,00 Sensor correction and Fault Redundancy 9
13 ... MAP Estimate 2
4. Speed Estimate 2
15 .. ... Throttle Estimate 2
16....... control logic 51
17 ... SE: control logic 50
18 ...l SE: Fail 12
19 ol SF: Multi 6
200l SE: Fueling Mode 19
L SF: Fuel Disabled 4
L. SF: Running 10
Q3L SF: Low_Emissions 4
4 SF:02 5
A5 L. SF: Pressure 5
200 SF: Speed 4
27 . SE: Throttle 5

* The Details sections for each object list the cyclomatic complexity numbers for all
individual objects.
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6. SubSystem block "Throttle & Manifold"

Justify or Exclude

Parent: sldemo_fuelsvs/Engine Gas Dvnamics

Child Systems: Intake Manifold Throttle

Metric Coverage (this object) Coverage (inc. descendants)
Cvclomatic Complexity 0 10

Decizsion NA 73% (8/11) decision outcomes
Execution NA 100% (13/13) objective outcomes
Relational Boundary NA 50% (3/6) objective outcomes
Saturation on wteger overflow NA 50% (8/16) objective outcomes

Decisions Analyzed

The Decisions analyzed table lists possible outcomes for a decision and the number of
times that an outcome occurred in each test simulation. Outcomes that did not occur are
in red highlighted table rows.

The following graphic shows the Decisions analyzed table for the Saturate block in the
Throttle & Manifold subsystem of the Engine Gas Dynamics subsystem in the
sldemo fuelsys example model.
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Saturate block "Limit to Positive"

Justifv or Exclude

Parent: sldemo_fuelsvs Engine Gas Dvnamics/ Throttle & Manifold
Uncovered Links: anp

Metric Coverage

Cvclomatic Complexity 2

Decizion 30% (2/4) decision outcomes
Execution 100% (1/1) ebjective outcomes
Felational Boundary 25% (1/4) objective outcomes

Decisions analvzed

input = lower limit 30%
false D.-"EQ;}S{]B
true 204508/204508

input == upper limit 30%
false 204508/204508

)
true L _1;]:—-!5{]8

To display and highlight the block in question, click the block name at the top of the
section containing the block’s Decisions analyzed table.
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= .Ij e I:] .:'
= ;_,r .

Limit to Positive

Conditions Analyzed

The Conditions analyzed table lists the number of occurrences of true and false conditions
on each input port of the corresponding block.

Conditions analyvzed

Description True || False
input port 1 199521 || 480
input port 2 200001 | 2

MCDC Analysis

The MCDC analysis table lists the MCDC input condition cases represented by the
corresponding block and the extent to which the reported test cases cover the condition

cases.

MC/DC analysis (combinations in parentheses did not occur)

Decision/Condition: E::f Fg:fte
expression for output
input port 1 TT FT
input port 2 TT (TF)

6-27



6 Results Review

6-28

Each row of the MCDC analysis table represents a condition case for a particular input to
the block. A condition case for input n of a block is a combination of input values. Input n
is called the deciding input of the condition case. Changing the value of input n alone
changes the value of the block's output.

The MCDC analysis table shows a condition case expression to represent a condition case.
A condition case expression is a character string where:

* The position of a character in the string corresponds to the input port number.

* The character at the position represents the value of the input. (T means true; F
means false).

* A boldface character corresponds to the value of the deciding input.

For example, FTF represents a condition case for a three-input block where the second
input is the deciding input.

The Decision/Condition column specifies the deciding input for an input condition case.
The True Out column specifies the deciding input value that causes the block to output a
true value for a condition case. The True Out entry uses a condition case expression, for
example, FF, to express the values of all the inputs to the block, with the value of the
deciding variable in bold.

Parentheses around the expression indicate that the specified combination of inputs did
not occur during the first (or only) test case included in this report. In other words, the
test case did not cover the corresponding condition case. The False Out column specifies
the deciding input value that causes the block to output a false value and whether the
value actually occurred during the first (or only) test case included in the report.

Some model elements achieve less MCDC coverage depending on the MCDC definition
used during analysis. For more information on how the MCDC definition used during
analysis affects the coverage results, see “Modified Condition and Decision Coverage
(MCDC) Definitions in Simulink Coverage” on page 5-4.

If you select Treat Simulink Logic blocks as short-circuited in the Coverage pane in
the Configuration Parameters dialog box, MCDC coverage analysis does not verify
whether short-circuited inputs actually occur. The MCDC analysis table uses an x in a
condition expression (for example, TFxxx) to indicate short-circuited inputs that were not
analyzed by the tool.

If you disable this feature and Logic blocks are not short-circuited while collecting model
coverage, you might not be able to achieve 100% coverage for that block.
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Select the Treat Simulink Logic blocks as short-circuited option for where you want
the MCDC coverage analysis to approximate the degree of coverage that your test cases
achieve for the generated code (most high-level languages short-circuit logic
expressions).

Cumulative Coverage

After you record successive coverage results, you can “Access, Manage, and Accumulate
Coverage Results” on page 3-10 from within the Coverage Results Explorer. By default,
the results of each simulation are saved and recorded cumulatively in the report.

If you select Show cumulative progress report in the Coverage Results Settings, the
results located in the right-most area in all tables of the cumulative coverage report
reflect the running total value. The report is organized so that you can easily compare the
additional coverage from the most recent run with the coverage from all prior runs in the
session.

A cumulative coverage report contains information about:

* Current Run — The coverage results of the simulation just completed.

» Delta — Percentage of coverage added to the cumulative coverage achieved with the
simulation just completed. If the previous simulation's cumulative coverage and the
current coverage are nonzero, the delta may be 0 if the new coverage does not add to
the cumulative coverage.

* Cumulative — The total coverage collected for the model up to, and including, the
simulation just completed.

After running three test cases, the Summary report shows how much additional coverage
the third test case achieved and the cumulative coverage achieved for the first two test
cases.
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Summary
Model Hierarchy/Complexity: Current Run Delta Cumulative
Decision Condition MCDC Decision Condition MCDC  Decision Condition MCDC

1. slvnvdemo sutopilot test harmness 31 28% 41% - 17% = 8% m €% 0% 51% - 41% - 17% =
2.... Logic 25 24% 28% mmm 17% m 9% N 8% W 0% 47% - 28% mmm 17% m
3. .. SF: Logic 24 24% mmm 28% mmm 17% = 2% m €% ® 0% 47% - 28% mmm 17% =
4 SF: Altitude 11 €4% — 67% m— 22% . 21% 17% = 0% 92% I 7% 22% =
5 SF: Active 4 38% mmm A NA 12% m NA NA 88% m— A NA
6..........5F.GS 12 1% = 8% W 0% 0% 0% 0% 11% = 8% ® 0%

SF: Active € 0% NA NA 0% NA NA 0% MA NA
8 ............... BF:Coupled 3 0% A NA 0% NA NA 0% A NA
9. ... Merify Outouts 5 ©0% m— 50% m— NA 0% 0% NA 0% — 50% m— N&
10. ... ... Subsystem1 1 0% MA NA 0% NA NA 100% E— MA NA
Mo Capture time 1 0% MA NA 0% NA NA 100% EE— MA NA
12 Subsystem2 1 100% So—— A NA 0% NA NA 100% EEE— A NA
120, Capture time 1 100% EE— MA NA 0% NA NA 100% I MA NA
14....... Subsystem3 1 0% NA NA 0% NA NA 0% MA NA
18 ..., Capture time 1 0% A NA 0% NA NA 0% A NA
16. ... ... Verification 2 100% Do C0% - NA 0% 0% NA 100% oo—— 50% - N&

The Decisions analyzed table for cumulative coverage contains three columns of data
about decision outcomes that represent the current run, the delta since the last run, and
the cumulative data, respectively.

Decisions analyzed:

Transition trigger expression 100% 0% 100%

falze 108710588 || 1097097 | 10971100

true 141095 o057 JA1o0

The Conditions analyzed table uses column headers #n T and #n F to indicate results for
individual test cases. The table uses Tot T and Tot F for the cumulative results. You can
identify the true and false conditions on each input port of the corresponding block for
each test case.
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Conditions analyzed:

- #1 #2 Tot
Description: T #F T #2 F T TotF
Condition 1, "alt_ctrl" 1 1097 | 0 | 1097 | 3 1097
Condition 2, "wow" ] 1 1] ] ] 3

Conditian 3,
“in[G3. Active. Coupled)”

The MCDC analysis #n True Out and #n False Out columns show the condition cases for
each test case. The Total Out T and Total Out F column show the cumulative results.

MC/DC analysis (combinations in parentheses did not occur)

L. iy #1 True #1 False #2 True #2 False Total Out Total Out
Decision/Condition

Out Out Out Out T F
Transition trigger expression
Condition 1, "alt_ctrl” TFF Fxx (TFF) Fxx TFF Fxx
Condition 2, "wow" TFF (TTx) (TFF) (TTx) TFF (TTx)
Condition 3, "in(GS.Active.Coupled)”  TFF (TFT) (TFF) (TFT) TFF (TFT)

Note You can calculate cumulative coverage for reusable subsystems and Stateflow
constructs at the command line. For more information, see “Obtain Cumulative Coverage
for Reusable Subsystems and Stateflow Constructs” on page 8-7.

N-Dimensional Lookup Table
The following interactive chart summarizes the extent to which elements of a lookup table

are accessed. In this example, two Sine Wave blocks generate x and y indices that access
a 2-D Lookup Table block of 10-by-10 elements filled with random values.
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A
Sine Wave 1
p ]
Scope
™

Sine Wave 2

In this model, the lookup table indices are 1, 2,..., 10 in each direction. The Sine Wave 2
block is out of phase with the Sine Wave 1 block by pi/2 radians. This generates x and y
numbers for the edge of a circle, which you see when you examine the resulting Lookup

Table coverage.
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Lookup n-D block "2-D Lookup Table"

Parent: ‘ex mec reports two d lookup table

Uncovered Links:

Ietric Coverage
Cyclomatic Complexity 0
20% (24M121)

Look-up Table interpolation/extrapolation intervals

Look-up Table Details

1o

O 1-20

[ 21-40
u [ 41-60

l...l M &1-380
B =30

The report contains a two-dimensional table representing the elements of the lookup
table. The element indices are represented by the cell border grid lines, which number 10
in each dimension. Areas where the lookup table interpolates between table values are
represented by the cell areas. Areas of extrapolation left of element 1 and right of
element 10 are represented by cells at the edge of the table, which have no outside
border.

The number of values interpolated (or extrapolated) for each cell (execution counts)
during testing is represented by a shade of green assigned to the cell. Each of six levels of
green shading and the range of execution counts represented are displayed on one side of
the table.

If you click an individual table cell, you see a dialog box that displays the index location of
the cell and the exact number of execution counts generated for it during testing. The
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following example shows the contents of a color-shaded cell on the right edge of the

circle.
0 -
1.0 ulnterpolationlntewal (6,9) E\ [=] @
O I 21-40 | Region: Interpalation
= L.-4' 41 - 60 Row: <X <=h
| ] W Gl-0 Column: B=Y<=09
EEN H a0 Execution counts: 51

The selected cell is outlined in red. You can also click the extrapolation cells on the edge

of the table.
0 -
B 1-20 ulnterpulatianlntewal (4,11) EI =] @
[l B 21-40 | Region: Extrapolation/Saturation
= m A1 - B0 Rows: I=H==4
0l O W Ei-E0 Column: Y= 10
|| B a0 Execution counts: 0

A bold grid line indicates that at least one block input equal to its exact index value
occurred during the simulation. Click the border to display the exact number of hits for

that index value.

0
_— B Break Paint #9 e ® (23]
= I 21 -40
Value: =9
™ m 41 - B0
1 l B 51-80
HEEN W o0 Execution counts: 0

The following example model uses an n-D Lookup Table block of 10-by-10-by-5 elements
filled with random values.
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Sine Wave

Sine Wave Scope

/

Ramp

Both the x and y table axes have the indices 1, 2,..., 10. The z axis has the indices 10,
20,..., 50. Lookup table values are accessed with x and y indices that the two Sine Wave
blocks generated, in the preceding example, and a z index that a Ramp block generates.

After simulation, you see the following lookup table report.

Lookup _n-D block "n-D Lookup Table"

Parent: ‘ex mc reports three d lookup table

Uncovered Links:

letric Coverage

Cyclomatic Complexity 0
Lol TAFTIEY

Look-up Table 6% (42/726) _ o
interpolation/extrapolation intervals

Tahkle map was not generated due to the table size
Force Map Generation

Instead of a two-dimensional table, the link Force Map Generation displays the
following tables:
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Look-up Table Details

2 < 10 la 10==ls<=20 l 20<ly<=130 I
[ LTI [ LT
] ||
| [ [T |
N [ ]
|1 H | |1
[ [ ]
([ [ || [
| 11| | [N ||
30 =1z ==40 l= 40 = |z == 50 Iz l= = 50
|
|
|
I
| [T
I

Lookup table coverage for a three-dimensional lookup table block is reported as a set of
two-dimensional tables.

The vertical bars represent the exact z index values: 10, 20, 30, 40, 50. If a vertical bar is
bold, this indicates that at least one block input was equal to the exact index value it
represents during the simulation. Click a bar to get a coverage report for the exact index
value that bar represents.

You can report lookup table coverage for lookup tables of any dimension. Coverage for
four-dimensional tables is reported as sets of three-dimensional sets, like those in the
preceding example. Five-dimensional tables are reported as sets of sets of three-
dimensional sets, and so on.
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Block Reduction

All model coverage reports indicate the status of the Simulink Block reduction
parameter at the beginning of the report. In the following example, you set Force block

reduction off.

Simulation Optimization Options

Default parameter behavior tunable
Block reduction forced off
Conditional branch optimization on

In the next example, you enabled the Simulink Block reduction parameter, and you did
not set Force block reduction off.

Simulation Optimization Options

Default parameter behavior tunable
Block reduction on
Conditional branch optimization on

Consider the following model where the simulation does not execute the MinMax1 block
because there is only one input — In3.

In1

) WM Cutd
InZ
In2 : Owz
Minhax1
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6-38

If you set Force block reduction off, the report contains no coverage data for this block
because the minimum input to the MinMax1 block is always 1.

If you do not set Force block reduction off, the report contains no coverage data for
reduced blocks.

Reduced Blocks

Blocks eliminated from coverage analysis by block reduction
model simulation setting:

gx minmax coverage/Minlax1

Relational Boundary

On the “Coverage Pane” on page 3-2 of the Configuration Parameters dialog box, if you

select the Relational Boundary coverage metric, the software creates a Relational

Boundary table in the model coverage report for each model object that is supported for

this coverage. The table applies to the explicit or implicit relational operation involved in

the model object. For more information, see:

» “Relational Boundary Coverage” on page 1-9.

* The Relational Boundary column in “Model Objects That Receive Coverage” on page
2-2.

The tables below show the relational boundary coverage report for the relation inputl
<= input2. The appearance of the tables depend on the operand data type.

* “Integers” on page 6-38
* “Fixed point” on page 6-39
* “Floating point” on page 6-40

Integers

If both operands are integers (or if one operand is an integer and the other a Boolean),
the table appears as follows.
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Relational Boundary

input] - input2 33%
-1 0/51
0 51/51
+1 0/51

For a relational operation such as operand 1 <= operand 2:

* The first row states the two operands in the form operand 1 - operand 2.

* The second row states the number of times during the simulation that operand 1 -
operand 2 is equal to -1.

* The third row states the number of times during the simulation that operand 1 is
equal to operand 2.

* The fourth row states the number of times during the simulation that operand 1 -
operand 2 isequal to 1.
Fixed point

If one of the operands has fixed-point type and the other operand is either a fixed point or
an integer, the table appears as follows. LSB represents the value of the least significant
bit. For more information, see “Precision” (Fixed-Point Designer). If the two operands
have different precision, the smaller value of precision is used.
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Relational Boundary

input] - input 33%
-LSB 51/51
0 0/51
+LSB 0/51

For a relational operation such as operand 1 <= operand 2:

* The first row states the two operands in the form operand 1 - operand 2.

* The second row states the number of times during the simulation that operand 1 -
operand 2 is equal to -LSB.

* The third row states the number of times during the simulation that operand 1 is
equal to operand 2.

* The fourth row states the number of times during the simulation that operand 1 -
operand 2 is equal to LSB.
Floating point

If one of the operands has floating-point type, the table appears as follows. tol
represents a value computed using the input values and a tolerance that you specify. If
you do not specify a tolerance, the default values are used. For more information, see
“Relational Boundary Coverage” on page 1-9.

Relational Boundary

input] - input2 50%
[-tol 0] 51/51
(0._.tol] 0/51
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For a relational operation such as operand 1 <= operand 2:

* The first row states the two operands in the form operand 1 - operand 2.

* The second row states the number of times during the simulation that operand 1 -
operand 2 has values in the range [ -tol..0].

* The third row states the number of times during the simulation that operand 1 -
operand 2 has values in the range (0. .tol] during the simulation.

The appearance of this table changes according to the relational operator in the block.
Depending on the relational operator, the value of operand 1 - operand 2 equal to 0
is either:

* Excluded from relational boundary coverage.

* Included in the region above the relational boundary.

* Included in the region below the relational boundary.

Relational Operator Report Format Explanation
== [-tol..0) 0 is excluded.
(0..tol]
I= [-tol..0) 0 is excluded.
(0..tol]
<= [-tol..0] 0 is included in the region
(0..tol] below the relational
o boundary.
< [-tol..0) 0 is included in the region
[0..tol] above the relational
- boundary.
>= [-tol..0) 0 is included in the region
[0..tol] above the relational
boundary.
> [-tol..0] 0 is included in the region
(0..tol] below the relational
o boundary.

0 is included below the relational boundary for <= but above the relational boundary for
<. This rule is consistent with decision coverage. For instance:
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» For the relation inputl <= input2, the decision is true if inputl is less than or
equal to input2. < and = are grouped together. Therefore, 0 lies in the region below
the relational boundary.

* For the relation inputl < input2, the decision is true only if inputl is less than
input2. > and = are grouped together. Therefore, 0 lies in the region above the
relational boundary.

Saturate on Integer Overflow Analysis

On the “Coverage Pane” on page 3-2 of the Configuration Parameters dialog box, if you
select the Saturate on integer overflow coverage metric, the software creates a
Saturation on Overflow analyzed table in the model coverage report. The software creates
the table for each block with the Saturate on integer overflow parameter selected.

The Saturation on Overflow analyzed table lists the number of times a block saturates on
integer overflow, indicating a true decision. If the block does not saturate on integer
overflow, the table indicates a false decision. Outcomes that do not occur are in red
highlighted table rows.

The following graphic shows the Saturation on Overflow analyzed table for the MinMax
block in the Mixing & Combustion subsystem of the Engine Gas Dynamics subsystem in
the sldemo fuelsys example model.



Top-Level Model Coverage Report

MinMax block "MinMhax"

Parent: sldemo fuelsys/Engine Gas Dynamics/Mixing & Combustion
Uncovered Links: =

Metric Coverage
Cyclomatic Complexity 0
Saturation on Overflow  50% (1/2) objective outcomes

Saturation on Overflow analyzed:

Saturate on integer overflow 50%
false 204508/204508
true 0/204508

To display and highlight the block in question, click the block name at the top of the
section containing the block’s Saturation on Overflow analyzed table.

Signal Range Analysis

If you select the Signal Range coverage metric, the software creates a Signal Range
Analysis section at the bottom of the model coverage report. This section lists the
maximum and minimum signal values for each output signal in the model measured
during simulation.

Access the Signal Range Analysis report quickly with the Signal Ranges link in the

nonscrolling region at the top of the model coverage report, as shown below in the
sldemo fuelsys example model report.

6-43



6 Results Review

Signal Ranges

Hierarchy Min Max

sldemo_foelsys
..Engine Speed_Selector 300 300
. .MAP Selector 0403559 08809674
.. 02 Voltage Selector 0436832 1
.. Throttle_Angle Selector 10 20
.. Eonstant? 0 0
.. Constant3 12 12
.. Eonstantd 0 0
.. Constants 0 0
.. EGO Fault Switch 1 1
..Engine Speed 300 300
..Engine Speed Fault Switch 1 1
.. MAP Fault Switch 1 1
.. Throttle Angle Fault Switch 1 1

.. Engine Gas Dvnamics
...... Mixing & Combustion
Each block is reported in hierarchical fashion; child blocks appear directly under parent

blocks. Each block name in the Signal Ranges report is a link. For example, select the EGO
sensor link to display this block highlighted in its native diagram.

» 4

EGO Sensor
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Signal Size Coverage for Variable-Dimension Signals

If you select Signal Size, the software creates a Variable Signal Widths section after the
Signal Ranges data in the model coverage report. This section lists the maximum and
minimum signal sizes for all output ports in the model that have variable-size signals. It
also lists the memory that Simulink allocated for that signal, as measured during
simulation. This list does not include signals whose size does not vary during simulation.

The following example shows the Variable Signal Widths section in a coverage report. In
this example, the Abs block signal size varied from 2 to 5, with an allocation of 5.

Variable Signal Widths:

Hierarchy Min Max Allocated

.. Abs 2 g g

.. Abs1 4 4 g

.. MinMax1 2 5 5

.. Bwitch 2 g g

.. Switch1 2 5 ]

.. Selector 4 4 ]

L 2T

...... out 4 5
...... out2 4 4 5

.. Subsystem

...... LogicalOperator 1 2 2
...... Switchi 1 2 2
...... Switch2 1 2 2

Each block is reported in hierarchical fashion; child blocks appear directly under parent
blocks. Each block name in the Variable Signal Widths list is a link. Clicking on the link
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highlights the corresponding block in the Simulink Editor. After the analysis, the variable-
size signals have a wider line design.

Simulink Design Verifier Coverage

If you select Objectives and Constraints, the analysis collects coverage data for all
Simulink Design Verifier blocks in your model.

For an example of how this works, open the sldvdemo debounce testobjblks model.
This model contains two Test Objective blocks:

* The True block defines a property that the signal have a value of 2.

» The Edge block, inside the Masked Objective subsystem, describes the property where
the output of the AND block in the Masked Objective subsystem changes from 2 to 1.

The Simulink Design Verifier software analyzes this model and produces a harness model
that contains test cases that achieve certain test objectives. To see if the original model
achieves those objectives, simulate the harness model and collect model coverage data.
The model coverage tool analyzes any decision points or values within an interval that you
specify in the Test Objective block.

In this example, the coverage report shows that you achieved 100% coverage of the True
block because the signal value was 2 at least once. The signal value was 2 in 6 out of 14
time steps.



Top-Level Model Coverage Report

Design Verifier Test Objective block "True"

Justifv or Exclude

Parent: sldvdemo debounce testobjblks
Uncovered Links: an

Metric Coverage

Test Objective 0% (0/1) objective outcomes

Test Objective analyzed
2 0/1001

The input signal to the Edge block achieved a value of True once out of 14 time steps.
Design Verifier Test Objective block "Edge"

Justifv or Exclude

Parent: sldvdemo_debounce testobiblks/Masked Objective
Uncovered Links: L

Metric Coverage

Test Objective 0% (0/1) objective outcomes

Test Objective analyzed
T 0/1001
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Export Model Coverage Web View
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You can export a Model Coverage Web View for your model. A Web View is an interactive
rendition of a model that you can view in a Web browser. A Model Coverage Web View
includes model coverage highlighting and analysis information from the Coverage Display
Window, as described in “View Coverage Results in a Model” on page 5-12.

Use the Results Explorer to generate a Model Coverage Web View. After you record
coverage, select Analysis > Coverage > Open Results Explorer. In the Results
Explorer, open the Settings, select Generate Web View Report, and click Apply.



Export Model Coverage Web View

i "

Coverage Results: fuelsys EI@

Settings

F] E fuelsys

@ Settings Cumulative Mode
4 |gp Current Cumulative Data Enable collecting cumulative data
|#% Run 1

» [ Data Repository |:| Show cumulative progress report

Htmil Opticns
Show report
Generate Web View Report

Include each test in the model summary

Produce bar graphs in the model summary

Use two color bar graphs {red,blue)

|:| Display hit/count ratio in the model summary

|:| Exclude fully covered model objects from report
Exclude fully covered model object details from report
Include cyclomatic complexity numbers in summary
Include cyclomatic complexity numbers in block details
|:| Filter Stateflow events from report

|:| Filter Execution metric from report

e | N

Next, select the Current Cumulative Data click Generate report.

When you generate a coverage report for your model with these settings enabled, the
software generates a Model Coverage Web View that you can open in a browser. To see
model coverage information for a block in a Model Coverage Web View, click that block.
The model coverage data appears in the Informer pane, below the model.
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For more information, see “Web Views” (Simulink Report Generator).
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Excluding Model Objects from
Coverage

* “Coverage Filtering” on page 7-2

* “Coverage Filter Rules and Files” on page 7-4

* “Model Objects to Filter from Coverage” on page 7-6

* “Create, Edit, and View Coverage Filter Rules” on page 7-7
“Coverage Filter Viewer” on page 7-13
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Coverage Filtering
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In this section...

“When to Use Coverage Filtering” on page 7-2

“What Is Coverage Filtering?” on page 7-2

When to Use Coverage Filtering

Use coverage filtering to facilitate a bottom-up approach to recording model coverage. If
you have a large model, there can be design elements that intentionally do not record
100% coverage. You can also have several design elements that you require to record
100% coverage but that do not achieve 100% coverage. You can temporarily or
permanently eliminate these elements from coverage recording to focus on a subset of
objects for testing and modification.

You can then iterate more efficiently—focus on a small issue, fix it, and then move on to
resolve the next small issue. Before recording coverage for the entire model, you can
resolve missing coverage issues within individual parts of the model.

What Is Coverage Filtering?

Coverage filtering enables you to exclude certain model objects from model coverage
reporting after you simulate your Simulink model. You specify which objects you want to
filter from coverage recording. There are two modes of filtering, Excluded and Justified.

Excluded objects do not contribute to coverage reports. After you specify the objects to
exclude when you simulate your model, the coverage report does not record coverage for
those objects.

Justified objects do contribute to coverage reports. After you specify the objects to justify
when you simulate your model, the coverage report considers these blocks as achieving
100% coverage, and they appear light blue in the “Coverage Summary” on page 6-12.



Coverage Filtering

Summary
Model Hierarchv/Complexity Test 1

D1 Cl MCDC Execution
1. shvnvdemo_covfilt 29 52% . 40% — 30%  — 13% m
2. ... Mode Logic 13 86% 73% m— 50% — NA
3. SE: Mode Logic 12 86%  — 73% — 500,  — NA
4 SE: Clipped 6 100% = NA NA NA
5 S SE: Full 2 25% mm NA NA NA

In the “Details” on page 6-14 section of the coverage report, justified objects show their
coverage outcomes as ((covered outcomes + justified outcomes)/possible decisions).

4. State "Clipped"

Justified (Remove this rule)

Justification rationale: Justification rationale

Parent: slvnvdemo covfilt/Mode Logic
Uncovered Links: ‘e

Metric Coverage (this object) Coverage (inc. descendants)
Cyclomatic Complexity 2 6
Decision (D1) 100% ((2+2)/4) decision outcomes 100% ((5+7)/12) decision outcomes

To filter objects, see “Create, Edit, and View Coverage Filter Rules” on page 7-7 and
“Creating and Using Coverage Filters”.
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Coverage Filter Rules and Files

In this section...

“What Is a Coverage Filter Rule?” on page 7-4

“What Is a Coverage Filter File?” on page 7-4

What Is a Coverage Filter Rule?

A coverage filter rule specifies a model object, a set of objects, or lines of code that you
want to exclude from coverage recording or that you want to justify for coverage.

Each coverage filter rule includes the following fields:

* Name—Name or path of the object to filter from coverage
+ Type—Whether a specific object is filtered or all objects of a given type are filtered
* Mode—Whether the object to be filtered is Excluded or Justified

Coverage reports do not include Excluded blocks. The coverage reports assume that
Justified blocks receive full coverage, but show that they are distinct from other
covered blocks in the coverage report.

* Rationale—An optional description that describes why this object is filtered from
coverage

What Is a Coverage Filter File?

A coverage filter file is a set of coverage filter rules. Each rule specifies one or more
objects or lines of code to exclude from coverage recording.

To apply the coverage filter rules after coverage recording, you create coverage filter
rules or load an existing coverage filter file. After you create the coverage filter rules, the
specified objects or lines of code are excluded from coverage when you generate a report.
You can reuse a coverage filter file for several Simulink models. However, a model can
have only one attached coverage filter file.

When you make changes to the coverage filter rules after you record coverage, you can
update the coverage report without needing to resimulate your model. After you make
changes, click Apply and then Generate Report in the Coverage Filter Viewer to update
the report.




Coverage Filter Rules and Files

If you use the default file name for the active model, and the coverage filter file exists on
the MATLAB path, you see the coverage filter rules each time that you open the model. To
save your current coverage filter rules to a file, click Save filter. To load an existing
coverage filter file, click Load filter
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Model Objects to Filter from Coverage

In your model, the objects that you can filter from coverage recording are:

Simulink blocks that receive coverage, including MATLAB Function blocks

Subsystems and their contents. When you exclude a subsystem from coverage
recording, none of the objects inside the subsystem record coverage.

Individual library-linked blocks or charts
All reference blocks linked to a library
Stateflow charts, subcharts, states, transitions, and events

For a complete list of model objects that receive coverage, see “Model Objects That
Receive Coverage” on page 2-2.



Create, Edit, and View Coverage Filter Rules

Create, Edit, and View Coverage Filter Rules

In this section...

“Create and Edit Coverage Filter Rules” on page 7-7

“Save Coverage Filter to File” on page 7-10

“Load Coverage Filter File” on page 7-11

“Update the Report with the Current Filter Settings” on page 7-11
“View Coverage Filter Rules in Your Model” on page 7-11

Create and Edit Coverage Filter Rules

* “Create a Coverage Filter Rule” on page 7-7

» “Select the Filtering Mode” on page 7-8

* “Add Rationale to a Coverage Filter Rule” on page 7-8

* “Justify Dead Logic from Simulink Design Verifier Dead Logic Analysis” on page 7-9

Create a Coverage Filter Rule

To create a coverage filter rule:

1 In the Coverage pane of the Configuration Parameters dialog box, enable model
coverage.
To record coverage results, simulate the model.

3 Create a new filter rule in one of two ways:

* In the model window, right-click a model object and select Coverage > Exclude.

* In the Details section of the Coverage Report, click Justify or Exclude for a
model object.

Depending on which option you select, the Type field in the “Coverage Filter Viewer” on
page 7-13 is set for the coverage filter rule you selected. You cannot override the value
in the Type field.
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Select the Filtering Mode

When you create a filtering rule, the default filtering mode is Excluded. Excluded objects
do not appear in the coverage reports. You can also set the filtering mode to Justified.
Justified blocks appear as achieving 100% coverage.

For more information, see “Coverage Filtering” on page 7-2.
Add Rationale to a Coverage Filter Rule

Optionally, you can add text that describes why you exclude that object or objects from
coverage recording. This information can be useful to others who review the coverage for
your model. When you add a coverage filter rule, the Coverage Filter Viewer opens. To
add the rationale:

1 Double-click the Rationale field for the rule.

2 Delete the existing text.

3  Add the rationale for excluding this object.

The following graphic shows examples of text in the Rationale field.



Create, Edit, and View Coverage Filter Rules

Coverage Results: sivnvdemo_covfilt

F] E shvnvdemo_covfilt
@ Settings

4 ||gh Current Cumulative D
|# Run 1

4 [ Data Repository
'] Run 1
|5 Run 1

4 M | »

[F=8 =R =5
Coverage Data
Report Filter
Model Code
Name Type Mode Rationale

Saturation by block path Excluded * | never be less than O

Switchable config by subsystem Excluded * | not used config

['om] at shmvdemo_c... by transition Excluded | transition is never false
Wiew im model

Filename: skcov_output\sivivdemo_covfilt\active_filt®
Save filter
Load filter

Generate report
Highlight model with coverage results

Revert

Note The Rationale field and Mode field are the only coverage filter rule fields that you
can edit in the Coverage Filter Viewer.

After you add a new coverage filter rule or edit an existing coverage filter rule, click
Apply to enable the Generate report and Highlight model with coverage results

links.

Justify Dead Logic from Simulink Design Verifier Dead Logic Analysis

You can create justification rules in the Coverage Results Explorer using the dead logic
detected during a Simulink Design Verifier Dead Logic Analysis.
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Open the Coverage Results Explorer from the Simulink menu. Select Analysis >
Coverage > Open Results Explorer.

Click Current Cumulative Data to access the coverage results for the current
simulation and navigate to the Filter tab.

Click Make justification filter rules for dead logic (using Simulink Design
Verifier).

Simulink Design Verifier runs the Dead Logic Analysis and populates the list of filters.
Click Generate report.

The justified rules from the previous step are shown in the Objects Filtered from
Coverage Analysis section at the beginning of the report. To navigate to the rules’
corresponding items in the Details section of the report, use the hyperlinks in the

rule descriptions. Clicking the hyperlinks in the Rationale column navigates to the
Coverage Results Explorer.

Objects Filtered from Coverage Analvsis

# Model Object Rationale

1l. mput port 1 T m Logic block "Or" dead logic

12. mput = lower limat F 1 Saturate block "Saturation” dead logic

You can add justification rules for elements that do not receive coverage to the filter
by clicking == in the Details section of the report.

Save Coverage Filter to File

After you define the coverage filter rules, save the rules to a file so that you can reuse
them with this model or with other models. By default, coverage filter files are named
<model name> covfilter.cvf.

In the Current Cumulative Data section of the Coverage Filter Viewer:

Click Save filter.
Specify a file name and folder for the filter file and click Save.



Create, Edit, and View Coverage Filter Rules

If you make multiple changes to the coverage filter rules, apply the changes to the
coverage filter file each time.

Load Coverage Filter File
After you save a coverage filter file, you can load the coverage filter file for other models.

In the Current Cumulative Data section of the Coverage Filter Viewer:

1 Click Load filter.
2 Navigate to the filter file and click Open.

You can have only one coverage filter file attached to a model at a time. If you attach a
different coverage filter file, the newly attached file replaces the previously attached file.

Two or more models can have the same coverage filter file attached. If a model has an
attached filter file that contains coverage filter rules for specific objects in a different
model, those rules are ignored during coverage recording.

Update the Report with the Current Filter Settings

If you change the filtering settings or add filters after you simulate the model, you can
update the coverage report and model highlighting without resimulating the model. After
you have simulated the model, in the Current Cumulative Data section of the Coverage
Filter Viewer:

1 Apply or Revert any changes you have made.
2  (Click Generate Report.

View Coverage Filter Rules in Your Model

Whenever you define a coverage filter rule or remove an existing coverage filter rule, the
Coverage Filter Viewer opens. This dialog box lists the coverage filter rules for your
model. For more information, see “Coverage Filter Viewer” on page 7-13.

The Coverage Filter Viewer is available in the Current Cumulative Data section of the

Coverage Results viewer. Alternatively, you can right-click anywhere in the model
window and select Coverage > Open Filter Viewer
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If you are inside a subsystem, you can view any coverage filter rule attached to the
subsystem. To open the Coverage Filter Viewer, right-click any object inside the
subsystem and select Coverage > Show filter parent.
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Coverage Filter Viewer

Coverage Filter Viewer

In the Coverage Filter Viewer, you can:

Review and manage the coverage filter rules for your Simulink model.

* Load or save coverage filter files for your model.

Navigate to the model to create additional coverage filter rules.

Cowverage Results: shenvdemo_covfilt

4 E shnvdemo_caovfilt

Coverage Data

@ Settings Filter

=N (B~

|£5 Current Cumulati Madel Code
[ Data Repository

Mode Rationale

Remove rule

View in model

Filename: slcov_outputisivivdemo_covfilt\active_filt
Load filter

Ll 1 | 3

To

Action

a rule.

Navigate to a model object associated with

1 Select the rule.
2 C(Click View in model.
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To

Action

Delete a rule.

1

Select the rule.
Click Remove rule.

Save the current rules to a file.

2
1
2

Click Save filter.

Specify a file name and folder for the
filter file and click Save.

Load an existing coverage filter file.

N =

Click Load filter.

Navigate to the filter file and click
Open.

Update the current coverage report with
the current filtering rules.

Apply or Revert any changes you have
made.

Click Generate Report.




Automating Model Coverage Tasks

* “Create Tests with cvtest” on page 8-2
* “Run Tests with cvsim” on page 8-4
* “Retrieve Coverage Details from Results” on page 8-6

* “Obtain Cumulative Coverage for Reusable Subsystems and Stateflow Constructs”
on page 8-7

* “Create HTML Reports with cvhtml” on page 8-8

» “Save Test Runs to File with cvsave” on page 8-9

* “Load Stored Coverage Test Results with cvload” on page 8-10
* “Use Coverage Commands in a Script” on page 8-11
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Create Tests with cvtest
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The cvtest command creates a test specification object. Once you create the object, you
simulate it with the cvsim command.

The call to cvtest has the following default syntax:
cvto = cvtest(root)

root is the name of, or a handle to, a Simulink model or a subsystem of a model. cvto is
a handle to the resulting test specification object. Only the specified model or subsystem
and its descendants are subject to model coverage.

To create a test object with a specified label (used for reporting results):

cvto = cvtest(root, label)

To create a test with a setup command:

cvto = cvtest(root, label, setupcmd)

You execute the setup command in the base MATLAB workspace, just prior to running the
instrumented simulation. Use this command for loading data prior to a test.

The returned cvtest object, cvto, has the following structure.

Field Description

id Read-only internal data-dictionary ID

modelcov Read-only internal data-dictionary ID

rootPath Name of the system or subsystem for
analysis

label String for reporting results

setupCmd Command executed prior to simulation

settings.condition Set to 1 for condition coverage

settings.decision Set to 1 for decision coverage

settings. Set to 1 for coverage for Simulink Design

designverifier Verifier blocks.

settings.mcdc Set to 1 for MCDC coverage




Create Tests with cvtest

Field Description

settings.overflowsaturation Set to 1 for saturate on integer overflow
coverage

settings.sigrange Set to 1 for signal range coverage

settings.sigsize Set to 1 for signal size coverage.

settings.tableExec Set to 1 for lookup table coverage

modelRefSettings.enable

String specifying one of the following
values:

* Off — Disables coverage for all
referenced models

* all — Enables coverage for all
referenced models

o filtered — Enables coverage for only
referenced models not listed in the
excludedModels subfield

modelRefSettings. Set to 1 for excluding coverage for the top

excludeTopModel model

modelRefSettings. String specifying a comma-separated list of

excludedModels referenced models for which coverage is
disabled when
modelRefSettings.enable specifies
filtered

emlSettings. Set to 1 to enable coverage for external

enableExternal program files called by MATLAB functions
in your model

sfcnSettings. Set to 1 to enable coverage for C/C++ S-

enableSfcn Function blocks in your model.

options. Set to 1 to override the Simulink Block

forceBlockReduction reduction parameter if it is enabled.
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Run Tests with cvsim
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Use the cvsim command to simulate a test specification object.

The call to cvsim has the following default syntax:

cvdo = cvsim(cvto)

This command executes the cvtest object cvto by simulating the corresponding model.
cvsim returns the coverage results in the cvdata object cvdo. When recording coverage
for multiple models in a hierarchy, cvsim returns its results in a cv.cvdatagroup
object.

You can also control the simulation in a cvsim command by setting model parameters for
the Simulink sim command to apply during simulation:

* The following command executes the test object cvto and simulates the model using
the default model parameters. The cvsim function returns the coverage results in the
cvdata object cvdo and returns the simulation outputs in a
Simulink.SimulationOutput object simOut:

[cvdo,simOut] = cvsim(cvto)

» The following commands create a structure, paramStruct, that specifies the model
parameters to use during the simulation. The first command specifies that the
simulation collect decision, condition, and MCDC coverage for this model.

paramStruct.CovMetricSettings = 'dcm';
paramStruct.SimulationMode = 'rapid’;
paramStruct.AbsTol = 'le-5"';
paramStruct.SaveState = 'on';
paramStruct.StateSaveName = 'xoutNew';
paramStruct.SaveOutput = 'on';
paramStruct.OutputSaveName = 'youtNew';

Note For a complete list of model parameters, see “Model Parameters” (Simulink).

The following cvsim command executes the test object cvto and simulates the model
using the model parameter values specified in paramStruct:

[cvdo,simOut] = cvsim(cvto,paramStruct);



Run Tests with cvsim

You can also execute multiple test objects with the cvsim command. The following
command executes a set of coverage test objects, cvtol, cvto2, ... using the default
simulation parameters. cvsim returns the coverage results in a set of cvdata objects,
cvdol, cvdo2, . and returns the simulation outputs in simOut.

[cvdol, cvdo2, ., simOut] = cvsim(cvtol, cvto2, ...)
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Retrieve Coverage Details from Results
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Simulink Coverage provides commands that allow you to retrieve specific coverage
information from the cvdata object after you have simulated your model and recorded
coverage. Use these commands to retrieve the specified coverage information for a block,
subsystem, or Stateflow chart in your model or for the model itself:

» complexityinfo — Cyclomatic complexity coverage

+ executioninfo — Execution coverage

+ conditioninfo — Condition coverage

* decisioninfo — Decision coverage

* mcdcinfo — Modified condition/decision (MCDC) coverage

* overflowsaturationinfo — Saturate on integer overflow coverage

* relationalboundaryinfo — Relational boundary coverage

* sigrangeinfo — Signal range coverage

* sigsizeinfo — Signal size coverage

* tableinfo — Lookup Table block coverage

+ getCoverageinfo — Coverage for Simulink Design Verifier blocks

The basic syntax of these functions is:

coverage = <coverage type prefix>info(cvdo,
object, ignore descendants)
* coverage — Multipart vector containing the retrieved coverage results for object
* cvdo — cvdata object created when coverage is recorded
* object — Handle to a model or object in the model

* ignore descendants — Logical value that specifies whether to ignore the coverage
of descendant objects



Obtain Cumulative Coverage for Reusable Subsystems and Stateflow Constructs

Obtain Cumulative Coverage for Reusable Subsystems
and Stateflow Constructs

“Obtain Cumulative Coverage for Reusable Subsystems and Stateflow® Constructs” on
page 5-27
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Create HTML Reports with cvhtml

8-8

Once you run a test in simulation with cvsim, results are saved to cv.cvdatagroup or
cvdata objects in the base MATLAB workspace. Use the cvhtml command to create an
HTML report of these objects.

The following command creates an HTML report of the coverage results in the cvdata
object cvdo. The results are written to the file file in the current MATLAB folder.

cvhtml(file, cvdo)
The following command creates a combined report of several cvdata objects:

cvhtml(file, cvdol, cvdo2, ...)

The results from each object are displayed in a separate column of the HTML report.
Each cvdata object must correspond to the same root model or subsystem, or the
function produces errors.
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Save Test Runs to File with cvsave

Once you run a test with cvsim, save its coverage tests and results to a file with the
cvsave function:

cvsave(filename, model)
Save all the tests and results related to model in the text file filename. cvt:

cvsave(filename, cvtol, cvto2, ...)

Save the tests in the text file filename. cvt. Information about the referenced models is
also saved.

You can save specified cvdata objects to file. The following example saves the tests, test
results, and referenced models' structure in cvdata objects to the text file
filename.cvt:

cvsave(filename, cvdol, cvdo2, ...)

8-9
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Load Stored Coverage Test Results with cvioad

8-10

The cvload command loads into memory the coverage tests and results stored in a file by
the cvsave command. The following example loads the tests and data stored in the text
file filename.cvt:

[cvtos, cvdos] = cvload(filename)

The cvtest objects that are loaded are returned in cvtos, a cell array of cvtest
objects. The cvdata objects that are loaded are returned in cvdos, a cell array of
cvdata objects. cvdos has the same size as cvtos, but can contain empty elements if a
particular test has no results.

In the following example, if restoretotal is 1, the cumulative results from prior runs
are restored:

[cvtos, cvdos] = cvload(filename, restoretotal)

If restoretotal is unspecified or 0, the model's cumulative results are cleared.

cvload Special Considerations

When using the cvload command, be aware of the following considerations:

* When a model with the same name exists in the coverage database, only the
compatible results are loaded from the file. They reference the existing model to
prevent duplication.

*  When the Simulink models referenced in the file are open but do not exist in the
coverage database, the coverage tool resolves the links to the models that are already
open.

* When you are loading several files that reference the same model, only the results that
are consistent with the earlier files are loaded.
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Use Coverage Commands in a Script

The following script demonstrates some common model coverage commands.
This script:

* Creates two data files to load before simulation.

* Creates two cvtest objects, testObjl and testObj2, and simulates them using the
default model parameters. Each cvtest object uses the setupCmd property to load a
data file before simulation.

* Enables decision, condition, and MCDC coverage.
* Retrieves the decision coverage results for the Adjustable Rate Limited subsystem.

» Uses cvhtml to display the coverage results for the two tests and the cumulative
coverage.

* Compute cumulative coverage with the + operator and save the results

mdl = 'slvnvdemo ratelim harness';
mdl_subsys = 'slvnvdemo ratelim harness/Adjustable Rate Limiter';

open_system(mdl);
open_system(mdl_subsys);

t gain = (0:0.02:2.0)'; u_gain = sin(2*pi*t_gain);

t_pos = [0;2]; u_pos = [1;1]; t_neg = [0;2]; u_neg = [-1;-1];
save('within lim.mat','t gain','u gain','t pos','u pos', ...
't_neg', 'u_neg');

t gain = [0;2]; u_gain = [0;4]; t pos = [0;1;1;2];

u pos = [1;1;5;5]*0.02; t neg = [0;2]; u neg = [0;0];

save('rising gain.mat','t gain','u gain','t pos','u pos', ...
't neg', 'uneg');

testObjl cvtest(mdl subsys);
testObjl.label 'Gain within slew limits';
testObjl.setupCmd 'load(''within_ lim.mat'');"';
testObjl.settings.mcdc = 1;
testObjl.settings.condition = 1;
testObjl.settings.decision = 1;

testObj2 = cvtest(mdl subsys);

testObj2.label = 'Rising gain that temporarily exceeds slew limit';
testObj2.setupCmd = 'load(''rising gain.mat'');"';
testObj2.settings.mcdc = 1;

testObj2.settings.condition = 1;

testObj2.settings.decision = 1;

[dataObjl,simOutl] = cvsim(testObjl);

decision _covl = decisioninfo(dataObjl,mdl subsys);
percent covl = 100 * decision cov1l(1l) / decision_cov1(2)
cc_cov2 = complexityinfo(dataObjl, mdl subsys);

[dataObj2,simOut2] = cvsim(testObj2,[0 2]);
decision cov2 = decisioninfo(dataObj2,mdl subsys);
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percent cov2 = 100 * decision cov2(1l) / decision_cov2(2)
cc_cov2 = complexityinfo(dataObjl, mdl subsys);

cvhtml('ratelim report',dataObjl,dataObj2);
cumulative = dataObjl+dataObj2;

cvsave('ratelim testdata',cumulative);

close _system('slvnvdemo_ratelim_harness',0);

8-12
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Component Verification

9-2

In this section...

“Simulink Coverage Tools for Component Verification” on page 9-2
“Workflow for Component Verification” on page 9-3

“Verify a Component Independently of the Container Model” on page 9-4
“Verify a Model Block in the Context of the Container Model” on page 9-5

Using component verification, you can test a design component in your model with one of
these approaches:

* System analysis. Within the context of the model that contains the component, you use
systematic simulation of closed-loop controllers to verify components within a control
system model. You can then test the control algorithms with your model.

* Component analysis. As standalone components, for a high level of confidence in the
component algorithm, verify the component in isolation from the rest of the system.

Verifying standalone components provides several advantages:

* You can use the analysis to focus on portions of the design that you cannot test
because of the physical limitations of the system being controlled.

* For open-loop simulations, you can test the plant model without feedback control.

* You can use this approach when the model is not yet available or when you need to
simulate a control system model in accelerated mode for performance reasons.

Simulink Coverage Tools for Component Verification

By isolating a component to verify and by using tools that the Simulink Coverage software
provides, you create test cases to expand the scope of the testing for large models. You
can:

* Achieve 100% model coverage — If certain model components do not record 100%
coverage, the top-level model cannot achieve 100% coverage. By verifying these
components individually, you can create test cases that fully specify the component
interface, allowing the component to record 100% coverage.

* Debug the component — To verify that each model component satisfies the specified
design requirements, you can create test cases that verify that specific components
perform as they were designed to perform.




Component Verification

» Test the robustness of the component — To verify that a component handles
unexpected inputs and calculations properly, you can create test cases that generate
data. Then, test the error-handling capabilities in the component.

Workflow for Component Verification

This graphic illustrates two approaches for component verification.
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Log fie signals
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™
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Simulate component,
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SIL or PIL mode
1

Unit testing
of code

1 Choose your approach for component verification:

* For closed-loop simulations, verify a component within the context of its container
model by logging the signals to that component and storing them in a data file. If
those signals do not constitute a complete test suite, generate a harness model
and add or modify the test cases in the Signal Builder.

» For open-loop simulations, verify a component independently of the container
model by extracting the component from its container model and creating a
harness model for the extracted component. Add or modify test cases in the Signal
Builder and log the signals to the component in the harness model.
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Prepare component for verification.

Create and log test cases. You can also merge the test case data into a single data
file.

The data file contains the test case data for simulating the component. If you cannot
achieve the expected results with a certain set of test cases, add new test cases or
modify existing test cases in the data file. Merge the test cases into a single data file.

Continue adding or modifying test cases until you achieve a test suite that satisfies
your analysis goals.

Execute the test cases in software-in-the-loop or processor-in-the-loop mode.
5 After you have a complete test suite, you can:

« Simulate the model and execute the test cases to:

* Record coverage.
* Record output values to make sure that you get the expected results.

* Invoke the Code Generation Verification (CGV) API to execute the generated code
for the model that contains the component in simulation, software-in-the-loop
(SIL), or processor-in-the-loop (PIL) mode.

Note To execute a model in different modes of execution, you use the CGV API to
verify the numerical equivalence of results. See “Programmatic Code Generation
Verification” (Embedded Coder).

Verify a Component Independently of the Container Model

Use component analysis to verify:

Model blocks
Atomic subsystems

Stateflow atomic subcharts

=

Depending on the type of component, take one of the following actions:

* Model blocks — Open the referenced model.

* Atomic subsystems — Extract the contents of the subsystem into its own Simulink
model.
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e Atomic subcharts — Extract the contents of the Stateflow atomic subchart into its
own Simulink model.

Create a harness model for:

¢ The referenced model

* The extracted model that contains the contents of the atomic subsystem or atomic
subchart

Add or modify test cases in the Signal Builder of the harness model.
Log the input signals from the Signal Builder to the test unit.
Repeat steps 3 and 4 until you are satisfied with the test suite.
Merge the test case data into a single file.

Depending on your goals, take one of these actions:

¢ Execute the test cases to:

* Record coverage.
* Record output values and make sure that they equal the expected values.

* Invoke the Code Generation Verification (CGV) API to execute the test cases in
software-in-the-loop (SIL) or processor-in-the-loop (PIL) mode on the generated
code for the model that contains the component.

If the test cases do not achieve the expected results, repeat steps 3 through 5.

Verify a Model Block in the Context of the Container Model

Use system analysis to:

1

Verify a Model block in the context of the block’s container model.
Analyze a closed-loop controller.

Log the input signals to the component by simulating the container model or analyze
the model by using the Simulink Design Verifier software.

If you want to add test cases to your test suite or modify existing test cases, create a
harness model with the logged signals.

Add or modify test cases in the Signal Builder in the harness model.
Log the input signals from the Signal Builder to the test unit.
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5 Repeat steps 3 and 4 until you are satisfied with the test suite.
Merge the test case data into a single file.
Depending on your goals, do one of the following:

* Execute the test cases to:

* Record coverage.
* Record output values and make sure that they equal the expected values.

* Invoke the Code Generation Verification (CGV) API to execute the test cases in
software-in-the-loop (SIL) or processor-in-the-loop (PIL) mode on the generated
code for the model.

If the test cases do not achieve the expected results, repeat steps 3 through 5.
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* “Test Model Against Requirements and Report Results” on page 10-2

* “Analyze a Model for Standards Compliance and Design Errors” on page 10-8
* “Perform Functional Testing and Analyze Test Coverage” on page 10-11

* “Analyze Code and Test Software-in-the-Loop” on page 10-15
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Test Model Against Requirements and Report Results

Requirements - Test Traceability Overview

Traceability between requirements and test cases helps you interpret test results and see
the extent to which your requirements are verified. You can link a requirement to
elements that help verify it, such as test cases in the Test Manager, verify statements in
a Test Sequence block, or Model Verification blocks in a model. When you run tests, a
pass/fail summary appears in your requirements set.

This example demonstrates a common requirements-based testing workflow for a cruise
control model. You start with a requirements set, a model, and a test case. You add
traceability between the tests and the safety requirements. You run the test, summarize
the verification status, and report the results.

Functional
requirements

System
requirements

- lpdate requirements

|

|

| bezmmm s Traceability ----
| | |
i Traceability i
i i i
| | |

Develop Develop
Develop test
specification / = detailed = casEs L= Run tests | Report results
architecture model

f

Refine

In this example, you conduct a simple test of two requirements in the set:

» That the cruise control system transitions to disengaged from engaged when a braking
event has occurred

» That the cruise control system transitions to disengaged from engaged when the
current vehicle speed is outside the range of 20 mph to 90 mph.

10-2



Test Model Against Requirements and Report Results

Display the Requirements and Test Case

1

Create a copy of the project in a working folder. The project contains data,
documents, models, and tests. Enter:

path = fullfile(matlabroot, 'toolbox', 'shared', 'examples’,...
'verification', 'src', 'cruise')

run(fullfile(path, 'slVerificationCruiseStart'))

In the project models folder, open the simulinkCruiseAddReqgExample.slx
model.

Display the requirements. Click the u= icon in the lower-right corner of the model
canvas, and select Requirements. The requirements appear below the model
canvas.

Expand the requirements information to include verification and implementation
status. Right-click a requirement and select Verification Status and
Implementation Status.
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5 Open the Simulink Test file sTReqTests.mldatx from the tests folder. The test file
opens in the Test Manager.

Link Requirements to Tests

Link the requirements to the test case.

1 In the Requirements Browser, select requirement S 3. 1.

2 In the Test Manager, expand the test file and select the Safety Tests test case.
Expand the Requirements section.

3 In the Requirements section, select Add > Link to Selected Requirement.

The requirements browser displays the verification-type link.
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v 5] 3
B 31
=l 3.2
E 33

=l 34

4

Safety Requirements Safety Requirements B = Verified by:
531 Vehicle braking disengages system = Safety Tests
53.2 System engagement speed limitations
533 Target speed limitations
534 Speed outside limits disengages system N

» Comments

v

Also add a link foritem S 3.4.

Run the Test

1

The test case uses a test harness SafetyTest Harnessl. In the test harness, a test
sequence sets the input conditions and checks the model behavior:

* The BrakeTest sequence engages the cruise control, then applies the brake. It
includes the verify statement

verify(engaged == false,...
'verify:brake', ...
'system must disengage when brake applied')
+ The LimitTest sequence engages the cruise control, then ramps up the vehicle
speed until it exceeds the upper limit. It includes the verify statement.

verify(engaged == false,...
'verify:limit', ...
'system must disengage when limit exceeded')
Run the test case. In the Test Manager toolstrip, click Run.

When the test finishes, expand the Verify Statements results. The Test Manager
results show that both assessments pass, and the plot shows the detailed results of
each verify statement.
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4 In the Requirements Browser, right-click a requirement and select Refresh
Verification Status to show the passing test results for each requirement.
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Report the Results
1 Create a report using a custom Microsoft Word template.

a From the Test Manager results, right-click the test case name. Select Create
Report.
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See Also

b In the Create Test Result Report dialog box, set the options:

o Title — SafetyTest

* Results for — ALl Tests

* File Format — DOCX

* For the other options, keep the default selections.

¢ For the Template File, select the ReportTemplate.dotx file in the
documents project folder.

d Enter a file name and select a location for the report.
e C(lick Create.
2  Review the report.
a In the Test Case Requirements section, click the link to trace to the
requirements document.

b  The Verify Result section contains details of the two assessments in the test,
and links to the simulation output.

Name ' Data Type  Units ~ sample Time  © Interp syne | et
Sequencel_.Merifyverify(engaged == SiTesiResult i | zch | union , Link
false) 1 1 1 ' | |

_____________________________ L | A
@ Test : : : : : . .
Sequencel_..NVerifyHigh:verify(engagea | SITesiResult ! ! zeh | union ¢ Link
== false) | | | . | :

Related Examples

. “Link to Requirements” (Simulink Test)

. “Validate Requirements Links in a Model” (Simulink Requirements)

. “Customize Requirements Traceability Report for Model” (Simulink Requirements)
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Analyze a Model for Standards Compliance and Design
Errors

Standards and Analysis Overview

During model development, check and analyze your model to increase confidence in its
quality. Check your model against standards such as MAAB style guidelines and high-
integrity system design guidelines such as DO-178 and ISO 26262. Analyze your model
for errors, dead logic, and conditions that violate required properties. Using the analysis
results, update your model and document exceptions. Report the results using
customizable templates.

standards |
1
I
““--—._.——ﬁ ;
| I
| I
I
i
I
* Model analysis: check
Develop detailed N Add lpropfarty N standards, check for_d.eslgn Y—»| Report results
model specifications errors, check specified
properties
F Y N
Resolve errorsand | Replicate errors
confirm exceptions | Analyze dependencies

Check Model for Style Guideline Violations and Design Errors

This example shows how to use the Model Advisor to check a cruise control model for
MathWorks® Automotive Advisory Board (MAAB) style guideline violations and design
errors. Select checks and run the analysis on the model. Iteratively debug issues using
the Model Advisor and rerun checks to verify that it is in compliance. After passing your
selected checks, report results.
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Check Model for MAAB Style Guideline Violations

In Model Advisor, you can check that your model complies with MAAB modeling
guidelines.

1 Create a copy of the project in a working folder. On the command line, enter

path = fullfile(matlabroot, 'toolbox', 'shared', 'examples’',...
‘verification', 'src', 'cruise')
run(fullfile(path, 'slVerificationCruiseStart'))

2  Open the model. On the command line, enter

open_system simulinkCruiseErrorAndStandardsExample
3 In the model window, select Analysis > Model Advisor > Model Advisor.

Click OK to choose simulinkCruiseErrorAndStandardsExample from the
System Hierarchy.

5 Check your model for MAAB style guideline violations using Simulink Check.

In the left pane, in the By Product > Simulink Check > Modeling Standards
> MathWorks Automotive Advisory Board Checks folder, select:

* Check for indexing in blocks

* Check for prohibited blocks in discrete controllers

* Check model diagnostic parameters

Right-click the MathWorks Automotive Advisory Board Checks node, and
then select Run Selected Checks.

Click Check model diagnostic parameters to review the configuration
parameter settings that violate MAAB style guidelines.

In the right pane, click the parameter links to update the values in the
Configuration Parameters dialog box.

To verify that your model passes, rerun the check. Repeat steps ¢ and d, if
necessary, to reach compliance.

To generate a results report of the Simulink Check checks, select the
MathWorks Automotive Advisory Board Checks node, and then, in the right
pane click Generate Report....
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Check Model for Design Errors

While in Model Advisor, you can also check your model for hidden design errors using
Simulink Design Verifier.

1 In the left pane, in the By Product > Simulink Design Verifier folder, select
Design Error Detection.
In the right pane, click Run Selected Checks.

After the analysis is complete, expand the Design Error Detection folder, then
select checks to review warnings or errors.

4 In the right pane, click Simulink Design Verifier Results Summary. The dialog
box provides tools to help you diagnose errors and warnings in your model.

a Review the results on the model. Click Highlight analysis results on model.
Click the Compute target speed subsystem, outlined in red. The Simulink
Design Verifier Results Inspector window provides derived ranges that can help
you understand the source of an error by identifying the possible signal values.

b  Review the harness model. The Simulink Design Verifier Results Inspector
window displays information that an overflow error occurred. To see the test
cases that demonstrate the errors, click View test case.

¢ Review the analysis report. In the Simulink Design Verifier Results Inspector
window, click Back to summary. To see a detailed analysis report, click HTML
or PDF.

See Also

Related Examples

. “Check Model Compliance by Using the Model Advisor” (Simulink Check)
. “Collect Model Metrics Using the Model Advisor” (Simulink Check)

. “Run a Design Error Detection Analysis” (Simulink Design Verifier)

. “Prove Properties in a Model” (Simulink Design Verifier)
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Perform Functional Testing and Analyze Test Coverage

Functional testing begins with building test cases based on requirements. These tests can
cover key aspects of your design and verify that individual model components meet
requirements. Test cases include inputs, expected outputs, and acceptance criteria.

By collecting individual test cases within test suites, you can run functional tests
systematically. To check for regression, add baseline criteria to the test cases and test the
model iteratively. Coverage measurement reflects the extent to which these tests have
fully exercised the model. Coverage measurement also helps you to add tests and
requirements to meet coverage targets.

Functional reguirements

Create test inputs or Add run-time

import external test data verifications
Run tests ] Collect » Report
coverage results
Add expected outputs ry

Set coverage criteria

h 4

and acceptance criteria
N

v

Analyze dependencies
Refine model

Add tests
Refine requirements

Incrementally Increase Test Coverage Using Test Case
Generation

This example shows a functional testing-based testing workflow for a cruise control
model. You start with a model that has tests linked to an external requirements document,
analyze the model for coverage in Simulink Coverage, incrementally increase coverage
with Simulink Design Verifier, and report the results.
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Explore the Test Harness and the Model

1

Create a copy of the project in a working folder. At the command line, enter:

path = fullfile(matlabroot, 'toolbox', 'shared', 'examples’,...
'verification', 'src', 'cruise')

run(fullfile(path, 'slVerificationCruiseStart'))

Open the model and the test harness. At the command line, enter:

open_system simulinkCruiseAddReqExample
sltest.harness.open('simulinkCruiseAddReqExample', 'SafetyTest Harnessl')
Load the test suite from “Test Model Against Requirements and Report Results”
(Simulink Test). At the command line, enter:

sltest.testmanager.load('slReqTests.mldatx")
sltest.testmanager.view

Open the test sequence block. The sequence tests:

* That the system disengages when the brake pedal is pressed
» That the system disengages when the speed exceeds a limit

Some test sequence steps are linked to a requirements document
simulinkCruiseChartReqs.docx.

Measure Model Coverage

1

In the Test Manager, enable coverage collection for the test case.

Open the Test Manager. In the Simulink menu, click Analysis > Test Manager.
In the Test Browser, click the s1TReqTests test file.
Expand Coverage Settings.

e N T 9

Under Coverage to Collect, select Record coverage for referenced models.

You specify a coverage filter to use for coverage analysis by using the Coverage
filter filename field. The default setting honors the model configuration
parameter settings. Leaving the Coverage filter filename field empty attaches
no coverage filter.

e Under Coverage Metrics, select Decision, Condition, and MCDC.



Perform Functional Testing and Analyze Test Coverage

wWN

~ COVERAGE SETTINGS*

~ COVERAGE TO COLLECT
Record coverage for system under test

+ | Record coverage for referenced models

Coverage filter filename: | [Model Settings] [ ]

COVERAGE METRICS

+'| Decision +'| Condition
| MCDC Lookup Table
Signal Range Signal Size
Simulink Design Verifier Saturation on integer overflow

Relational Boundary

Run the test. On the Test Manager toolstrip, click Run.

When the test finishes, in the Test Manager, navigate to the test case. The aggregated
coverage results show that the example model achieves 50% decision coverage, 41%
condition coverage, and 25% MCDC coverage.
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> AGGREGATED COVERAGE RESULTS

ANALYZED MODEL REFORT CO.. DECISION CONDITION MCDC +
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1-6
Add Tests for Missing Coverage Export

Generate Tests to Increase Model Coverage

1 Use Simulink Design Verifier to generate additional tests to increase model coverage.
Select the test case in the Results and Artifacts and open the aggregated coverage
results section.

2 Select the test results from the previous section and then click Add Tests for
Missing Coverage.

The Add Tests for Missing Coverage options open.

3 Under Harness, choose Create a new harness.

4 Click OK to add tests to the test suite using Simulink Design Verifier.

5 Run the updated test suite. On the Test Manager toolstrip, click Run. The test results
include coverage for the combined test case inputs, achieving increased model
coverage.

See Also

Related Examples

. “Link to Requirements” (Simulink Test)

. “Assess Model Simulation Using verify Statements” (Simulink Test)

. “Compare Model Output To Baseline Data” (Simulink Test)

. “Generate Test Cases for Model Decision Coverage” (Simulink Design Verifier)
. “Increase Test Coverage for a Model” (Simulink Test)
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Analyze Code and Test Software-in-the-Loop

Code Analysis and Testing Software-in-the-Loop Overview

Analyze code to detect errors, check standards compliance, and evaluate key metrics
such as length and cyclomatic complexity. Typically for handwritten code, you check for
run-time errors with static code analysis and run test cases that evaluate the code against
requirements and evaluate code coverage. Based on the results, refine the code and add
tests. For generated code, demonstrate that code execution produces equivalent results
to the model by using the same test cases and baseline results. Compare the code
coverage to the model coverage. Based on test results, add tests and modify the model to
regenerate code.

Detailed model /

- s Add tests /
-------- Traceability-------- ™
Requirements ity Refine model
T
\-_/{_4__\ :
Traceability i
N 1
' 1
| 1

Develop or
generate code

Code analysis
Error detection
Code metrics

| Verify results / - Analyze N Report
» : » »
equivalence coverage results

Run tests

h 4
h 4

h

A J

Analyze Code for Defects, Metrics, and MISRA C:2012

This workflow describes how to check if your model produces MISRA® C:2012 compliant
code and how to check your generated code for code metrics, code defects, and MISRA
compliance. To produce more MISRA compliant code from your model, you use the code
generation and Model Advisor. To check whether the code is MISRA compliant, you use
the Polyspace MISRA C:2012 checker and report generation capabilities. For this
example, you use the model simulinkCruiseErrorAndStandardsExample. To open
the model:

1  Open the project.
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10 Verification and Validation

path = fullfile(matlabroot, 'toolbox', 'shared', 'examples’,...

'verification', 'src', 'cruise')

run(fullfile(path, 'slVerificationCruiseStart'))
2 From the project, open the model simulinkCruiseErrorAndStandardsExample.

engaged

/(;uiseOnOff \
Brake Stiasdes -£ engaged
- (EJ
CoastSetSw
Epea —E tspeed

AccelResSw

(1) - P
-E CruiseOnOff

CruiseOnOff

@ —£ Brake "

Brake

@ —£ Speed >

Speed

@ —£ CoastSetSw A
CoastSetSw

@ —E AccelResSw >

AccelResSw

Run Code Generator Checks

<

Compute target speed

tspeed

Before you generate code from your model, there are steps that you can take to generate
code more compliant with MISRA C and more compatible with Polyspace. This example
shows how to use the Code Generation Advisor to check your model before generating

code.

1 Right-click Compute target speed and select C/C++ > Code Generation Advisor.

2 Select the Code Generation Advisor folder. Add the Polyspace objective. The MISRA
C:2012 guidelines objective is already selected.
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Analyze Code and Test Software-in-the-Loop

Code Generation Objectives (System target file: ert.tic)

Available objectives Selected objectives - prioritized

Execution efficiency MISRA C:2012 guidelines
ROM efficiency Polyspace

RAM efficiency
Traceability
Safety precaution
Debugging

+

5

Click Run Selected Checks.

The Code Generation Advisor checks whether there are any blocks or configuration
settings that are not recommended for MISRA C:2012 compliance and Polyspace
code analysis. For this mode, the check for incompatible blocks passes, but there are
some configuration settings that are incompatible with MISRA compliance and
Polyspace checking.

v [C@ Code Generation Advisor
& Check model configuration settings against code generation objectives
o Check for blocks not recommended for MISRA C:2012

Click on check that was not passed. Accept the parameter changes by selecting
Modify Parameters.

Rerun the check by selecting Run This Check.

Run Model Advisor Checks

Before you generate code from your model, there are steps you can take to generate code
more compliant with MISRA C and more compatible with Polyspace. This example shows
you how to use the Model Advisor to check your model further before generating code.

For more checking before generating code, you can also run the Modeling Guidelines for
MISRA C:2012.

I+

+
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10 Verification and Validation

At the bottom of the Code Generation Advisor window, select Model Advisor.

Under the By Task folder, select the Modeling Guidelines for MISRA C:2012
advisor checks.

»  Model Advisor
[] I3 By Product
v [m] =) By Task

[m] [C5) Code Generation Efficiency

[] =3 Data Transfer Efficiency

[ ] 53 Frequency Response Estimation

[m] =) Managing Data Store Memory Blocks

[C=1 Managing Library Links And Variants

[] 53 Migrating to Simplified Initialization mode

[m] 55 Model Metrics

[m] =) Model Referencing

W [C=1 Modeling Guidelines for MISRA C:2012

=] Check configuration parameters for MISRA C:2012
=] Check for blocks not recommended for MISRA C:2012
:=| Check for unsupported block names
=] Check usage of Assignment blocks
=] “Check for bitwise operations on signed integers
(=] “Check for recursive function calls
=] “~Check for equality and ineguality operations on floating-point
=] “Check for switch case expressions without a default case

3 Click Run Selected Checks and review the results.

4 If any of the tasks fail, make the suggested modifications and rerun the checks until
the MISRA modeling guidelines pass.

Generate and Analyze Code

After you have done the model compliance checking, you can now generate code. With
Polyspace, you can check your code for compliance with MISRA C:2012 and generate
reports to demonstrate compliance with MISRA C:2012.

1 In the Simulink editor, right-click Compute target speed and select C/C++ > Build
This Subsystem.

2 Use the default settings for the tunable parameters and select Build.
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3  After the code is generated, right-click Compute target speed and select Polyspace >

Options.

"
@

* Commeonly Used Parameters

Select:
Solver
Data Import/Export
Optimization
Diagnostics
Hardware Implementation
Model Referencing
Simulation Target
Code Generation
Coverage
Design Verifier
Polyspace

Configuration Parameters: simulinkCruiseErrorAndStandardsExample/ModelReferencing (Active)

= All Parameters

Polyspace options (for Embedded Coder generated code)
Polyspace
Product mode: | Bug Finder
Settings from: | Project configuration and MISRA C 2012 checking for generated code
[ use custom project file
Praject configuration: Configure
[] Enable additional file list  Select files
[[] stub lookup tables
Data Range Management
Input: Use spedified minimum and maximum values
Tunable parameters: | Use calibration data
Model reference
Model reference verification depth: | Current model only

Model by model verification

Output

Browse for project file

Output folder: ‘ results_$ModelName$

[1 Make output folder name unigue by adding a suffix
[[] Add results to current Simulink Project

Results review
Open results automatically after verification
Configuration checking

Check configuration before verification: |On (proceed with warnings)

OK

~ Check configuration

Cancel Help Apply

4  Click the Configure (Polyspace Bug Finder) button. This option allows you to choose
more advanced Polyspace analysis options in the Polyspace configuration window.
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10 Verification and Validation

W Polyspace Bug Finder
File Edit Tools Window Help

&l “]Q|

simulinkCruis...Example_config =

=-Target & Compiler
Macros
- Environment Settings
----- Inputs & Stubbing
----- Multitasking
----- Bug Finder Analysis
----- Main Generator
----- Reporting
----- Distributed Computing
----- Advanced Settings

Coding Rules & Code Metrics

Coding Rules

[] Check MISRA C:2004 | required-rules
[] Check MISRA AC AGC| OBL-rules
[] Check MISRA C:2012 | mandatory-required

[] Check custom rules

Code Metrics

Edit
Edit
Edit

Edit

Calculate Code Metrics

5 On the same pane, select Calculate Code Metrics. This option turns on code metric
calculations for your generated code.

Save and close the Polyspace configuration window.
From your model, right-click Compute target speed and select Polyspace > Verify

Code Generated For > Selected Subsystem.

Polyspace Bug Finder analyzes the generated code for a subset of MISRA checks and

defect checks. You can see the progress of the analysis in the MATLAB Command
Window. Once the analysis is finished, the Polyspace environment opens.

Review Results

After you run a Polyspace analysis of your generated code, the Polyspace environment

shows you the results of the static code analysis. There are 50 MISRA C:2012 coding rule
violations in your generated code.
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Analyze Code and Test Software-in-the-Loop

Expand the tree for rule 8.7 and click through the different results.

Rule 8.7 states that functions and objects should not be global if the function or
object is local. As you click through the 8.7 violations, you can see that these results
refer to variables that other components also use, such as CruiseOn0ff. You can
annotate your code or your model to justify every result. But, because this model is a
unit in a larger program, you can also change the configuration of the analysis to

check only a subset of MISRA rules.

¥ Configuration | |¥] Result Details

{p] Dashboard | [¥] Source | (=] Output Summary

' Polyspace Bug Finder - Compute \\home-00-ah\mhaines\Documents\MATLAB\project: ples\cruise3\results Compute\Compute - O *
File Reporting Metrics Tools Window Help
& & 5> run @ stop | Q -
B2 Results 'W'S <
All results | T New .- <A 5> @ Showing 118/118 » Compute.c X 4 b8 ||®@
- - - - - - FOeIifE LOMpUTE_IN_ACCEL (TUINTE_I7 10 |
Family &F Information o Fle F Class <F Function =f Severity #define Compute IN CRUISE ((uints_T)10) P
[=-MISRA C:2012 49 @ #define Cu[rpabsiINicnast. ( cnn:;TJ 2u) @
2 Unused code 32 $define Compute IN NO ACTIVE CHILD ((uinte_T)0U)
4 Code design 2 #define Corrp'.:\:eill{iclﬂ; N ( t'.:in:37TJ 2U)
[=-8 Dedlarations and definitions 14 ) - - -
=-8.7 Functions and objects should not be defined with external inkage if they are referenced in only one translation unit. 14 #define Compuce IN_ON ({uinzg_T)10)
L T Category: Advisory Compute.c Global Scope File Scope #define Compute IN_STANDBY (({uintg_T)20)
Loe Category: Advisory Compute.c Global Scope File Scope #define Compute IN_Steady ({uintg T)30)
1% * Category: Advisory Compute.c Global Scope File Scope
.= *  Category: Advisory Compute.c Global Scope File Scope /* Block states (auto storage) */
Category Advisory Compute.c G\oba\scope File Scope W _Compute T EMFJEE DH;
- : mtegnry Advisory Computa c G\oba\s:opa F!Ie Scope /* Real-time model */
[ Category: Advisory Compute.c Global Scope File Scope v 7
: RT_MCDEL_Compute_T Compute M ;
8 2 E RT_MCDEL_Compute T *const Eumpuca M = cCompute M ;
&l Project Browser Results List - - - - -
v /* Exported data definition */
Variable trace Compute.c|
I Resuft Review /% Definitien for custem storage class: Global */
boolean T AccelResSw;
Severity : | | |Enter comment here... poolean T Brake;
Status ~ boolean T Emastﬁetﬁw;
boolean T GruiseOnOff:
~ MISRA C:2012 8.7 (Advisory) (2 uined T Speeds
Functions and objects should not be defined with external linkage if they are referenced in only one translation unit. boolean T engaged:
Variable ‘Compute_M' should have internal linkage. winte T rspeed;
/* Definition for custom storage class: Global */
uints_T Roldrate = 5U:
uinte_T Tncdec = 1o;
uints T maxtspeed = 90U;
v - v

In your model, right-click Compute target speed and select Polyspace > Options.
Set the Settings from (Polyspace Bug Finder) option to Project configuration.

This option allows you to choose a subset of MISRA rules in the Polyspace

configuration.
Click the Configure button.

select the check box Check MISRA C:2012 and from the drop-down list, select

In the Polyspace Configuration window, on the Coding Rules & Code Metrics pane,
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10 Verification and Validation

single-unit-rules. Now, Polyspace checks only the MISRA C:2012 rules that are
applicable to a single unit.

¥ Polyspace Bug Finder O *
File Edit Tools Window Help
| & vl
onfiguratio =
simulinkCruis...Example_config x | 4 B
-Target & Compiler Coding Rules & Code Metrics
- Macros
‘- Environment Settings
----- Inputs & Stubbing
----- Multitasking Coding Rules
3 Coding Rules & Code Metrics [] Check MISRA C:2004 required-rules Edit
----- Bug Finder Analysis :
_____ Main Generator [] Check MISRA AC AGC OBL-rules Edit
----- Reporting Check MISRA C:2012 single-unit-rules Edit
----- Distributed Computin
. puting [] Use generated code requirements
----- Advanced Settings
[] Check custom rules Edit
Effective boolean types| Type 2 ¥ ':E:' .

boolean_T

Code Metrics

Calculate Code Metrics

Save and close the Polyspace configuration window.

7 Rerun the analysis with the new configuration.

When the Polyspace environment reopens, there are no MISRA results, only code
metric results. The rules Polyspace showed previously were found because the model
was analyzed by itself. When you limited the rules Polyspace checked to the single-
unit subset, no violations were found.
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See Also

Family +f Information < File + Clad
--Code Metrics 69
+-Project Metrics 1
il-File Metrics 8
i Function Metrics 60

When this model is integrated with its parent model, you can add the rest of the MISRA
C:2012 rules.

Generate Report

To demonstrate compliance with MISRA C:2012 and report on your generated code
metrics, you must export your results. This section shows you how to generate a report
after the analysis. If you want to generate a report every time you run an analysis, see
Generate report.

1 [f they are not open already, open your results in the Polyspace environment.

2 From the toolbar, select Reporting > Run Report.

3 Select BugFinderSummary as your report type.

4 Click Run Report.

The report is saved in the same folder as your results.
5 To open the report, select Reporting > Open Report.

See Also

Related Examples
. “Run Polyspace Analysis on Code Generated with Embedded Coder” (Polyspace Bug

Finder)
. “Test Two Simulations for Equivalence” (Simulink Test)
. “Export Test Results and Generate Reports” (Simulink Test)
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